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1. Home

Welcome to the LightBurn Docs!

Please use the search bar at the top of the page or click the closest match for what you're trying to find.

Disclaimer and Safety

Beginner Pathway

Installing LightBurn

Adding your laser to LightBurn

Configuring a laser for use with LightBurn

How To Use LightBurn

Zooming, Panning, and Selection

Getting started - Making a simple project

Coordinates, Device Origin, and Job Origin - Placing your work

Primary Documentation

How to use specific features in LightBurn

Cool tricks and usability tips

Working with Other Software

LightBurn Bridge Docs

Using A Rotary

Galvo Docs

Download PDF Version

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

1. Home

- 4/241 - (C) LightBurn Software, LLC

https://lbrn.info/pdfdocs


2. Disclaimer and Safety

Lasers use intense beams of light to create heat and fire as a normal part of their operation, and depending on the laser, the light
might not be visible to you. When used safely, a laser cutter is an incredibly useful tool. However if the proper safety measures are
ignored, you could burn or blind yourself or someone else, or start a fire that could damage or destroy your home, or in the worst case,
kill someone. CO2 lasers use high voltages, and if wired incorrectly could kill you.

Do not leave a running laser unattended.

By using this software, the user accepts complete responsibility for each and every aspect of safety associated with the use of the
laser machine, laser system and LightBurn Software.

You agree that:

You will not hold the author or contributors of LightBurn liable for any damage to equipment or persons from the use of LightBurn.

You understand the potential hazards in using high power lasers and high voltages.

You will wear proper eye protection rated for your laser when operating it.

You will use the LightBurn software in a legal and safe manner.

You relieve the author and contributors from any liability arising from the use or distribution of the LightBurn software.

You are entirely operating at your own risk. Lasers can be lethally dangerous.

Danger
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3. Beginner Docs

Beginner Docs First Steps

3.1 What Is LightBurn?

LightBurn is layout, editing, and control software for your laser cutter. LightBurn talks directly to your laser, without the use of
additional software. 

With LightBurn you can:

Import artwork in a variety of common vector graphic and image formats (including AI, PDF, SVG, DXF, PLT, PNG, JPG, GIF, BMP)

Arrange, edit, and even create new vector shapes within the editor, with powerful features like offsetting, boolean operations,
welding, and node editing

Apply settings like power, speed, number of passes, cut order, brightness & contrast, dithering mode, and much more

Send the result directly to your laser cutter

LightBurn is a native application written for Windows, macOS, and Linux.

• 

• 

• 
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3.2 Beginner Walkthrough

Beginner Docs First Steps

3.2.1 Adding & Configuring for Beginners

LightBurn can't control every laser, but it can talk to a
number of different types of laser controllers, all of which
use different ways of communicating, and have different
abilities and settings.

This step tells LightBurn what you have.

If you've never configured a device in LightBurn, you'll be
brought here automatically when you run the software. It is
important that you pick something because the interface in
LightBurn will change depending on the capabilities of the
laser you choose. If you don't have a laser to connect to yet,
you can create a placeholder device

If you've done this before, but want to change your laser, or
add a new one, click the 'Devices' button in the Laser
Window to bring up the devices list.

LightBurn can also be configured to control more than one
laser, and there are settings stored for each device. If you
don't pick one, we have nowhere to put these settings, and
a number of features within LightBurn will not work until this
is set up.

The Devices page

This is the Devices page in LightBurn. Here you will see a list
of all the laser devices you've added to LightBurn, or an
empty list when you're first starting.

The simplest way to proceed is to click 'Find My Laser' and
let LightBurn try to figure out what you have. If that doesn't
work, your laser connects with Ethernet, or you have a
Marlin device, you'll need to use 'Create Manually'. If you're
using a LightBurn Bridge device, you can use the LightBurn
Bridge setup.

Find My Laser

Create Manually

LightBurn Bridge

You can also import and export laser configurations to move
them between computers using the Export  button on this
page from the source computer, and then import it to the
new install using the Import  button. Exporting will create
a .lbdev  (LightBurn device) file, which contains all of the
device specific information LightBurn needs to make that
machine's profile on the new computer.

You can import a LightBurn Device profile by dragging and
dropping it into your main window.

• 

• 

• 
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What if I don't have a laser yet?

You don't ever need to connect a laser to LightBurn to use it,
but LightBurn will not run without a device profile
configured, because it needs a place to store some settings,
and wants to know what options to show you in the
interface. If you use a laser that accepts files on a USB drive,
for example, LightBurn needs to know which controller it
uses so it can produce the correct output files.

To start using LightBurn without a laser, use Create Manually
and configure the things you can, and guess at whatever
you don't know. When you finally do get your laser, you can
come back to this screen, select the 'dummy' profile you set
up, and click 'Remove'. Then you can follow the set-up steps
here for real this time and use your laser!

Configuring

If you have a GCode controller, particularly if you also use
your system as a CNC or 3D printer, there may be additional
configuration required.

Common GRBL setups

If you have a Ruida DSP controller, and are configuring from
scratch, read here:

Configuring a Ruida

If you're using a galvo laser, start here.

Configuring A Galvo

• 

• 

• 
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3.2.2 Coordinates and Job Origin

There are a few ways to tell LightBurn how to place the
project within the work area of your machine. You choose
them in the "Start From" box on the Laser tab:

Absolute Coordinates

Absolute Coordinates is the simplest - The page grid you
see in the main editing window represents your machine's
work area. Anything you place in that area will be cut in the
corresponding place on your machine. Users with small
lasers like the K40 will likely find this the simplest and most
intuitive option.

Note: Using absolute positioning requires a laser with
homing switches and a fixed origin. If you have a small diode
laser that does not have homing sensors, you will need to
manually zero the machine. See Machines without homing
sensors / limit switches.

In the image below, the two circles placed in the middle of
the work area will be cut in the middle of the machine work
area. The green square in the lower-left of the image
represents the Job Origin, and the red square in the same
place shows the Machine Origin. In "Absolute Coordinates"
these are always in the same place.

Current Position

Current Position is probably the next easiest to use. Your
job cuts relative to the current position of the laser head
when you hit the Start button. You use the "Job Origin"

control in the Laser window to tell LightBurn how to position
the job relative to the laser.

In this image, we're starting from the Current Position, with
the Job Origin set to the lower left:

Notice that the green "Job Origin" indicator has moved. This
represents the position of the laser when you start the job,
so the laser is going to move slightly up and to the right
from wherever it is, cut the two circles, and go back to
where it started.

Imagine that you wanted to cut this amazing two-circle
pattern onto a beverage coaster or a phone case. Lining it
up like this is not easy. If you change the Job Origin setting
to "Center", you get this instead:

Now the job is going to be cut centered around the current
position of the laser head. If you position the laser directly
over the center of the item you want to cut, the resulting
image will be centered on the item.

Using Current Position and Job Origin together lets you line
up a cut on a piece of material with ease, once you
understand how it works.

User Origin

User Origin works almost exactly the same as Current
Position, except that the starting location is
"programmable". Some lasers have an "Origin" button on
them (like Ruida controllers). GCode based systems use the
"Set Origin" button in LightBurn to do the same thing. You
jog your laser to the position you want your job to start from,

3.2.2 Coordinates and Job Origin
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hit the "Set Origin" button, and then you're free to move the
laser around again. If you specify "User Origin" as the "Start
From" value, the laser will move back to that programmed
location and start the cut from there.

Finish Position

Note that the Finish Position setting is only for GCode-based

controllers. DSP controllers manage this internally.

LightBurn gives you the control of where you want the head
of the laser to return to after a job is finished. By default it
will return to 0,0 however this is not the optimal location for
some machines. 

To change your finish position, go to the Move window and
use the arrows to reposition your laser head to where you
would like it to return to on job finish. Then click the Set

Finish Position button. Your machine will now remember
that spot for future jobs. This can be reset at any time by
repeating these steps for a new location.

3.2.2 Coordinates and Job Origin

- 10/241 - (C) LightBurn Software, LLC

img/MoveWindow.png
img/MoveWindow.png


3.2.3 Basic Usage: The Essentials

So far we've done a brief introduction to the UI and covered 
zooming, panning, and selecting.

The next things we'll cover are:

Creating Shapes

Importing Artwork

Moving and Sizing Artwork

Grouping

Cut Layer Settings

Controlling the Laser

Creating Shapes

LightBurn's shape creation tools let you create simple
shapes. Choose a tool from the left toolbar, like the ellipse,
rectangle, or polygon tools. With a tool selected, left-click in
the workspace and drag the mouse to adjust the size of the
shape you're creating. While dragging, the Shift key will
force the shape to have the same width and height, so you
get circles and squares instead of ellipses and rectangles.
The Ctrl key causes the shape to be centered on the starting
point, instead of dragging it out from corner to corner.
Release the mouse button to finalize the shape.

For text, select the text tool, then click in the edit window to
place the cursor. Type your text, and press the Esc key when
finished.

Importing Artwork

The shape creation tools let you make simple shapes in
LightBurn, like circles, rectangles, text, and polygons, and
also give you the ability to edit and adjust them, but
LightBurn isn't intended to be a complete artist package or
dimensioned modeling tool. For that, you would use external
software like CorelDraw, Adobe Illustrator, Inkscape, or
AutoCAD. Photo or image manipulation software such as
Photoshop or GIMP can be used to create or manipulate
image files.

When you have artwork ready in one of these programs, the
next step is to import it into LightBurn to adjust the settings.
LightBurn can import the following file types:

Vector / mixed formats:

.ai - Adobe Illustrator

.svg - Scalable Vector Graphics

.dxf - AutoCAD Drawing Exchange Format

.pdf - Adobe Portable Document Format

.plt / .hpgl - Plotter / Hewlett-Packard Graphics Language

Image formats:

.png - Portable Network Graphics

.jpg / .jpeg - Joint Photographic Experts Group format

.bmp - Windows Bitmap

.gif - Graphics Interchange Format

.tif / .tiff - Tagged Image File Format

Note that not all features of every format will be supported.
Vector graphics formats in particular are incredibly complex,
and using more advanced features, like pattern fills,
masking, gradients, and so on will not necessarily translate
well when importing. LightBurn cares about shape outlines -
if you want artwork to include the advanced features, the
best option is usually exporting as a high-DPI image.

You can import files into LightBurn in several different ways:

Clicking the Import button on the main toolbar ( )

Using the File > Import option from the main menu

Pressing the Import keyboard shortcut (Ctrl + I)

Dragging a file from the Windows Explorer or MacOS
Finder into LightBurn

Copying and Pasting an image from a browser window into
LightBurn

Moving and Sizing Artwork

Once you have your artwork in LightBurn, the next step is
usually placing or sizing it. When one or more items are
selected, you'll see various "tool handles" appear around the
outside of the selection, like this:

In the image above, you can see 9 gray squares, and four
arrows. If you hover your mouse over any of them, the
cursor will change to indicate the kind of operation that tool
performs - resizing, moving, or rotating.

Grabbing any of the four corners will let you resize the
artwork from that corner, and defaults to uniform resizing
with the opposite corner as the anchor point. Holding the
Ctrl key (or Command on Mac) switches the anchor point to
the center, so the object center remains in place when
resizing. Holding the Shift key allows you to resize the width
and height independently, instead of locking them together.

Grabbing any of the four side handles will let you adjust the
width or height of the selection, and the Ctrl (or Command)
key switches to center anchor just as it does with corner
sizing. When moving, the status bar shows both the absolute
position of the selection being moved, and the relative
distance it has moved.

The center handle is for moving the selection, though you
can also click and drag any edge of any shape to do this as
well. When moving a selection, holding the Shift key
constrains the movement to be horizontal, vertical, or
diagonal.

The four rotate handles allow you to rotate the object freely
using the mouse. While rotating, the relative rotation is
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displayed in the status bar. Holding the Ctrl key (Command
on Mac) snaps the rotation to the nearest 5 degrees, holding
Shift will snap to 15 degrees, and holding Ctrl+Shift snaps to
45 degrees.

You can also move, rotate, and resize artwork using the 
Numeric Edits Toolbar.

Grouping

When you create shapes in LightBurn, they're independent
of other shapes you create. Sometimes it's handy to be able
to treat a collection of things as a single unit, to make sure
they keep their relative position and size when you're
moving them around. In LightBurn, this is called a Group. If
you select two or more shapes and click the 'Group' button

( ), or press Ctrl + G , you'll create a new object
that contains the original shapes. To un-group the objects so
you can edit the individual parts, select a group of shapes

and click the un-group button ( ), or Ctrl + U .

You can tell if a shape is in a group or not based on how it
looks when selected.

Ungrouped objects are displayed with a simple dash pattern
when selected, like the single circle above on the left. A
grouped shape shows a repeating dot-dot-dash pattern when
selected, shown on the three smaller circles above on the
right.

Cut Layer Settings

Artwork imported from vector files assigns shapes to layers
in LightBurn based on the colors of the vectors in the
original file. If you create your files with this in mind, it can
save you time.

Layers in LightBurn are used to assign different settings to
the shapes in your design. For example:

In the above design, black could be used for a solid, dark
engraving, blue could be a very light engraving with an
outline to add definition to the text, and red would be a slow,

high-power cutting layer. The final output to the laser might
look like this:

The information shown in the Cuts / Layers window is just
the basics. You can see the full set of options for a layer by
double-clicking the entry in the layer list to bring up the Cut
Settings window.

Controlling the Laser

There are two windows primarily used to control the laser:

The Laser Window, shown in the lower right of the display by
default, lets you select your laser, start, stop, or pause a job,
frame the design (move the laser head around the boundary
of your design to test alignment), and more. These options
can vary based on the type of laser you're using.

The Move Window, docked behind the Cuts / Layers window
by default, gives you jog buttons and positioning control,
and the 'Speed' value there is used when framing or jogging
the laser in LightBurn.

⌃

⌃
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There are a couple other methods for moving the laser that
are noteworthy:

The Click-to-Position tool ( ) on the Creation Tools
toolbar lets you click anywhere in the workspace and
LightBurn will jog the laser to that point.

Note that this assumes that your laser has been properly
homed - Some DIY-style machines do not have homing

switches, so using any form of absolute positioning in
LightBurn requires extra steps.

The number pad arrow keys can be used to jog the laser
after clicking in the edit window (workspace).

The Arrange menu and arrangement tools can be used to
move the laser relative to artwork in the workspace.

• 

• 

• 

• 
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Beginner Docs First Steps

3.2.4 Making a Simple Project

We're going to go step-by-step through creating a small,
simple project in LightBurn, from start to finish, to show you
how to use a few of the basic editing tools, and give you a
feel for how things work.

Before you start, make sure you have a laser set up in
LightBurn (see Adding your Laser).

This project will be a simple name tag, cut out around the
letters, ideally made from thin wood or acrylic, but a piece of
cardboard will do.

Creating the text

With LightBurn running, and an empty project, click the
Create Text button shown below. It normally lives along the
left side of the main window:

Next, click the mouse somewhere in the middle of the Edit
window (the workspace) to get a cursor, then type your
name:

Click the 'Select' tool button on the top left of the edit
window, or press Esc  twice (once to finish entering text,
and again to exit text entry and go back to selection mode).

When you finish the text, you'll see an entry appear in the 
Cuts / Layers list on the upper right of the display. This is the

"layer" that your text is on, and it holds the settings that will
be sent to the laser for all the objects on this layer:

This tells us that the shapes on this layer will be drawn as
lines, with 100 mm/sec speed, and 20% power. Depending
on your settings, the '100.0' might be different - Diode lasers
are less powerful than CO2 lasers, and run slower, so they
tend to use mm/minute as units, so the same default value
would display as 6000 mm/min. If you have your units set to
Inches, you might see 3.9 in/sec, or 236 in/min.

Previewing

To see how the laser will run your project, click the Preview
button in the middle of the main toolbar:

The preview window will pop up, showing the completed job,
like this:

The lighter red lines are showing the laser moving between
the shapes (traversal moves), and the black lines are where
the laser will burn. Click the 'Play' button and you can watch
a simulation of how the laser will run the job. You can also
grab the slider and drag it around to see the cut at different
points in time. Spot checking the output like this is a good
habit to get into, because you'll likely spot mistakes before
you burn the project for real, saving time and material. Click
the 'Ok' button to close the preview.

⎋

3.2.4 Making a Simple Project
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For more information on the preview window see its page
here Preview Window

Changing text properties

Make sure you're still in Selection mode - the 'Select' tool
should be highlighted. Click the name, or click and drag a
rectangle around it to select it. When it's selected, it will be
drawn as animated dashes instead of solid lines, and
handles will appear around the selection to let you change
the size, position, or orientation.

The options in the Text Toolbar at the top will activate, like
this:

Click the drop down for the font, and change it to anything
you like. While you are choosing, the changes will be
displayed in real time in the edit window. You can change the
height, make it bold or italic, and adjust spacing here too.

Undo / Redo

If you make a change you don't like, you can undo it by
clicking the Undo button on the toolbar (or pressing Ctrl

+ Z , or Edit > Undo in the menu). If you decide you liked it
after all, you can also Redo ( Ctrl + Shift + Z  / 

Cmd + Shift + Z ). Undo and Redo in LightBurn are
unlimited - the undo system doesn't reset unless you create
a new file or close the program.

Changing the Layer settings

Rather than outline the text, we're going to change it to be
solid filled. In the Cuts / Layers window, click where it says
'Line' and change it to 'Fill', like this:

You'll notice that the display in the edit window hasn't
changed, but if you run the preview again, it looks quite
different. By default, the view in LightBurn shows outlines
only, not fills, because it's much faster, and it prevents
things from being hidden behind solid shapes that might still
be run on the laser.

Adding an outline: The Offset tool

With the text selected, click the 'Offset' button on the left
toolbar, shown here:

The Offset options window will appear, and you should see
something like this:

The offset tool creates a new shape by outlining the shapes
in your selection at a given distance, either inward, outward,
or both, and merging the result. If you point the mouse at
the 'Offset Distance' value, you can scroll the mouse wheel
to change the number and watch the result change on the
fly. You can also click the box and just enter a number as
well.

Make the Offset Distance value large enough that there are
no internal gaps in the outline - Notice the gap above
between the L and the next letter is gone in the version
below:

When you're happy with the result, click 'OK'.

Changing Layers

Now, use the left mouse button to click the new outline you
just made, so it is the only thing selected, like this:

⌃

⌃ ⇧

⌘ ⇧

3.2.4 Making a Simple Project
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Then, click the Red button in the color palette at the bottom
of the display:

The outline will turn red, and you should see two entries in
your Cuts / Layers list, like this:

The first, the black layer, is the fill for your text, and the
second red layer is for the outline cut.

Speed and Power

This is where things get a little tricky in terms of you being
able to follow along. Speed and power settings vary quite a
bit between lasers, and LightBurn supports a lot of different
types of machines. It also depends on the kind of material
you're using - cutting through 1/8" basswood uses much less
power than cutting through 1/4" plywood or acrylic. For right
now we'll assume 1/8" (3mm) plywood and give some
guesses for settings, but you'll probably have to change
them.

To start with, click the black color entry in the Cuts / Layers
window. Below the list of layers you'll see the Cut Info
window, containing something like this:

For the text, you want enough power to engrave into the
material you're using, but not too deep.

If you have a CO2 laser, use 200 mm/sec, 15% power

(both Power Min and Power Max - more on this later) and
leave everything else.

If you have a diode laser, use 50 mm/sec (or 3000 mm/
min), and 50% power.

Understand that this is a rough starting point, and you will
probably need to change this later.

Now, click the red entry in the Cuts / Layers window. This is
going to be what cuts through the material to cut out the
shape. Cutting requires more power and much less speed.

For a CO2 laser, set 15 mm/sec, 75% power (again for

both min and max power)

For a diode laser, use 2 mm/sec (120 mm/min), and 100%
power. Depending on the strength of the diode you have,
you might need to go slower than this, or use more passes
by setting the Pass Count value higher.

Again, these are guesses, but they're a starting point.

Open the Preview window again (Alt+P, or click the Preview
button), then drag the progress slider from left to right to
watch how the job will run. You'll see the text engrave first,
followed by the outline cut. If you don't see those things,
check the settings again, and verify that you have the first
layer (black) set to Fill, and the second layer (red) set to
Line.

Positioning the Job on the Laser

When sending this to the laser, there are a couple of
different ways that it can be positioned, and the one you
choose may depend on the kind of hardware you have. If
you have a small diode laser that does not having homing
switches, you will likely want to run the job using the
'Current Position' mode. For now, that's what we'll
recommend for everyone, since it's easy.

If you have an Ortur Laser Master, or other small laser that 
does have homing switches enabled, you will likely find
'Absolute Coords' to be the simpler setting to use - this
means that wherever you place your work in LightBurn is
exactly where it will go on the laser.

In the Laser window, which is in the lower-right of the main
window by default, look for the 'Start From' drop down box,
and choose 'Current Position' or 'Absolute Coords'. If you see
'Controller Setting' in this window, it means you have a
Trocen Controller, and the start position is set from the
controller menus, not from software. Don't sweat it for now.

If you used 'Current Position' mode, you'll see the 9-dot "Job
Origin" control under it activate, and you should see a green
square on your design in the same spot indicated by Job
Origin control, like this:

In the above image, the Job Origin is set to the lower-left,
and that's where the green origin square is on the design.
That green square represents the position of the laser before

• 

• 

• 

• 
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you start the job, so the design is going to end up above and
to the right of wherever the laser is when we press Start.

Put a piece of material in the bed of the laser, and use the
arrow keys on the laser controller (if you have that) to move
the head of the laser to the lower-left corner of the material.
If your laser controller doesn't have arrows, click an empty
spot in the edit window, then use the arrows on the Number
Pad of your keyboard to jog the laser around instead.

When you think it's lined up, press the button labeled
'Frame'. The head of the laser will move in a rectangle
around where the job will go. If you need to adjust anything,
do so, then Frame again.

If you only have the option for 'Controller Setting' in the
above window, when you position the laser in the lower
corner of the material, press the button labeled 'Origin' on
the controller panel to tell the controller this is where you'd
like the job to start.

When everything is lined up, close the lid on the laser (or if
you don't have one, put on your safety glasses), then press
the Start button.

If anything goes wrong, hit the Stop button to abort the job,
but if not, let it finish. When it completes, have a look at how
things ended up - if the engraving of the name is too deep or
too dark, you can increase the speed or reduce the power
(or both). If the cut didn't go all the way through, reduce the

speed or increase the power (or both). If you don't move
your part, you can run the cut again (possibly with new
settings) without having to use a new piece of material..

Results and Next Steps

When it's done, hopefully it looks like something like this:

That's it for this quick tutorial - It's only meant to be a
starting point, but hopefully it was enough to give you a
little foundation, and a taste of how things work.

Next Steps:

We recommend going through some of our "LightBurn
Basics" tutorials on YouTube, and we have a great project
tutorial that's a little more in depth called the "WIFI QR Code
tutorial" that covers more ground, including importing.

LightBurn YouTube channel• 

3.2.4 Making a Simple Project
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Beginner Docs

3.3 Downloading & Installing LightBurn

3.3.1 Downloading LightBurn

The first step is to go to lightburnsoftware.com

At the top, click "Download and Trial" (or click here)

You'll see links for the current release of LightBurn.
Download the version that matches your computer. 

Windows 64-bit - nearly all modern computers are 64 bit

Windows 32-bit - some older systems might need this

Mac OSX

Linux 64-bit

When you've completed the download, you should see the
file in your "Downloads" folder. On Windows and Mac you
can just double-click the downloaded file.

Minimum computer system requirements

LightBurn will run on Windows 7.0 or later (32 or 64 bit),
MacOS 10.11 or later, or 64 bit Linux (Ubuntu 20.04 or
Fedora 36, anything else may not work as intended). Ubuntu
users unable to upgrade beyond Ubuntu 18.04 should
download version 1.2.01 instead of the current version.

LightBurn does not require a powerful computer for most
work, though if your designs contain a lot of images, more
memory is helpful. As with most things, a faster computer
will make it easier to work with large images or complex 
vector graphics.

Choose your operating system:

Windows

MacOS

Linux

3.3.2 Windows Installation

Launch the installer by double-clicking it. Windows may ask
if you trust us first.

Click Next, then click 'Install'. The installation will proceed.
When it completes, you'll see this:

If you have never installed LightBurn before, you might need
to check the 'Install FTDI driver' button - this is mostly used
by DSP controllers, like Ruida and TopWisdom, and it only
needs to be done once. If you update the software later, you
do not need to repeat this step.

That's it! Locate the LightBurn icon to launch the program

3.3.3 MacOS Installation

Installing LightBurn on Mac is accomplished the same way
as most Mac software. After downloading the DMG file, open
the file (typically by double-clicking) and drag LightBurn into
your Applications folder. As long as you have version 1.2.00
or later, LightBurn should be ready to use. If you're using an

• 

• 

• 

• 

• 

• 

• 

3.3 Downloading & Installing LightBurn

- 18/241 - (C) LightBurn Software, LLC

https://lightburnsoftware.com/
https://lightburnsoftware.com/pages/trial-version-try-before-you-buy
https://github.com/LightBurnSoftware/deployment/releases/tag/1.2.01
./img/Setup-1.png
./img/Setup-1.png
./img/Setup-2.png
./img/Setup-2.png


older version, please see the information below for an
additional step you'll need to take.

Versions before 1.2.00 were not notarized to be recognized
by your computer as coming from a trusted developer. If you
installed an older version, you'll need to follow the steps
below to allow your computer to run the software:

To Install the LightBurn application:

Double-click the LightBurn.dmg file to mount the disk image.

Drag the LightBurn application into your applications folder

Eject the LightBurn disk image, or drag it to the trash bin

When launching LightBurn for the first time:

Open a Finder window

Browse to the 'Applications' folder

Hold the Control key and click the LightBurn icon, or right-
click or / two-finger tap the icon

Choose 'Open' from the menu

When MacOS asks if it should open the program, say yes,
and it will be listed as an exception in your launcher. From
then on you can just launch the application normally.

Video Walkthrough

3.3.4 Linux Installation

In step 1 below, $USER  doesn't need to be replaced with
your username. It's a standard system variable, and if
entered exactly as shown below will automatically refer to
the logged-in user's username.

Open a terminal and run the following command:

sudo adduser $USER dialout && sudo adduser $USER tty

IMPORTANT! Log out and log back in (this refreshes the
permissions we just added)

Download the Linux 64-bit version, either the .run  file or
the .7z  file and follow the appropriate steps below:

.RUN  INSTALLER

Open your terminal and cd  to the directory you downloaded
the file to.

Run bash ./LightBurn-Linux64-v*.run

It will now automatically install and create a program listing in
your desktop environment.

.7Z  INSTALLER

Extract the folder wherever you want Lightburn to exist

Right click AppRun  > Properties > Permissions > 'Allow
executing file as program'

Double click AppRun  inside your Lightburn folder

macOS Notarization Bypass Guide (fixing the

'unable to check it for malicious software'

warning)

1. 

2. 

3. 

1. 

2. 

3. 

4. 

5. 

Info

1. 

2. 

3. 

4. 

1. 

2. 

3. 

1. 

2. 

3. 

3.3.4 Linux Installation

- 19/241 - (C) LightBurn Software, LLC

img/Installation/Mac_Installation.png
img/Installation/Mac_Installation.png
img/Installation/Notarization_Failure.png
img/Installation/Notarization_Failure.png


Beginner Docs First Steps

3.4 LightBurn UI Tour

If you've never used LightBurn before, the main window might seem a little intimidating. Try not to let it scare you - we'll break out
the important sections to start with. LightBurn also has some features to make it easier to learn:

Tool tips: If you hover the mouse over a control, you'll see a small bit of text pop up that describes that button or feature, like
this:

If you hover the mouse over something and press the F1  key (help), LightBurn will launch the help page for that feature in your
browser. Most of the panels and buttons on the main window of LightBurn will do this.

3.4.1 The Main Window

This is the default layout for the main LightBurn window:

Here it is again, with the sections labeled:

Open Image 

It's worth noting that along the very bottom of the main
display is a status bar that will occasionally show
information like an automatic backup in progress, position of
the cursor, laser connecting, and so on.

The main sections of the user interface are all linked as
chapters, so you can skip around as needed. It's a big
application but you don't need to know all of it to use it well!

The Main Window

Menus

Main Toolbar

Creation & Modifier Tools

Color Palette

Tool Layers

Cuts & Layers

Size, Position, Numeric Edits

Font & Text

Laser Window

Workspace / Edit Window

For a full list of the windows and dockables in LightBurn, see
the section on the user interface.

• 

Help
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These are the windows you will use most commonly, though
there are others. If you ever close one accidentally and want
it back, go to the menu bar, click the Window  menu, or just
right-click an empty space on the toolbar, and re-enable the
window you want back.

3.4.2 Menus

Almost all desktop software uses menus in some form. The
menu bar at the top of the main window gives you access to
almost every feature available in LightBurn.

Depending on the operating system you're using the menus
might appear a little differently, and some features may be
removed if your laser doesn't support them.

If a feature has a shortcut, it will be shown next to it in the
menu, as shown above. Learning the shortcuts for the
features you use most often will make using LightBurn much
faster, and sometimes there are even 'shorter' shortcuts -
you can find these in the help menu under Help > Quick
Help and Notes.

Menus in depth

3.4.3 Main Toolbar

The main toolbar in LightBurn gives you quick access to
commonly used functions for opening or importing files,
saving, using the clipboard (copy & paste), moving or
zooming the view. Right beside it is the Arrangement
toolbar, containing some commonly used arrangement tools
for arranging and aligning shapes.

If you aren't sure what a button is for, hover the mouse over
it and it will tell you:

Main Toolbar in depth

Arrangement Toolbar in depth

3.4.4 Creation & Modifier Tools

The shape creation tools are normally arranged vertically,
but we're showing them sideways here. By default, these are
docked along the left side of the work space for quick
access.

The first tool, 'Select' is probably the one you'll use most,
and is the default tool chosen when LightBurn starts. The
others are used to create basic shapes like circles and
rectangles, text, and lines, and there are few for modifying
shapes in more complicated ways, like merging shapes, or
creating lots of copies of shapes.

Creation Tools in depth

Modifier Tools in depth

3.4.5 Color Palette

The color palette lives along the bottom of the main window
by default, though a common alternative is docking it next
to the creation tools along the left.

Lasers don't "print" in color, so these colors are used to
assign different kinds of operations to the shapes in your
design. A common convention is to use bright red for cuts,
though how you use the colors is up to you.

With nothing selected in the workspace, click a color entry
and new shapes will be created in that color. If you have
something selected, clicking a color entry will apply that
color to the shapes in your selection. The colors currently in
use in your design will also appear as entries in the Cuts /
Layers window, where you can choose the operations that
each color represents.

• 

• 

• 

• 

• 
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TOOL LAYERS

There are 2 special layers at the end of the cut palette,
labeled T1 and T2. These are Tool Layers and are purely
for creating non-output shapes in your designs. These layers
have no cut parameters and will never be output to the
laser. For example you could use them for:

Indicating pre-determined material size and position on
your machine

Guide-lines for aligning shapes

Apply Path to Text (without the path being output)

Image Masking

3.4.6 Cuts / Layers

This window shows the colors currently in use in your design,
and lets you quickly access the settings assigned to them.

The first column shows the name you've assigned to this
layer, followed by the color, then the Mode (Line, Fill, both,
or Image). Then the speed and power are displayed,
followed by the options to enable or disable sending this
layer to the laser, or displaying it in the workspace.

Underneath the layer list you can see and change the basic
settings for the currently selected layer. If you double-click
an entry in the layer list, it will bring up a larger Cut Settings
Editor, with a more complete set of options.

Cuts / Layers window in depth (to be completed)

3.4.7 Size and Position / Numeric Edits

The Numeric Edits toolbar lets you resize, position, and
rotate shapes, and change the unit of measure.

The lock button can be used to maintain the aspect ratio of
your objects when changing the size, and the 9-dot control
lets you choose the point that positioning and sizing
happens from. The number entry boxes accept equations
and units, too - You can enter 5mm, 5in, 5", 5*3mm, and so
on, and LightBurn will calculate the correct result for you.

Numeric Edits toolbar in depth

3.4.8 Fonts and Text controls

The font and text toolbar will activate when you use the
'Create Text' tool, or select text objects.

This toolbar lets you change the font, size, spacing,
alignment, and automatic welding. It also has settings for
variable text options, like serial numbers, dates, and using
data tables from a CSV file.

Fonts and Text in depth

3.4.9 Laser window

The Laser window is used to choose the laser to use, test the
position of a file (frame), run or stop the laser, and choose
various options that affect how the current file will be
processed, ordered, and positioned on the machine.

Note that this window may look different for you depending
on the type of laser chosen and the options it supports, and
some options will be hidden if you are in 'Beginner Mode'.

Laser Window in depth

• 

• 

• 

• 

• 
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3.4.10 Workspace / Edit window

Finally, the workspace, or edit window, is the drawing area
where you lay out your design. The size of the border and

grid drawn in the workspace matches the available work
area on your machine. When you import artwork it is
displayed here, and the arrangement of things will match
the output sent to your laser.

Next Step: Zooming, Panning, and Selection

3.4.10 Workspace / Edit window
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3.5 Zooming, panning, and selection

The Edit Window, the center of the main display, can be moved around and zoomed with the mouse to help you focus on different
parts of your design.

3.5.1 Zooming

Scrolling the mouse wheel will zoom in or out from the
location of the mouse - you can simply point at something
with the mouse and scroll the mouse wheel to zoom in on
that point. If you have a touch-pad (like a Mac) using a two-
finger swipe up or down does the same thing.

You can also use the - and + keys in the upper-right of the
keyboard to zoom.

3.5.2 Panning

To pan the view, sliding the window around, press and hold
the middle mouse button and move the mouse. If you don't
have a middle mouse button, you can hold the Space bar on
your keyboard down instead - you'll see the mouse cursor

change to a hand , and then you can grab and drag the
view with the left mouse button.

There are buttons on the main toolbar for panning and
zooming too:

The first button, the four arrows, is the Pan control. Click that
to enter Pan mode, to drag the view. You'll see the mouse

cursor change to a hand, like this:  When the hand
cursor is visible, you can drag the view around by pressing
the left mouse button and moving the mouse. The Space bar
acts as a shortcut for the Pan control.

The second button is Zoom to Page - clicking this will reset
the view in the workspace to frame the entire work area,
which is the view that LightBurn starts with.

The next two buttons are Zoom in and Zoom out. Clicking
them will zoom in or out of the center of the view. You can
also press the - and + keys in the upper-right of your
keyboard for this, or use the mouse wheel.

The 4th button is Frame Selection - Clicking this will zoom
the view to focus on whatever is currently selected, or all the
shapes in your project if you haven't selected anything.

3.5.3 Selection

There are multiple ways to select things in the edit window
(workspace). The simplest is to point the mouse at the
outline of a shape and click it with the left mouse button.

A few things happen when a shape is selected:

The selected shape is drawn with an animated pattern instead
of solid lines

The edit handles for resizing, positioning, skewing, or rotating
the selection appear

The size and position of your selection is shown in the Numeric
Edits toolbar

Other controls in LightBurn may activate, depending on what
you've selected

To clear the current selection, left click an empty space in
the view, or press the Esc key.

You can select a collection of shapes by pressing and holding
the left mouse button and dragging a rectangle around the
things to select, from left to right, like this:

The red rectangle will disappear when you release the
mouse button, and all the shapes fully enclosed within it will
be selected. This is called an enclosing selection - only
things fully contained in the red enclosing rectangle will be
selected.

1. 

2. 

3. 

4. 
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You can drag from right to left instead, and this will create a
green rectangle, which will select anything that it crosses:

In this case, all three items will be selected even though
they are not fully contained by the selection rectangle.

Experiment with these two selection methods -
understanding how they work, and when to use them,
makes working on larger projects much faster.

Selection Modifiers

To supplement click-select and rectangle selection,
LightBurn supports these modifier keys:

Shift  : Holding Shift while selecting will add the new
selection to the current one.

( Ctrl  / Cmd ) + Shift : Holding both Ctrl  and 
Shift  will remove the new selection from the current

one.

Ctrl  / Cmd : Holding Ctrl  by itself will toggle the
selection state of the new selection.

Additional Selection Tools

There are also a few items in the Edit menu for special types
of selection:

Select All: selects everything in the project

Invert Selection: Anything selected becomes
unselected, and anything unselected is now selected

Select open shapes: Selects anything in the design that
is an open shape (IE, is not a closed path that forms a
continuous loop)

Select open shapes set to Fill: Similar to Select open
shapes, but only selects open shapes that are set to 'Fill' -

This is useful, because LightBurn is unable to fill shapes
that aren't closed, so this can help you find them.

Select all shapes in current layer: If you choose a
layer setting and click this option, it will select everything
assigned to that layer.

Select contained shapes: this is one you won't use
often, but it's incredibly powerful when you need it. Select
a single shape in LightBurn, then click 'Select Contained
Shapes' to add everything that is 'inside' the item
currently selected. For example, if you wanted to select
everything inside one of the two blue outlines below, click-
select or drag-select would be difficult and time
consuming, but 'Select contained shapes' does it in just
two clicks:

Troubleshooting

Normally, selecting an object in LightBurn will give a nice
even "crawling ants" animation. If you find that you're
getting odd flashing or patterns, the most likely problem is
overlapping geometry. This is often the result of importing
the same file twice, or other design software exporting paths
improperly.

To solve this problem quickly, try deleting duplicate shapes
using Edit > Delete Duplicates or Alt  + D .

You can also try ungrouping ( Ctrl / Cmd  + U ) and
deleting individual shapes if you want more manual control.

Next Step: Basic Usage - The Essentials

• ⇧
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3.6 Feature Comparison

Feature LightBurn RDWorks LaserCAD AutoLaser LaserWeb

Windows 7, 8, 10 * * * * *

Mac OSX * *

Linux * *

64 bit native application *

Drag & Drop *

Copy & Paste with system
clipboard

*

Undo / Redo Unlimited 20 steps Unlimited 30 steps no

User support forum *

CorelDraw macro * * * *

Rectangular array tool * * * *

Circular array tool *

Illustrator import (AI) * * * *

PDF import * *

SVG Import * * *

DXF import * * * * *

Support for DXF instances *

Specify cut start point &
direction

* * * *

Mixed manual / automatic
cut order

*

Automatic Inside / outside
cut order

* * * *

Ruida controller support * *

Trocen controller support * *

TopWisdom controller
support

* *

GCode controller support * *

Integrated webcam
support for job placement

*

Print & Cut registration
mark support

* * (requires RDV
controller)

Image operations

Image dither modes 7 2 0 2 0

Halftone image generation * * *

Transparent bitmap
support

*

Brightness / Contrast
image controls

* * * *

Image edge enhancement *

3.6 Feature Comparison
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Feature LightBurn RDWorks LaserCAD AutoLaser LaserWeb

Vectorize image (trace) * * *

Crop / Mask images *

Vector Operations

Create and edit vector
graphics in-app

* * * *

Vector shape node-level
editing

* * * *

Automatic text welding *

Boolean operations (union,
subtract, weld)

*

Shape offsetting * * (poor) * (poor) * (poor)

Welded offsets *

Multiple offset corner
types (round / sharp /
beveled)

*

Use objects as guides *

Create rectangles with
rounded corners

*

Fillet shape corners *

Multiple object selection
modes (crossing,
enclosing)

*

Fully simulated preview * *

Text / Font Operations

TrueType font support * * * *

SHX font support * * * *

Apply text to curved path *

Bend text *

Engraving operations

Ramp generation (for
stamp making)

* * * *

Material Settings Library * *

Rotary engraving support * * * * *

Tool path preview * * * * *

Move laser to graphic
position

*

Move graphic to laser
position

*

Jog laser by clicking in
page

*

Jog laser with numeric
keypad

* *

3.6 Feature Comparison
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4. Primary Docs

4.1 Tips and Tricks

LightBurn has a decent number of user interface tricks that aren't always obvious, so we're listing many of them here. We also
have a Hotkey reference guide here.

4.1.1 Tool tips

Nearly everything in LightBurn has pop-up text that will tell
you what the control is for, and sometimes gives additional
help, like this:

4.1.2 Topic-aware help function

If you point the mouse cursor at a button or window and
press F1  (help), LightBurn will launch your browser and
open the documentation on the relevant help page for that
control. This works for nearly all controls on the main
window.

4.1.3 Reset the window layout

Sometimes a window gets shoved off the screen or
positioned in a way that makes it hard to find, or move. You
can reset the window layout in LightBurn in two different
ways:

In the Window menu, choose "Reset to default layout".
This will undock all windows, and re-dock them in the
default order.

If that doesn't do it, restart LightBurn while holding 
Shift  - this skips restoring the saved window layout,

and always works.

4.1.4 Edit window shortcuts

The edit window has a number of single-key shortcuts that
are only active when you have clicked in the edit window.
They are:

H  - flip selection horizontally

V  - flip selection vertically

L , R , T , B  - Align the selected objects by Left,
Right, Top, or Bottom edges

C  - Align the selected objects along their vertical
centerlines

E  - Align the selected objects along their horizontal
centerlines

P  - Move the selection to the center of the page

Arrow keys - Move the selection (Shift and Ctrl adjust the
size of the move)

(comma) and (decimal), usually under < and >, are rotate
90 counterclockwise and clockwise

Holding Shift while pressing , (comma) and . (decimal) will
rotate 45 degrees

Tab  - Select the next shape in the shape list

Number pad arrows - Jog the laser

4.1.5 Framing Mode Nudging

While framing, the arrow keys can be used to nudge the
position of your graphics by 1mm. Holding Shift will increase
the movement distance to 5mm, and holding Ctrl will
decrease it to 0.2mm.

4.1.6 Equation support in number boxes

The position, width, and height boxes in LightBurn will
accept not just numbers, but also measurements and
equations. All of these are valid:

50mm, 5cm

10 in, 10"

2 ft, 2'

10.25 / 2

(10+2) * 4 + 1in

You can also use the constants e and pi, and functions like
sin, cos, tan, sqrt, abs, atan, log, pow, and more.

4.1.7 Copy & Paste from other applications

LightBurn can paste data in known formats from other
applications.

An image copied from a browser can be pasted into
LightBurn

Text copied from anywhere can be pasted into LightBurn

Shapes copied from Inkscape can be pasted into LightBurn

4.1.8 Drag & Drop from the file browser

Files in any format supported by LightBurn can be dragged
into LightBurn from your file browser (Windows file explorer,
or Finder on MacOS).
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4.1.9 Automatic file backups

LightBurn by default will save backups of whatever file you
are working on. If you have previously saved the file as a
LightBurn project, the backup will be stored in the same
folder, with the same name, but with "_backup" appended to
it.

If you haven't saved the file with a name yet, LightBurn will
store the backups for it in you Documents folder with the
name "AutoSave_xxxx" where the x's are a random string of
characters. If LightBurn crashes, you can usually open the
most recent of these files to recover your work.

4.1.10 Auto-Start a job after Sending it to the

laser

Hold the Shift key when you click the Send button in
LightBurn to, and LightBurn will automatically run the file on
the laser when the send is completed. This is useful if you
are sending very complex or large files, and want to be
certain that the transfer completes before the job starts
running, but saves you having to press Start on the
controller.

4.1.11 Pause and stop from the keyboard

While your laser is running, you can use your keyboard's 
Pause  key to pause the laser and Ctrl + Break  to stop

it. Break  is typically on the same key as Pause , but more
compact keyboards may not have this key.

4.1.12 Setting up a new computer

Setting up a new computer can be a pain, especially if
you've put a lot of time and effort into adding machines and
configuring your LightBurn installation exactly how you like
it. To avoid repeating all that work, you can export your
preferences on your old computer using File > Export

Prefs, and then import them on your new computer using 
File > Import Prefs. Starting in verson 1.3, there is also
an Import Prefs button in the Devices window if no lasers
have been added - this lets you import prefs when you first
open a fresh installation of LightBurn.

⌃

4.1.9 Automatic file backups
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4.2 Installation & Licensing

Primary Docs

4.2.1 Trial or License Activation

If you've never used LightBurn before, you'll be shown the
License and Trial page first. Here you can either enter and
activate a license key if you have one, or you can activate a
free 30 day trial by clicking "Activate Trial".

If you already have a license key, be sure to enter it exactly,
including the dashes, into the box labeled 'License Key' then
click the 'Activate License' button below it. We recommend
just copying the key and pasting it into the License Key box.

If you do not have an internet connection on the computer
you will be running LightBurn on, please follow the Offline
Activation instructions.

You can get back to this screen in LightBurn at any time by
going to the menu and clicking Help > License Management.

Once you have activated your license or the trial, click 'OK'

If you ever need to manage your license, such as deactivate
an old computer, follow the instructions on the License
Management page.

The next thing you'll see is the 'General Usage Notes' page -
this is a brief help page just to get you going. You can get
back to it any time in the Help menu, under Help > Quick
Help and Notes. Click OK.

You're almost done!

Next Step: Adding your Laser to Lightburn

4.2 Installation & Licensing
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Primary Docs

4.2.2 License Management

The license system used by LightBurn has a web portal that
you can use to view the computers on their license, and do
some basic tasks like remove a computer that has failed and
process an offline activation. 

If you purchased your key from LightBurn directly, you will
have access to this portal. If you purchased from a 3rd party
vendor, we would need to assign your license key to your
email address for you to use this. Contact us via email
(support@lightburnsoftware.com) with your full name and

license key to have us do this. 

To access the license portal, go to http://
lightburn.cryptlex.app

The first time you use the portal you will need to request a
password reset. Click 'Forgot Password', enter the email
address where you received your license key, and click
'Recover Password'. You will receive an email from Cryptlex
with a password reset link. Follow the link, choose your new
password, then log in. 

If you do not see it, please check your Promotions or Spam
folders as the password reset email sometimes ends up
there. If you still cannot find it, then your email provider
might be blocking the email from ever reaching you to begin
with - some email providers do this. We know Gmail works
well, and if you provide a Gmail account, we can put your
key under that instead so that you can access the portal. In
this case, contact us via email with your full name and
license key.

REMOVING AN OLD COMPUTER FROM YOUR KEY:

On the main screen you will see any licenses associated with
your email address, like this:

Clicking on "#/# Activations" next to a license will show
which computers are assigned to your license key, when
they were activated and last used, etc, like this:

Clicking one of the computers will show additional details,
and displays this icon in the upper-right:

Click that, and you have the option to delete an activation,
removing the license from that computer, and freeing up the
license seat for use on another machine.

OFFLINE ACTIVATION

If you have would like to license a computer without a
network connection, enter the license key, then click
“Request Offline Activation”. It will ask you to save a file that
contains the machine fingerprint as an offline request. Copy
that to a USB flash drive and bring it to a machine with a
network connection.

To do offline activation from the portal, open the .ofr file in a
text editor (Sublime Text or Notepad++ work nicely) and
copy the entire string. With your license being viewed, click
'Activations', then 'Offline Activation', and paste the copied
OFR content into the request box in the Cryptlex portal. This
will produce the .dat response file which is what you will put
back into the offline LightBurn system.

If you're not comfortable doing this yourself, you can email
the .ofr file and your license key to us, and we will process
and return the .dat response file that you use to complete
the activation.

If you’re trying to run the trial, there isn’t currently a way to
register the trial without an internet connection. It only
needs to be connected long enough to verify that the
machine hasn’t run the trial before, and doesn’t require the
connection after that.

4.2.2 License Management
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4.3 Adding A Laser

Beginner Docs First Steps

4.3.1 Laser Types

There are many types of laser cutters and engravers that
are compatible with LightBurn, let's talk about a few of
them.

Diode Lasers

These devices typically share a lot of design with 3D
printers, and are equipped with a small, fairly low-power
diode laser module. These devices can usually cut thin
pieces of wood or plastics, but are far more often used to
engrave wood or plastic surfaces with a design.

Sculpfun S9 Limit Switch Guide

Sculpfun S9 Flashing GRBL Guide

CO
2
 Lasers

These devices use a CO2 beam to cut through thicker pieces

of wood, plastics, or other organic materials. While there are
"galvo" style CO2 laser cutters, most of these are gantry

style, where the beam is "moved" about the cutting area
with a gantry system. Many of these lasers use a glass tube
filled with gas to produce the beam, hence the name.

3018/"CNC" Guide

Ruida Ethernet Guide

Trocen Ethernet Guide

Galvo Lasers

These devices have a fixed galvo head responsible for
actuating mirrors to move the beam, and usually have an
external box responsible for generating a beam. This beam
is produced by a CO2 or Fiber source to engrave, color, or

occasionally cut pieces of metal or glass.

JCZ/Galvo Guide

Machine Guides

Machine Guides

Machine Guides

4.3 Adding A Laser
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4.3.2 Adding A Laser

Primary Docs First Steps

Find My Laser

Start by clicking the Devices button in the Laser window to
open the Devices Page.

In the Devices page, click the 'Find My Laser' button, and
you'll see this screen:

Make sure your laser is powered on, connected to your
computer with a USB cable, and has completed any startup
sequence it needs to, like homing. When the laser is ready,
click Next.

After a short scan, LightBurn will list the devices it was able
to recognize:

In the above image, I have two lasers connected to my
computer - the first, a GRBL controller on COM9, and the
second, a Ruida DSP controller on COM3. Select your laser
and click 'Add Device'.

Is your laser a GCode, DSP, or Galvo device? What if it 
wasn't found?

GCODE DEVICES

If you have a GCode controller, you'll be asked if your
machine is an X-Carve or Shapeoko, because there are some
specific settings that need to be configured for those
machines. If you have one, click the appropriate button, if
not, click 'Other'. You may be asked where the origin of your
machine is, and if you want to home on startup. Nearly all 
GCode systems use the front-left as the origin.

If your machine has homing or limit switches, enable the
homing on startup, otherwise leave it off. If you see 
Error: 9  in the console later, it means you've enabled this
feature, but your machine isn't configured for homing.

With some GCode devices, additional configuration of either
LightBurn or the controller may be necessary.

Next: Connecting to the Laser

DSP DEVICES

If you have a DSP controller, the next screen will ask you
where your machine origin is. This is the corner the machine
goes to when looking for the homing switches when it
powers up. Click the home corner. If you get it wrong, things
may be backwards or upside down, but don't worry - you can
easily change it later.

When your laser is added, click 'OK' on the Devices page to
exit.

Next: Software walk-through for beginners

GALVO DEVICES

Galvo devices have a few more steps comparatively, where
LightBurn will attempt to import the markcfg7 file from your
EZCAD2 setup. Select the location, enter your workspace
size, and you'll be done. See the Galvo Setup page for a
step-by-step on completing these steps.

Next: Software walk-through for beginners

WHAT IF MY LASER ISN'T FOUND?

If LightBurn can't find your laser, it could be for a number of
reasons:

Missing drivers - If your laser came with its own
software or drivers, install it. Even if you don't plan to use
it, sometimes they contain necessary drivers that aren't
included with LightBurn.

In the case of galvo devices, they have a LightBurn
specific driver that needs to be used. See here for more
information.

Can't connect - Only one application can talk to your
laser at once. If you run other software, like RDWorks,

• 

• 

• 

4.3.2 Adding A Laser
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Easel, Carbide Create, AutoLaser, LaserCAD, etc, make
sure that software is not running when you run LightBurn.

Networked device - LightBurn can't automatically
configure a network-connected laser. For this, you'll have
to click 'Create Manually' and follow the steps.

Marlin controller - If you are using a Marlin controller,
they have a variety of baud rates and configuration
options, and they take significantly longer to reset than
most other controllers, so it's not practical to auto-search
for them - click 'Create Manually' and follow the steps.

Manually adding a Laser

If LightBurn can't automatically add your laser, because it's
not connected to your computer, or is connected over a
network, you can add a laser manually.

If you don't have a laser hooked up to your computer, you
can create a laser manually as shown below, using your best
guess for the settings. If you have a specific laser in mind,
you can look up the appropriate settings for it in that
machine's support.

Start by clicking the Devices button in the Laser window to
open the Devices Page.

Click the Create Manually button on the Devices page.

Device type:

LightBurn will open the New Device Wizard, and the first
thing you'll see is a list of the controllers supported by your
version of LightBurn:

• 

• 
I don't have a laser right now!

4.3.2 Adding A Laser
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Choose the entry that matches the type of controller or
firmware in your laser and click Next.

Connection type:

The next step is choosing how you connect to your laser. The
choices you see will depend on the type of connection
methods supported by your controller and LightBurn. Serial/
USB is the most common. Some controllers allow connection
by Ethernet (note that this includes both WIFI and wired).

Choose how you wish to connect, and click Next.

Name and work area size:

You can name the laser, which is very useful if you have
more than one, or just leave it as is.

You must set the size of the work area for your laser so that
LightBurn can make try to prevent things from going out of
bounds. If you don't know the exact size, you can easily
change this later in the Device Settings page.

Laser Origin and homing:

The origin setting is where the 'zero' point of your X & Y axis
meet. If you get this wrong, you can change it later in the 
Device Settings page. This setting also controls the
orientation of the output - if it's wrong, the output from your
laser may be mirrored or upside down.

If you have a GCode based controller, like GRBL,
Smoothieware, or Marlin, commonly used with diode lasers
or smaller hobby systems, in almost all cases the origin will
be in the front-left. With GCode based systems, you are
given the option to send the homing command when
LightBurn first connects. If your laser does not have homing
switches, leave this off.

4.3.2 Adding A Laser
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If you have a DSP controller, like Ruida, Trocen, or
TopWisdom, common in larger CO2 lasers with metal

cabinets and LCD displays, the origin corner will be the
corner that the laser head seeks out when you power it up.
With DSP controllers, the controller will automatically home
itself when powered up, so you will not see the option for
homing on startup.

All done!

That's it - The final page will show you a summary of your
choices. You can go back and fix anything if necessary, or
click Finish to create the new device entry.

Next Step: Connecting to the Laser

Primary Docs LightBurn Bridge

LightBurn Bridge

The LightBurn Bridge is only for use with lasers using Ruida
controllers.

The LightBurn Bridge was created by LightBurn to get
around some of the limitations of Ruida controllers. Ruida
uses the UDP network protocol, which does not guarantee
data transmission, and is therefore not reliable enough to
use over WIFI. Many computers no longer have a network
port, and running a network cable is often impractical or
cumbersome. In addition, Apple's device driver for the USB
connection to the Ruida has issues that often cause data
loss.

The LightBurn Bridge overcomes all of this. It's a Raspberry
Pi running software created by LightBurn to act as a relay
between your PC and laser. You connect to it using TCP, so
the commands are reliably sent even over WIFI. The Bridge
forwards the commands to the controller using a short
network cable, and relays responses back to your computer.

The LightBurn Bridge is simple to configure, requires no
drivers, and typically sends data 50% to 100% faster than a
USB connection. It looks like this:

If you purchased a kit with everything included, continue

below. But if you want to setup your own with a Raspberry Pi

you already have, follow the SD card flashing instructions

first.

The bridge is intended to be an appliance. We have tested
the software extensively, but we do not support
modifications to the hardware or firmware - if you alter the
system to add functionality beyond what is covered here, or
in the Advanced Guide, you’re on your own.

Warning

Danger

4.3.2 Adding A Laser
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LIGHTBURN BRIDGE SETUP

The LightBurn Bridge is pre-configured to connect to a laser
configured with an IP address of 10.0.3.3. In the Ruida
control panel, set the IP of your laser to this value, then
connect a network cable from the controller to the Raspberry
Pi, and plug in the Pi with its power adapter. If you need to
change the IP address, please check out the Configuration
Options, and please note the caveats to doing this, listed
there.

In LightBurn, in the Devices screen, click 'LightBurn Bridge'
to set it up:

Connecting the LightBurn Bridge to your network

LightBurn will open the LightBurn Bridge discovery wizard to
guide you through the setup.

On your computer or a mobile device, use the WiFi settings
to find the LightBurn Bridge device, and connect to it:

Note: The access point name you find will typically have a
four-character random string at the end of the name, such
as LightBurn Bridge E4B7 . This is to prevent conflicts if you
have multiple LightBurn Bridge devices in the same location.

4.3.2 Adding A Laser
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When you've selected the LightBurn Bridge access point,
click Next.

Note: You may also configure the WiFi manually, as shown
on the Advanced Usage page.

Configuring the Bridge in LightBurn

Now you need to tell the LightBurn Bridge which WiFi
network to connect to, and give it the network password. In
most cases, the configuration page on the Bridge will open
automatically. If it does not, browse to http://192.168.42.1 as
shown in the wizard page below. If you want to use your PC
to configure the Bridge, click the button shown to open your
browser to the correct page:

Setting the WiFi name and password

In the browser window, you'll see a page like this:

Select your WiFi network from the list of options, enter your
password, then click the 'Connect' button at the bottom.
You'll see a message appear near the top, telling you that
the bridge is connecting to your WiFi network. You can now
close the browser window and go back to the LightBurn
wizard.

If you were using your PC to configure the LightBurn Bridge,
re-connect the PC to your WiFi network if you need to.

Finding the LightBurn Bridge from your PC

LightBurn will now scan your network, looking for connected
devices, to find the new LightBurn Bridge. You'll see a
progress bar appear as it does this:

If LightBurn is able to connect to the Bridge device, and the
Bridge was able to talk to your laser, you should see
something like this:

If everything looks good, click 'Add Device' and you'll be
taken to the setup screen for the device, asking you to enter
the name, check the size, and so on. Click here to skip to the
next section.

If the either the Bridge or the laser are not found, you may
need to change the IP address on your laser to 10.0.3.3 (the
default for the LightBurn Bridge), or optionally, you can
configure the bridge to use a different address for your laser.

Name and work area size

You can name the laser, which is very useful if you have
more than one, or just leave it as is.

4.3.2 Adding A Laser

- 38/241 - (C) LightBurn Software, LLC

./img/Bridge/LightBurnBridge-ConfigureAccessPoint.png
./img/Bridge/LightBurnBridge-ConfigureAccessPoint.png
./img/Bridge/LightBurnBridge-WIFIConnectPage.png
./img/Bridge/LightBurnBridge-WIFIConnectPage.png
./img/Bridge/LightBurnBridge-Scanning.png
./img/Bridge/LightBurnBridge-Scanning.png
./img/Bridge/LightBurnBridge-FoundLaser.png
./img/Bridge/LightBurnBridge-FoundLaser.png


You must set the size of the work area for your laser so that
LightBurn can try to prevent things from going out of
bounds. If you don't know the exact size, you can easily
change this later in the Device Settings page.

Laser Origin

The origin setting is where the 'zero' point of your X & Y axis
meet. If you get this wrong, you can change it later in the 
Device Settings page. This setting also controls the
orientation of the output - if it's wrong, the output from your
laser may be mirrored or upside down.

With a DSP controller, like Ruida, Trocen, or TopWisdom, the
origin corner will be the corner that the laser head seeks out
when you power it up.

All done!

That's it - The final page will show you a summary of your
choices. You can go back and fix anything if necessary, or
click Finish to create the new device entry.

Next Steps

If your use of LightBurn Bridge is more complex than
indicated here, you may need to take a look at our Advanced
Guide for LightBurn Bridge.

4.3.2 Adding A Laser
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4.3.3 Connecting to the Laser

Once you have added your laser to LightBurn, it should
appear in the list of devices to the right of the 'Devices'
button in the Laser Window. If you only have a single laser, it
will be automatically chosen for you.

If you have more than one laser set up, you might need to
select the one to connect to by clicking here:

Depending on the type of controller you have, you might
have to manually choose the port that the laser is connected
to, by clicking where you see '(Choose)' in the Laser Window:

As long as your laser is connected to the same
communication port, LightBurn will reconnect when you re-
start. If you reboot your computer, or plug the controller into
a different USB port, you might need to re-select it.

If you see the '(Choose)' as shown above, you need to select
the port. If no ports are listed in the drop-down, it means
that no devices were found, which could mean that it is not
plugged in correctly, isn't powered, or you're missing a
driver.

If your laser disconnects for some reason, or enters an alarm
state and needs to be reset, you can quickly re-connect by
right-clicking the 'Devices' button in the Laser Window.

4.3.3 Connecting to the Laser
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4.4 Configuring A Laser

Primary Docs GRBL

4.4.1 Common Grbl Setups

If you have a GCode-based system, like a Shapeoko,
Eleksmaker, X-Carve, or Acro system, you might need to
make some simple changes to get the most from LightBurn.

Quick Reference

You might need to adjust your spindle max RPM value
( $30 ) to match the LightBurn default (1000) or vice versa.
The value in LightBurn is called "S-Value Max", in the 
Device Settings.

You might need to enable "Laser Mode" if you have GRBL
1.1f or later ( $32=1 )

If you have an older version of GRBL (prior to 1.1f) it's
highly recommended to upgrade the firmware, as Laser
Mode also prevents the machine from pausing with every
power change. The pause, which happens on older
versions, or when not using Laser Mode, will cause
excessive burn spots when engraving images.

If your machine uses negative workspace coordinates
you'll need to apply a workspace offset ( G10 L2 P1 xx yy ).

Set your machine status reporting to be relative to the
workspace origin, not the machine origin ( $10=0 ).

Make sure the controller is reporting positions in mm, as
expected by LightBurn ( $13=0 )

If your machine does not have homing switches (also
called limit switches) you will need to home it manually if
you want to use Absolute Coords or User Origin modes

Grbl Flavors

Grbl firmware was originally designed for CNC machines and
3D printers, with laser support added more recently. It is
highly configurable, and this is both a blessing and a curse.
The "standard" way a CNC machine is configured is
somewhat different from the way laser machines often are.
Luckily this is easy to change, and easy to switch from one
to the other.

The more recent versions of Grbl (1.1f and up) support two
things that are incredibly useful for lasers. The first is Laser
Mode, enabled by setting $32=1 in the firmware settings.
Laser mode eliminates the pauses that happen when
changing power output, because Grbl knows it's controlling a
laser which reacts instantly, instead of waiting for a spindle
to change RPM.

The second is a feature called variable power mode, or the
M4 command. In this mode, Grbl adjusts the laser power as
the machine speeds up and slows down, making for very
consistent cutting and marking. Older versions of Grbl do not
have this feature, and simply run the laser at a constant
power output for the duration of a cut. Since the machine

needs to slow down to take sharp corners, this means
corners get over-burnt, while long straight lines end up
lighter.

This also has the benefit that when the laser comes to a
complete stop, the beam turns off (zero speed equals zero
power), meaning that pausing a job automatically turns off
the laser. This is not always true with other versions of Grbl.

If you aren't already running Grbl 1.1f (or later) on your
controller, we highly recommend it for laser use. If this isn't
an option, that's ok, but your results won't be as good, and
pausing the laser runs the risk of leaving the beam on and
ruining the job.

Getting Machine Settings

Many GRBL based machines allow the settings of the
machine to be easily exported or viewed. For advanced
configuration like adding limit switches, updating firmware,
or setting up a new controller, you'll need to interact with
these values. LightBurn makes this easy to do by using the
Console window or the Machine Settings window to copy,
update, or reset your Machine Settings.

Opening the Machine Settings window allows you to more
concisely see the parameters labeled for you. You can from
this window, also export them to a file for later restoration,
like we did in our GRBL flashing guide here.

In the Console, enter $$  to ask the controller to return to
you the machine's configuration in that window. This is often
easier to do, as it avoids any potential of LightBurn not
knowing custom configuration a vendor may have made.

• 

• 

• 

• 

• 

• 

• 
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Shapeoko, XCarve, and other negative workspace

systems

Shapeoko machines typically use Grbl 1.1f, as do newer X-
Carve and some other systems, but as they are designed as
CNC machines, they are typically configured for negative
workspace coordinates, which LightBurn doesn't support.
This is an easy thing to work around though, using a
workspace offset.

We'll use a Shapeoko XXL as our example setup. This
machine has an 812mm x 812mm working area, and the
origin is set to the rear-right, with negative numbers going
down and to the left (onto our workspace). We're going to
leave the direction alone, but change the origin position by
using this command in the LightBurn Console window:

That command says "set an offset" ( G10 L2 ) in the first
coordinate system ( P1 ) of X -812  and Y -812 . (If your
machine is a different size, use your width and height values
in mm instead of the 812's shown here, and remember the
minus signs - those are important)

This shifts the origin point of the machine left and forward
by the size of the workspace. Then you tell LightBurn that
the origin is at the front-left of the machine, instead of the
rear-right, and you're done.

When you want to go back to using your machine for CNC
use, clear the offset with:

It is simple to set these up as macro buttons in the LightBurn
console window. Enter the first command into a macro and
call it "Use Laser", and enter the second command into a
different macro and call it "Use CNC". When you want to use
your laser, click the "User Laser" macro button, and when
you're done and want to switch back to CNC, click the "Use
CNC" button.

After setting this, you will also need to make sure your
machine is reporting coordinates relative to this workspace
origin, instead of the absolute machine zero. Do this by
entering $10=0 in the console.

X-CARVE

X-Carve machines sold prior to January 2018 generally run
an older flavor of Grbl (1.0c) which does not support the
variable power ( M4 ) command, meaning you'll need to use
the Grbl-M3 device in LightBurn. Machines sold after that
date use Grbl 1.1f, and will work with the standard Grbl
device in LightBurn if the following settings commands are
entered in the console:

These two lines:

Set the spindle max value ($30) to match LightBurn and
Grbl's default setting (1000)

Enable laser mode ($32=1)

OTHER MACHINES

If you aren't sure how to configure your machine, there are
some simple steps to take that can help. First, figure out
which firmware you're running. In LightBurn, when you first
connect to the machine, the console window will usually
show a 'hello' message from the controller. For
Smoothieware boards it's just "Smoothie". For Grbl, it will be
"Grbl 1.1f [$ for help]" or similar - this tells you it's Grbl, and
which version. Machines using Grbl 1.1f or later will support
the M4 variable power command, and just use the "Grbl"
driver in LightBurn. Grbl 1.1e or older (Grbl 1.0, Grbl 0.9,
etc) must use the Grbl-M3 device in LightBurn.

With the driver identified, it's time to find the machine
origin. First, home the machine by pressing the Home button

( ) on the Move window.

In the console window, type

then hit enter. Your machine will head toward its origin
position. This isn't always the same as where the home
position is. Usually the home position is in one of the
corners. Most often it will be the rear-right, or front-left of
the machine. In some cases, it might be the center of the
work area. If your machine does this, skip ahead to Center
Origin Machines below.

After it stops moving, type

G10 L2 P1 X-812 Y-812

G10 L2 P1 X0 Y0

$30=1000

$32=1

• 

• 

G0 X0 Y0

G0 X10 Y10
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then hit enter. If your machine moves 10mm into the work
area on both axis that's good - it means your machine uses
positive workspace coordinates. You simply set the origin in
LightBurn to match the machine origin discovered above. If
your machine bumped the rails, it uses negative
coordinates.

Negative Coordinate Machines

If your machine uses negative coordinate space, we need to
offset the origin.

LightBurn wants positive workspace numbers, like this:

This image shows the origin at the front-left, with positive X
values moving to the right, and positive Y values heading to
the rear of the machine.

A negative workspace system looks like this:

In this image, the origin is at the rear-right of the machine.
The X and Y directions are the same as before, but now, to
move into the work area, you would need to use negative
numbers. Instead, we're going to set up a work offset.

You'll need to know the total distance your machine can
travel in both axis. For a Shapeoko XXL, for example, it's
812mm in X and Y. For a 500x500 X-Carve, it's 250mm in X
and Y. By applying a workspace offset that is the size of your
machine area, we can shift the offset to the opposite corner,
like this:

Enter the following command:

in the console, and hit enter. Note that the '250' above
should be replaced with the total travel width and height of
your machine. If your machine had a 600mm width and
400mm height, you would use:

This command offsets the origin by the given amounts. If the
origin used to be in the rear-right of the machine, and you
offset it in the negative direction by the width and height of
the work area, you've moved the origin to the front-left.

If you enable a workspace offset, you will also need to make
GRBL report its location relative to this shifted origin, instead
of in "machine space" by setting $10=0. Some systems, like
Easel or Carbide Motion, may need a different value, so it is
good to remember the existing setting.

Center Origin Machines

Some systems have their origin in the center of the
workspace. After homing your machine, enter this command
in the console and hit enter:

That command says "rapid move to coordinate 0,0"

If your machine travels to the center of the workspace
instead of the rear-right you will still need to move the origin
just like in the "Negative Coordinate Machines" above, but
only by half the size of your workspace. Follow the directions
for a negative coordinate space machine, but divide your

G10 L2 P1 X-250 Y-250

G10 L2 P1 X-600 Y-400

G0 X0 Y0
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workspace numbers in half before issuing the GCode offset
command.

Machines without homing sensors / limit switches

If your machine does not have homing switches (also called
limit switches) you will need to home it manually if you want
to use Absolute Coords or User Origin modes. You can do this
in a couple ways:

With the machine off, manually move the laser head to
the origin position (usually front-left), then power up the
machine. Until you tell it otherwise, the power-on location
of the controller is treated as the zero position.

With the machine powered, jog the laser head to the
origin position. In the console window, type: G92 X0 Y0
and press (enter). The G92  command tells GRBL to set the
current location as the specified coordinate, so you're
telling the machine "this is zero". You will also need to set
$10=0 for this to work correctly.

XTOOL WI-FI UPLOAD

As of LightBurn 1.2.02, we do not support uploading GCode
to the XTool family of lasers via Wi-Fi. The upload mechanism
is significantly different than that of the currently supported
methods, and that development hasn't yet been completed.
Thank you for understanding.

• 

• 
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Primary Docs Ruida

4.4.2 Configuring a Ruida

When purchasing a laser with a DSP controller installed, the
factory making the machine configures the laser controller
for you to tell the controller how fast and in what directions
to move, where the homing switches are, and so on.

If you are installing a new controller into a machine, you will
need to perform the configuration that is normally done for
you by the factory.

A somewhat common mistake for new users is doing a
'factory reset' of their controller - this resets it to the stock
configuration supplied by Ruida, not the configuration
applied by the company that set up your laser, so it's not
recommended to do this. Chances are you already have,
which is why you're here.

Ruida Machine Settings in LightBurn

With the laser connected to your computer, go to the bottom
of the Edit menu and click Machine Settings. LightBurn will
open the Machine Settings window and read the
configuration from your controller. You should see this
screen:

The top section of the list is referred to as user settings -
these are settings that are intended to be tunable by the
user if necessary. The lower section, under 'Vendor Settings'
are things usually configured for you by the factory and
should only be changed if you have a good reason for doing
so.

It's also a good idea to back up the initial settings before you
change them, so you can go back to what you had if you
make a mistake and can't remember what you did.

The 'Read' button tells LightBurn to read the settings from
the controller (this happens automatically when you open
the Machine Settings window). The 'Save' button will write
all settings to a file. 'Load' will read settings from a file back
into memory. 'Write' commits the settings in LightBurn back
to your controller.

In the bottom of the Machine Settings window is a heading
called Vendor Settings. Click it to 'unroll it' and you'll see
something like this:

The first section is general configuration, and then there are
settings that are specific to each axis, followed by a Laser
section, for configuration specific to the laser type.

Homing, Directions, and Travel

A DSP laser will have homing switches - one on each axis.
They might be physical lever-type micro switches, optical
beam-break switches, or inductive proximity sensors. Locate
the switch at the end of the X axis, and the one for the Y

4.4.2 Configuring a Ruida

- 45/241 - (C) LightBurn Software, LLC

img/MachineSettings-Ruida.png
img/MachineSettings-Ruida.png
img/MachineSettings-RuidaVendor.png
img/MachineSettings-RuidaVendor.png


axis. Note that the Ruida homes using the X- and Y- limit
switches.

When you power up the laser, the first thing it will do is
move toward the corner it thinks those switches are at to
home itself. If it's moving in in the wrong direction, you'll
have to hit the ESC button on the controller itself to stop it.

Bring up Machine Settings in LightBurn, and go to the
Vendor settings section at the bottom, and open the X axis
and Y axis Settings. Near the top of each will be three check
boxes:

Invert Keypad Direction

Limiter Polarity

Direction Polarity

The first (keypad direction) controls which way the arrow
buttons move the laser. The second (limiter polarity) tells
the controller whether the limit switch triggers high
(normally open) or low (normally closed) when contacted,
and the 3rd (direction polarity) controls which way the motor
moves in general.

There are only 4 possible combinations of "limiter polarity"
and "direction polarity" for each axis. I can't tell you which is
the correct combination, but change those settings for the X
axis until it moves properly when you power the machine,
then do the Y axis. Once these are set, the next steps are
easier.

When the limiter and direction settings are correct, check
that the keypad arrows on the machine are moving the laser
in the correct direction. If not, toggle the 'Invert Keypad
Direction' button for whichever axis is wrong.

You will also need to set the 'Max Travel' value for the X and
Y axis - these numbers dictate the length of each axis, and
together define the size of the work area of the machine.

Step Length Calibration

The next part is figuring out how far the laser moves when
you tell it to, and how far off it is. The controller needs to
know how far a single step moves when it sends a step pulse
to the motors so it can translate real measurements into the
proper number of steps.

Rough Calibration

In LightBurn, set the 'Start From' setting in the Laser window
to Absolute Coords, like this:

Then draw a small rectangle at the origin. Start with 10 x 10
or 20 x 20 mm, like this:

Note that your origin corner might be in a different spot than
mine - you should set it in the device settings to match the
origin corner of the machine.

Now, use the 'Frame" button (shown above, near the 'Start
From' setting) and see how big it frames. If it's barely
moving, your step size is too big (the controller thinks it is
moving more than it is). If it moves way too far, the step size
is too small (the controller thinks it has to take lots more
steps than necessary).

This part is just doing rough adjustment - it's not accurate at
all, but you need to get into the right ballpark before doing
the next part.

In the Machine Settings again, in the settings for the X and Y
axis, are values called 'Step Length' Adjust those according
to what I said above - If the controller doesn't move enough
by half, cut the step length in half. If it moves twice as far as
it should, double the step length. Frame again, and iterate
until the size of what you've drawn and the size the laser
frames is reasonably close.

Final Calibration

Now, draw a box similar to the original, but make it 100 x
100, or 200 x 200 (mm), set the Min and Max power low to
start, but high enough to make a mark, and run the job it on
a piece of scrap material. Measure the result as accurately
as you can.

This time, actually do the real math with the step size:

New Step Size = (Current Step Size * Measured Length) /
Requested Length

If the controller complains about 'water protect', you can
disable the water protect setting in the machine settings.
Ditto for the door protect (it's the lid open switch). If you
have a flow meter, you should have it hooked up so you
know you have water running through the tube, and have
the water protect enabled.

As you are dialing in the above settings, if the steppers skip
or make buzzing sounds, you might need to reduce the Idle
Acceleration or Idle Speed settings near the top. Those
things will require tuning with some trial and error.

FIXING SKEWED ENGRAVING

An occasional problem with new setups, and sometimes
even existing machines, is lines cutting correctly, but
engravings coming out slanted or skewed, like this:

• 

• 

• 

• 
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If your output looks like this, you likely have your motor
pulse step polarity set incorrectly. On Ruida controllers,
there’s a setting called ‘PWM Rising Edge Valid’ that you can
change for each axis that tells the controller whether the
rising edge or falling edge of a step pulse is what the motor
driver is looking for. Toggling this may fix skewed engraving.

The fix is relatively simple. In Edit > Machine Settings, look
in the X & Y axis motor settings section at the bottom, and
look for the value of 'PWM Rising Edge Valid' on the X axis.
Change that - if's it's checked, un-check it, or vice versa.
Then, copy the new setting over to the Y axis as well.

What is this setting and why does it matter?

A step pulse is a transition from low to high, or high to low.
The controller will hold the line low, and pulse it high, or hold
the line high, and pulse it low. The transition itself is what
matters, and motor drivers will either look for a transition
from low to high (rising edge) or high to low (falling edge) to
accept as a ‘Step’.

If the laser controller believes that the motor driver is
looking for the leading edge signal (when it transitions from
low to high), it will pulse the line, and could change the
direction line immediately after that. If the motor driver is
waiting for the falling edge, it will see the direction change
BEFORE the falling edge of the pulse, meaning that it will
change direction one step too soon.

[

In the image above, the upper line of steps is interpreted as
4 steps in one direction, then two in the other. The lower line
is interpreted as 3 and 3, and the only difference is which
side of the step signal the driver is looking for.

Start & End Delay

This features adds in a start/stop delay to allow the laser to
enable any systems it enables itself when starting a job. This
gives, for example, fans time to get to speed or evacuate
the air in the laser before stopping when done.
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4.5 User Interface & Features

4.5.1 Menus

The various features in LightBurn are accessed through the
menus. The various features in each menu are listed and
explained here.

File Menu

Edit Menu

Tools Menu

Arrange Menu

Laser Tools Menu

Window Menu

Language Menu

Help Menu

File Menu

NEW

Clicking "New" in the File Menu will clear any current project
and create a new one. You can also press Ctrl + N  / 

Cmd + N .

NEW WINDOW

Clicking "New Window" will open a new instance of
LightBurn. This can be used to run jobs on multiple lasers at
the same time or quickly jump between projects.

Please note that if you change LightBurn's settings while you
have multiple windows open, the settings in whichever
window is closed last will be saved to the preferences file
and will overwrite any changes you made previously in other
windows.

RECENT PROJECTS

This will open a list of the most recently opened files to
choose from.

OPEN

To open an existing or saved file, click on “Open” in the File
menu or press Ctrl + O  / Cmd + O .

IMPORT

You can import any supported LightBurn files into the file
you are currently working on. Click on “Import” in the File
menu or press Ctrl + I  / Cmd + I  LightBurn
supports importing the following file types: svg, ai, pdf, dxf,
hpgl, plt, png, jpg, bmp, tiff, gif, webp.

SHOW NOTES

Add or view project comments through this menu. ( Ctrl

+ Alt + N )

SAVE

To save a project click on “Save” in the File menu or press 
Ctrl + S  / Cmd + S . Type the name you want the file

saved as in the dialog box that opens up. 

SAVE AS

To save a file with changes, but still keep the original file
intact, click on the “Save As” icon in the File menu.

SAVE GCODE

Generates and saves the GCode (the code that gets would
normally be sent to the laser cutter) for the project as it
currently stands. ( Alt + Shift + L )

This option will only be enabled for devices that
communicate via GCode. 

EXPORT

To export a file to a different file format, click on “Export” in
the File menu ( Ctrl + X  / Cmd + X ). LightBurn can
export to SVG, AI, and DXF formats. Bitmaps are only
exported in SVG files, and text is automatically converted to
simple shapes in all export formats. ( Alt + X )

If you have objects selected, only those will be exported,
otherwise it will export the entire content of your project. If
you have exactly one bitmap selected, you will also be given
the option to export as PNG or JPG.

PRINT (BLACK ONLY)

This menu item ( Ctrl + P ) outputs a black and white
document to be sent to a printer or built-in "Print to PDF"
tools. This document is saved exclusively in black/white.

PRINT (KEEP COLOR)

Similarly to above, you can use Print (keep color) to send to
a physical printer, or to a file, your design for review,
markup, etc. The export is sent with the same colors as
selected in the [Color Palette]. This can also be triggered by 

Ctrl + Shift + P .

SAVE PROCESSED BITMAP

Exports a copy of a bitmap that you have edited in LightBurn
with the edits. 

SAVE BACKGROUND CAPTURE

If you have a camera connected, this function saves a
screenshot of the camera feed. 
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OPEN PREFS FOLDER

Opens the folder containing your LightBurn preferences in
your file browser. 

EXPORT PREFS

Allows you to export your preferences as they currently
stand. 

IMPORT PREFS

Allows you to import preferences from an exported copy. 

LOAD PREFS BACKUP

Allows you to import preferences from a list of (automatically
saved) versions.

EXIT

To exit LightBurn, click on the “Exit" in the File menu or press
Ctrl + Q  / Cmd + Q . You will be prompted to save

your file if you have unsaved changes.

Return to top

Edit Menu

UNDO

To undo the last editing action done on the current file, click
on "Undo" in the Edit menu or press Ctrl + Z  / Cmd

+ Z

REDO

To Redo the last editing action done on the current file, click
on "Redo" in the Edit menu or press Shift + Ctrl + Z  / 

Shift + Cmd + Z

SELECT ALL

To select all objects in the current file click on "Select all" in
the Edit menu or press Ctrl + A  / Cmd + A .

INVERT SELECTION

Selects the opposite of what you have currently selected.
E.g. if you have one object selected, it will select every
object except that one. ( Ctrl + Shift + I )

CUT

To one or more objects from the current file, select them and
click on "Cut" in the Edit menu or press Ctrl + X  This
will put the object on the clipboard, and remove it from the
current file.

COPY

To copy one or more objects, select them and click "Copy" in
the Edit menu or press Ctrl + C  / Cmd + C  This will
put the objects on the clipboard, but leave the original
object alone.

DUPLICATE

To duplicate a selection in place, select one or more objects
and click "Duplicate" in the Edit menu or press Ctrl+D. This
is an "in-place" copy and paste operation all in one,

bypassing the clipboard. This means if you already have
something on the clipboard, it'll still be there after using
Duplicate. The duplicate is placed directly on top of the
original.

PASTE

To paste an object from the clipboard click "Paste" in the Edit
menu or press Ctrl + V . This will place a copy of the
clipboard contents in the current file. Note that LightBurn
can paste text or images copied to the clipboard from other
software.

PASTE IN PLACE

To paste an object from the clipboard click "Paste in place" in
the Edit menu or press Alt + V . This will place a copy
of the clipboard contents in the current file in the same spot
that it was in the original file. 

DELETE

To delete an object select it and click "Delete" in the Edit
menu, or hit Del . This will remove the object from the
current file.

CONVERT TO PATH

This converts a built-in shape object, like a rectangle, ellipse,
or text, into lines and curves that can be edited. Click on
"Convert to path" in the Edit menu, or enter Ctrl shift+c+
+. The original shape information is lost, so you won't be
able to change text with the text tool after using this.

CONVERT TO BITMAP

This converts selected vectors into bitmaps (rasters/pixels).
( Ctrl + Shift + B )

CLOSE PATH

In order to Fill a shape with your laser, the shape must be a
closed loop, where the starting and ending point are the
same. If the start and end points are very close, but not
quite connected, "Close Path" will move them together. Click
on "Close path" in the Edit menu or press Alt+C.

CLOSE PATHS WITH TOLERANCE

Works similarly to close paths, but allows you to set a
tolerance for "close" points, so that it doesn't join parts that
are far from each other. 

AUTO JOIN SELECTED SHAPES

Looks at the start and end points of all the selected curves,
and if any of them are close enough, connects them
together into a single shape. Useful when importing DXF
files, which don't contain connectivity information. Click on
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"Auto join selected shapes" in the Edit menu or press 
Alt + J .

OPTIMIZE SELECTED SHAPES

Attempts to fit the selected shapes to arcs and lines within a
specified error tolerance. Useful for reducing the point count
in a shape, or recovering arcs from software that exports
them as many small line segments.
( Alt + Shift + O )

DELETE DUPLICATES

This will delete duplicate items within the drawing, for
example if two squares are identical and one on top of the
other, this will delete the extra square. This helps to
minimize erroneous moves and double-cuts. ( Alt + D )

SELECT OPEN SHAPES

This will select all open shapes in the document.

SELECT OPEN SHAPES SET TO FILL

This will select all the open shapes that are set to fill in the
document.

SELECT ALL SHAPES IN CURRENT LAYER

This will select all the shapes that are set to cut in the
current layer of the document. Note that if some of these
shapes are grouped, the system may have to un-group them
in order to select them.

SELECT CONTAINED SHAPES

Will select all the shapes that fall entirely within the shape
you have selected. 

IMAGE OPTIONS

Offers you various ways to refresh or replace bitmap images
in your project. Handy if you have made some edits to a
bitmap in a different editing software, and you want to
replace the old version you have open in LightBurn. 

Refresh Image

Reload Image

Replace Image To Fit

SETTINGS

Clicking on "Settings" in the Edit menu will open the Settings
window, where you can change general user settings and
preferences.

DEVICE SETTINGS

Opens the Device Settings window, for editing LightBurn
preferences specific to the chosen laser.

MACHINE SETTINGS

Opens an editor that allows reading and writing firmware
settings from supported controllers.

DEBUG DRAWING

This is mostly an internal tool for LightBurn developers that
shows the bounds of shapes being drawn.

CONVERT TO CUT (DEBUG)

Also an internal tool for LightBurn developers - It converts
the selected shapes into the cuts that would be sent to the
laser, and makes a new shape from the result. This is not
how you produce gcode / cuts for your machine, it's just a
debugging tool for the LightBurn developers.

Return to top

Tools Menu

Many of the tools in this menu are also available as icons in
the tool toolbar that by default, is on the left side of the
workspace. See Creation Tools for more information.

SELECT

Click on "Select" to select objects in the workspace, or to
access menus and toolbars.

DRAW LINES

Click on "Draw Lines" or press Ctrl + L  to draw straight
or curved lines in the workspace. Click + Drag to make
curved lines. 

RECTANGLE

Click on "Rectangle" or press Ctrl + R  to draw
rectangles in the workspace.

ELLIPSE

Click on "Ellipse" or press Ctrl + E  to draw ellipses in
the workspace.

POLYGON

Create a regular polygon with a variable number of sides
(triangle, hexagon, octagon, etc). ( Shift  & drag)

EDIT NODES

Click on "Edit Nodes" or press ++ctrl+~++ to edit nodes of
objects in the workspace.

EDIT TEXT

Click on "Edit Text" or press Ctrl + T  to create or edit
text in the workspace.

POSITION LASER

Allows you to click on a place in your project, and have your
laser move to that point in real life (works best with absolute
coordinates/end-stops). 

MEASURE

Opens up a window that provides you with various
information about objects as you hover over them in your
scene. Things like line length, start and end point, etc. 
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CREATE QR CODE

Allows you to create a QR code containing various
information such as: Wifi details, contact info, links, text, raw
content, etc. 

OFFSET SHAPES

Used to create new shapes that are offset from the current
selection, inward or outward.

WELD SHAPES

Fuses multiple shapes together into a single outline.

BOOLEAN UNION

Adds two closed paths together into one mass so that all
their intersecting lines disappear. 

BOOLEAN DIFFERENCE

Select an closed path you want cut, and then also select
another that you want to cut out of the first and then click
Boolean Difference to do so. 

BOOLEAN INTERSECTION

Select two closed paths and click Boolean Intersection to
remove all the areas that don't overlap. 

BOOLEAN ASSISTANT

Gives you a preview of the Boolean functions described
above, to help you choose the correct one. 

CUT SHAPES

Select the shape you want cut and also select another
shape, then select Cut Shape. The outcome will both what
you would get from a boolean difference and a boolean
intersection. This also works on open paths (unlike the
boolean operations). 

ADJUST IMAGE

Allows you to edit a bitmap image in various ways, such as
brightness, contrast, image processing mode, negative, etc. 

TRACE IMAGE

Opens the image tracing tool where you can trace the
content of a bitmap image into vector graphics.

APPLY PATH TO TEXT

If you select a shape and a line of text, this command will
attach the text to the shape, so the text follows the path.
This allows you to make curved text. (Read more here)

APPLY MASK TO IMAGE

Select a closed shape and a bitmap, and this function will
cut the bitmap to fit the shape. See how to use this tool
effectively here.

Return to top

ARRANGE MENU

Group

Click on "Group" or press "Ctrl + G" to group the selected
objects in the workspace.

Ungroup

Click on "Ungroup" or press "Ctrl + U" to ungroup the
selected objects in the workspace.

Auto-Group

Automatically groups shapes within other shapes that
contain them.

Flip Horizontal

Click on "Flip Horizontal" or press "Ctrl + Shift + H" to flip
the selected objects in the workspace horizontaly.

Flip Vertical

Click on "Flip Vertical" or press "Ctrl + Shift + V" to flip the
selected objects in the workspace vertically.

Mirror Across Line

Select objects and the shift select line to mirror them about,
and then click "Mirror Across line" or press "Alt+M".

Rotate 90° Clockwise

Select objects and click "Rotate 90° Clockwise" or press ".".

Rotate 90° Counter-Clockwise

Select objects and click "Rotate 90° COunter-Clockwise" or
press ",".

Two-Point Rotate / Scale

Select object and click "Two-Rotate / Scale " or press "Ctrl/
CMD + 2". Click the point you will rotate about, then to only
rotate, move the mouse to the second point. To scale hold
shift while rotating. For more information see Two-Point
Rotate / Scale

Align Centers

Click on "Align Centers" to place the center points of the
selected objects directly on top of each other.

Align Left

Click on "Align Left" or press "Ctrl + Shift + Left arrow" to
align the selected objects in the workspace to the left.

Align Right

Click on "Align Right" or press "Ctrl + Shift + Right arrow" to
align the selected objects in the workspace to the right.

Align Top

Click on "Align Top" or press "Ctrl + Shift + Up arrow" to
align the selected objects in the workspace to the top.

Align Bottom

Click on "Align Bottom" or press "Ctrl + Shift + Down arrow"
to align the selected objects in the workspace to the bottom.

Align H-Center
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Click on "Align H-Center" to align the selected objects in the
workspace to the center of the horizontal plane.

Align V-Center

Click on "Align V-Center" to align the selected objects in the
workspace to the center of the vertical plane.

Distribute

Provides various methods of evenly spacing objects across
various axes. 

Move H-together

Click on "H-together to move shapes like distribute, but
keeps shapes together

Move V-together

Click on "V-together to move shapes like distribute, but
keeps shapes together

Nest Selected

Exports selected objects to a file, copies that file path, and
opens SVGnest.com so you can upload the file and nest your
objects. 

Dock

A little like simple nesting. Select some shapes and click one
of the directional docking buttons, and LightBurn will "dock"
all your shapes together in that direction, moving them
together until they touch. See Docking for more information.

Move Selected Objects

Offers various places to move the selected objects to, such
as page centre, laser position, upper left, etc. 

Move to Page Center

Click on this to move selected objects to center of page

Move to Upper Left

Click on this to move selected objects to Upper Left of page.

Move to Upper Right

Click on this to move selected objects to Upper Right of
page.

Move to Lower Left

Click on this to move selected objects to Lower Left of page.

Move to Lower Right

Click on this to move selected objects to Lower Right of
page.

Move Laser to Selection

Offers various ways for you to move the laser to parts of the
object you have selected, like the top left or centre of it. 

Grid / Array

Click on "Grid / Array" to create an array or grid of objects in
the workspace. A window will open allowing you to enter the
parameters for the array or grid. For more details, see here.

Circular Array

Click on "Circular Array" to create an array or grid of objects
in a circle in the workspace. A window will open allowing you
to enter the parameters for the array. For more details, see 
here.

Copy Along Path

Click on "Copy Along Path" to make copies of your selected
shape(s) along a path. First, select the object(s) you want to
copy, then select the path to copy along. Then select "Copy
Along Path". You can create a certain number of copies or
set the space between copies. By default, the orientation of
your copies will stay the same, but the "Rotate" option will
cause the shape to rotate along the path.

Create Rubber-Band outline from selection

Creates an outline on the current layer encompassing all
selected parts. 

Break apart

Click on "Break apart" to break selected object into
individual parts.

Push forward in draw order

Click on "Push forward in draw order" or use "Page up" key
to move the selected object up one level in the draw order.
Usefull when trying to see objects on the screen.

Push backward in draw order

Click on "Push backward in draw order" or use "Page down"
key to move the selected object down one level in the draw
order. Usefull when trying to see objects on the screen. "Ctrl-
PgDn" or "Ctrl-PgUp" will send an object to the very bottom,
or very top of the objects on the screen.

Push to Front

Moves the selected object to the top of the drawer order.

Push to Back

Moves the selected object to the bottom of the drawer order.
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Note: Drawing order changes only work in wireframe
(outline) rendering mode, not filled. In filled rendering mode,
the display order will always match the layer order.

Lock Selected Shapes

Locks selected shapes from being edited in any way. 

Unlock Selected Shapes

Unlocks selected shapes to allow them to be edited again.

Return to top

LASER TOOLS MENU

The Laser Tools menu is the new home for utilities that
interact with the laser.

Print and Cut

This sub-menu lets you run the Print and Cut wizard, set the
targets, enable the different Print and Cut modes, or reset it.

Calibrate Camera Lens

Open the camera lens calibration wizard. For more
information on setting up the camera, see here.

Calibrate Camera Alignment

Open the camera alignment calibration wizard. For more
information on setting up the camera, see here.

Rotary Setup

This will open the rotary setup dialog box. Use this to set up
your rotary attachment.

Feeder Setup

This will open the auto-feed setup dialog. Use this to set up
the auto-feed table controls for Ruida controllers with an
auto-feeding table.

Focus Test

Opens the Focus Test generator tool. Requires a machine
with a controlled Z-axis.

Interval Test

Opens the Interval Test generator tool, though this has been
largely replaced by the Material Test generator below.

Material Test

Opens the Material Test generator tool, which lets you
generate and run test grids with varying settings.

Center Finder

Opens the Center Finder tool, used to locate the center of a
circular object in a few simple steps. see Center Finder

WINDOW MENU

Reset to Default Layout

To arrange the windows and menus back to the original
default layout, click on "Reset to Default Layout" You can use
the Window menu to toggle windows and menus on or off.

Preview

Click on "Preview" or press "Alt + P" to open the preview
window. It will show the current laser project and includes
information on cut distance, rapid moves, and total time
estimate. Cut lines are in black and traversal moves are red.
You can toggle the display of traversal moves on or off, as
well as shading by power level.

Zoom to Page

Zooms so that the full workspace is in view. 

Zoom In

Click on "Zoom In" or press "Ctrl + =" to zoom in the
workspace.

Zoom Out

Click on "Zoom In" or press "Ctrl + -" to zoom out in the
workspace.

Frame Selection

Zoom the view to completely contain the current selection.
(Ctrl + Shift + A)

View Style

Allows you to change the appearance of objects in your
scene from wireframe or filled modes. 

Return to top

LANGUAGE MENU

Choose the language you would like to have LightBurn use in
this menu.

Return to top

HELP MENU

About LightBurn

Shows your LightBurn Version, copyright and attribution
information. 

LightBurn Support Forum

Links to our online forum where you can get help from our
support staff and the community. 

Quick Help and Notes

Click on "Quick Help and Notes" or press F1 to access hotkey
list, general usage notes and version information.

Online Documentation

Click on "Online Documentation to access the
documentation for LightBurn.
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PDF Documentation

Links to a PDF copy of our documentation, if you prefer
reading pages over online text. 

Online Video Tutorials

Click on "Online Video Tutorials" to access the tutorial
videos.

CorelDraw macro setup help

Links to documentation about installing the LightBurn macro
for CorelDraw

Generate Support Data

Generates encoded data that is handy to provide to our
support staff when you are seeking help with a problem. 

Camera Selection Help

Helps you select an apropriate camera for your laser cutter. 

Check for Updates

Click on "Check for Updates" to make sure you are on the
most recent version.

License Management

Launch the license dialog, where you can enter your license
key, or see the status of your trial period or license.

Enable Debug Log

This is for the developers, turn on the log by clicking on
"Enable Debug Log". The log file will be written to your "My
Documents" folder on Windows, or Documents on Mac, and
is cumulative - each time you enable the debug log it will
append to any existing log, so it's a good idea to delete it
after you're finished.
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4.5.2 Windows & Buttons

LightBurn Windows

This is a list of all the standard windows (and toolbars)
available in LightBurn, and how to use them.

USER INTERFACE

Main Elements

Main window, menus, and status bar

Main Toolbar (file, clipboard, view, settings)

Move window (jogging and positioning)

Laser Control (status and control)

Editing

Arrangement Toolbar (grouping, mirroring, alignment,
distribution)

Zooming, Panning, and Selecting Items (traversing the
workspace)

Creation tools (selection, shapes, text, node editing)

Modifier tools (offsetting, Boolean operations, grids)

Numeric Edits (size, position, units)

Fonts and Text (choice, configuration)

Variable Text (dynamic text content)

Shape Properties (configuration, power, cut order)

Cut Settings

Cuts & Layers (how the laser treats your graphics)

Color palette

Libraries

Art Library (store assets that get reused)

Material Library (store materials that get reused)

Machine Specific

File List (files on DSP controllers)

Console (textual control interface for GRBL/GCode)

Camera Control (adjust and calibrate cameras)

Setup

LightBurn Settings (global LightBurn settings)

Machine Settings (on-machine settings)

Device Settings (settings specific to each laser)

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Main Toolbar

Hover over an icon to see the name, click for more

information.

NEW

Create a new file.

OPEN

Open a file. By default, the dialog box filters for LightBurn
( .lbrn  and .lbrn2 ) files, but you can use the dropdown to
show all supported file types, supported image file types, or
supported vector file types.

Open will open the file as a LightBurn project. If you want to
bring a file into an existing project, please use Import
instead.

IMPORT

Import a file into your currently open project. By default, the
dialog box shows all supported file types, but you can use
the dropdown to filter for support image file types or
supported vector file types.

UNDO & REDO

Undo and redo your actions in LightBurn.

COPY, CUT, PASTE, DELETE

Copy will save a copy of your selected object(s) to the
computer's clipboard. Cut will do the same, in addition to
removing the existing object(s) from the page. Paste will
insert the contents of your computer's clipboard into
LightBurn. Delete will remove the selected object(s) from the
page.

PAN / DRAG VIEW

Allows you to click to drag the page around. If using a
mouse, you can accomplish the same thing by clicking the
mouse wheel and dragging.

ZOOM TO PAGE

Zoom to show the page as large as possible, centered within
your LightBurn window.

ZOOM IN & ZOOM OUT

Zooms your page in to get a closer view, or out to see more
of the page at once.

ZOOM TO FRAME SELECTION

Zoom to show the selected objects as large as possible,
centered within your LightBurn window. If no objects are
selected, it will instead zoom to show all objects on the
page. Unlike Zoom to Page, it will ignore empty space on
your page.

UPDATE THE BACKGROUND FROM THE CAMERA

Update the camera overlay, if you're using a camera.
Grayed out and unselectable when the camera is not in use.

PREVIEW

Open the Preview Window.

SETTINGS

Open the general LightBurn Settings window.

DEVICE SETTINGS

Open the Device Settings window.
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Primary Docs UI GRBL Ruida

Move Window

The Move window is used primarily for jogging and
positioning, as well as homing functions.

This window will not show up for Galvo devices. Their mirror
configuration means "static movement in the workspace"
doesn't behave as expected.

Get Position, when pressed, will query the controller for its
current location, and display it in the X,Y,Z,U fields to the
right.

The Go button on the right side will send the laser to the
entered coordinates in the Move to Position entry boxes.

The Saved Positions drop-down displays a list of previously
stored positions. This can be useful for jogging to known
locations on the work area, like a specific corner, the
location of your rotary tool, commonly used jigs, and so on.
You can manage the contents of this list by clicking the 
Manage button on the right.

To jog your laser, click one of the arrow buttons around the
home button. This will move your head by the set distance,
and speed entered in the window.

The Speed setting in this window also controls the
movement speed used when use the Frame buttons, or
using the 'Click to Move' tool.

If your laser supports it, enabling the 'Continuous Jog' switch
changes the behavior - In this mode, press and hold one of
the buttons to move the laser at the desired speed, then
release the button to stop.

You can also get the current position, set or clear a custom
origin or set the 'Finish Position' - IE, where the laser head is
sent when a job finishes.

Note: If you have a Ruida controller, you will not see Set
Origin, Clear Origin, or Set Finish Position, as these are
handled by the controller itself. LightBurn will generally show
only controls you can use.

Info
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Primary Docs UI

Laser Window

The Laser Window lets you select the laser you're using, see
it's connection status, send jobs to the laser, and control a
few different things about how jobs are run on the laser,
including how the job is positioned, and the order things are
cut.

The type of laser you have active will affect how this window
looks, and Beginner Mode will change it too, so don't panic if
yours looks different than what is shown here.

START / STOP / PAUSE

The Start, Stop, and Pause buttons will likely get a lot of use:

Start: run the current file on the laser

Pause: pause a running job, allowing it to be resumed
when you click the pause button again

Stop: immediately abort the running job

The Send button, if your laser supports it, will let you send
the current job to the laser as a named file, so you can run
from the laser itself.

FRAMING

The two Frame buttons are used to preview the position of
the job on the laser.

The first is a standard rectangular frame, also
called a 'Bounding Box'. This is the smallest rectangle that
will fully contain the shapes you're sending to the laser.

If my current file was these four hexagons, the green
rectangle around them is the path the rectangular frame
would follow:

The O-Frame button, called the 'Rubber
Band Frame', traces a path around your design that is the
shape of a rubber band stretched around it. For the
hexagons file, it would look like this:

This is useful for lining up jobs with irregular shapes where a
simple box outline doesn't fit well. For example, a long, thin
diagonal shape, or a triangle.

SAVE / RUN MACHINE FILES

The next two buttons will change depending on the type of
laser you're using, but they always do the same things. The
first will save the current design as a 'Machine Ready' file, in
the file format used by your laser. The second will load and
run a previously saved file. If you have a Ruida, these will
save and run RD files. If you have a GCode based laser,
these buttons will save and run GCode files.

HOME

The Home button will tell your laser to execute a homing
cycle, where it moves toward the home position looking for
the switches that activate when it hits the boundary. Homing
is how your laser figures out where it is.

GO TO ORIGIN

The Go to Origin button tells the laser to jog to the position
currently set as the user origin. Most DSP controllers have an

• 

• 

• 
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'Origin' button on the panel that you press to set the current
position as the user origin. If you want to send the laser to
that spot, press the 'Go to Origin' button.

START FROM / JOB ORIGIN

These two controls affect where the job is placed on the bed
of your laser. Please read the Coordinates and Job Origin
page for details on the different modes, and how they affect
the placement of your job.

CUT SELECTED GRAPHICS

This toggle switch tells LightBurn to only send the portion of
your design that is currently selected. If you run a file on
your machine and part of the design doesn't cut all the way
through, select that piece, enable this switch, and click 
Start to re-send just the selected part of the job. The
placement of the part will not change.

USE SELECTION ORIGIN

When used in combination with Cut Selected Graphics,
the Use Selection Origin button tells LightBurn that you
want the origin of the job to be calculated from only the
parts that are selected, not the whole design. This is useful if
you have many different shapes in a file, like a large
selection of frames, but only want to send the one you've
chosen, and want the origin calculated from just that
selected item.

SHOW LAST POSITION

When enabled, the Show Last Position button places a cross-
hair cursor in the edit window at the location of the laser
head. If you jog the laser within LightBurn using any of the
positioning tools, the position will be updated. The position 
does not update live - for example, it will not update while a
job is running, because that would encourage you to watch
the screen instead of your laser. A laser should never be left
unattended while running.

OPTIMIZE CUT PATH

This toggle will enable / disable the path optimizer that plans
the cutting path the laser will take. With it disabled, the
order will simply be the order that the shapes in your file
were drawn in.

OPTIMIZATION SETTINGS

This button opens the Optimization Settings window,
allowing you to change the various options that control the
cut planner.

DEVICES

Opens the Devices Window, allowing you to add, remove, or
edit device profiles for the lasers you want to use with
LightBurn. Right-clicking the Devices button closes and re-
opens the connection to the currently selected device.

Preview Window

The preview window allows you to preview the path the laser
will take and verify your order of operations while getting a
rough idea of your final result, while giving an estimated
time of how long the program will take.

You can bring up the preview in a few ways:

Press Alt  + P

Click the preview button on the toolbar - it looks like a TV

In the menu, go to Window > Preview

Right click and choose Preview in the context menu

The previewed path is handled exactly like it will be sent to
the laser control so the path is affected by things like

Cut settings (multiple passes, tabs, kerf, etc)

Layer order

Optimization settings

Cut Selected Graphics

Origin

PATH PREVIEW

There are a few ways you can see how the job will run.

Time Slider

The Time Slider allows you to quickly slide through the
project and understand the cut order and path.

Play Button

Play allows you to play the project in real time or sped up or
slowed down based on the "Playback Speed" slider.

Job Information

Below the Time Slider there is information about your
project:

• ⎇

• 

• 

• 

• 

• 

• 

• 

• 
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Cut distance - The distance the laser travels while on

Rapid Moves - The traverse move distance (laser not on)

Total time estimated - This is the total time estimated for
the job based on the cut speeds and traversal move
speeds defined in "Additional Settings" in Device Settings.
If you've changed your acceleration or speed settings, or
you find that your preview times are not accurate, you can
use the Read From Controller button in this window to
update the settings for the preview.

New in v1.3: The preview will automatically simulate the
overscan moves used by DSP controllers, giving a more
accurate time.

PREVIEW OUTPUT

Start Here

The Start Here button will you allow you to start a program
on the laser part way through, from wherever the preview
time slider is currently set.

Save Image

Save Image saves out an image file of the current state of
the preview window.

OPTIONS

Show Traversal Moves

Show traversal moves shows travel (non-laser moves) with
red lines when enabled.

Shade According to power

The shade according to power option only works with
Grayscale with Image Mode or Power Scaling with Fill Mode

Invert

The Invert button is used to change the preview to make the
lasered areas light, and the background dark, so you can see
what your output might look like on slate, wood that's been
painted black, or any other material where the burned area
will be lighter than the original material.

• 

• 

• 
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TROUBLESHOOTING

If the preview window's estimated time is inaccurate, you
may need to update the Simulation Settings as part of your
Device Settings.

Primary Docs UI

Arrangement Toolbar

The Arrangement Toolbar comes in two flavors - long, shown
at the top, and shorter, shown just below it. Both offer the
same functions, but the shorter version of it is available for
those with smaller displays, to save space.

If you are using the shorter version of the Arrangement
toolbar, buttons with a small triangular mark in the lower-
right corner of the button will pop-up a sub-menu with more
choices, like this:

The Arrangement toolbar is mostly functions to control the
placement and alignment of shapes in your design.

Group and Ungroup

The Group button and the related Ungroup button (below)
are used to place shapes into a container (a group) so they
can be treated as a single entity when moving, resizing,
assigning layer color, and so on. The relative position and
size of the grouped objects is maintained. You can also make
groups of grouped objects, creating a hierarchy of grouped
shapes.

Use the hotkeys Ctrl + G  / Cmd + G  to group, and 
Ctrl + U  / Cmd + U  to Ungroup.

Grouping shapes is often used to tell LightBurn to treat the
group as a single entity for an operation, like aligning
shapes, using the Boolean tools, and even for cutting, if the
proper optimization options are chosen, but the most
common reason is simply to make it easier to move and size
a collection of related shapes, like different parts of an
imported file or image trace.

Note: grouped shapes are not "connected" - if you draw four
distinct lines, and make their ends touch so it looks like a
square and then group them, they are still four distinct lines,
not a continuous connected path. To join the shapes
together, you would use the Auto Join tool.

The Ungroup button does the opposite of what the Group
button does - it takes a set of grouped objects, removes
them from the group, and discards the container. The
individual shapes that made up the group are now distinct
shapes again.

⌃ ⌘

⌃ ⌘
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 Vertical Mirror and  Horizontal Mirror

The mirror buttons take the current selection and flip it
horizontally or vertically. You can use the hotkeys Ctrl /

Cmd  + Shift  + H  and Ctrl / Cmd  + Shift  + 
V  for this, or, if the Edit window has the keyboard focus,

just press H  or V  to flip horizontally or vertically.

 Mirror Across a Line

This tool behaves slightly differently to the other two mirror
tools in that it creates a copy of the selected object or
objects, and mirrors it (or them) across a line. The line must
have only two points, and be the last item selected. The
default hotkey for Mirror Across Line is Ctrl / Cmd  + 

Shift  + M .

This tool can be used if you want to create a symmetrical
shape, like a bottle or heart. You draw half the original
shape, then mirror it to create the other half, like this:

Align Centers

Select two or more shapes, then click the Align Centers tool
to move all shapes in the selection to be centered over the
last selected item.

Align Vertically along left, center, or right

These buttons will move all shapes in the current selection
to align the left, right, or vertical centers of the selected
shapes to the last item in the selection.

Align Horizontally along top, center, or bottom

These buttons will move all shapes in the current selection
to align the top, bottom, or horizontal centers of the
selected shapes to the last item in the selection.

Distribute Vertically

These two buttons will vertically move the items in the
current selection to space them evenly, either setting the
same distance between the centers of each object, or
setting the same distance between edges of the objects.

Distribute Horizontally

These two buttons will horizontally move the items in the
current selection to space them evenly, either setting the
same distance between the centers of each object, or
setting the same distance between edges of the objects.

 Make Same Width / Make Same Height

These buttons will set all objects in the selection to the same
width or height as the last selected item. Objects will resize
from their centers.

⌃

⌘ ⇧ ⌃ ⌘ ⇧

⌃ ⌘

⇧
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Move Selection to Corner or Page

Center

These buttons move the current selection to the indicated
corner of the workspace, or the center of it. You can quickly
move the selection to the page center by hitting 'P' after
selecting. These functions can also be found in the Arrange
menu, under 'Move Selected Objects'.

Holding the Ctrl key (Command on MacOS) while pressing
one of these buttons will move the laser to the indicated
corner of the selection, instead of moving the selected
objects. These functions can also be found in the Arrange
menu, under 'Move Laser to Selection'.

Move Selection to Laser Position

This button will move the current selection to the current
position of the laser head. The selection is placed relative to
the laser head based on the setting of the 9-dot corner

control on the Numeric Toolbar 

Primary Docs UI

Numeric Edits Toolbar

The Numeric Edits toolbar in LightBurn is used for adjusting
the size, position, and orientation of shapes or groups of
shapes in your project.

XPos and YPos

The X and Y (horizontal and vertical) positions of your
selection, relative to the point in your selection indicated by
the 9-dot control toward the right side of the toolbar. In the
above image, the 9-dot control is showing the lower-left
corner, so the XPos and YPos values are showing the current
location of that corner of the selection.

Width and Height

The width and height of the current selection. When the lock
control is enabled, the aspect ratio (relationship between
width and height) of your selection is maintained - this
means that if you have a shape that is currently 50mm wide
and 25mm tall, it is twice as wide as it is tall, or it has a 2:1
aspect ratio. If you change the width to 80 while the lock is
enabled, the height will automatically change to 40,
preserving the 2:1 ratio. If you unlock the lock control, the
width and height can be changed independently.

The width and height controls are followed by percentage
controls which can be used to quickly change the relative
size of your selection. Enter 50 in one of the boxes, and the
size will become 50% of whatever it was before.

Rotate

The rotate box is used to rotate the current selection by the
number of degrees entered.

mm / in control

Used to quickly toggle between metric and imperial. Default
state will depend on your current unit of measurement.

Equation support

Note that the XPos, YPos, Width, Height, and Rotate fields
can all accept equations, and the XPos, YPos, Width, and
Height controls accept units as well. This means that if you
are working in mm, but you want to create a shape that is 5
inches wide, just enter 5in or 5" into the width field and
LightBurn will convert it for you. More information about the
equation support in LightBurn can be found on the Tips and
Tricks page.
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Primary Docs UI Text & Fonts

Fonts and Text

Creating text in LightBurn is simple - click the Create Text

tool ( ) on the Creation Toolbar, click somewhere on the
page to get a cursor, and type.

When you enable the Create Text tool, the Text Options
toolbar will activate as well.

With the Text tool in LightBurn you can:

Create text on the screen, or edit existing text by clicking
within it.

Change font and size, alignment, and spacing

Enable / disable automatic welding

Create Variable Text objects

FONT SETTINGS

There are a number of global font settings that can be found
in the settings dialog on the File Settings page

Default Font - Default selected font for new documents

Default Height - Default font height for new documents

Enable Right-to-Left text support - This will
automatically be enabled on first run if a Right-to-Left
language is the current system input language. But it can
be forced on here later if needed. It will allow you to turn
on Right-to-Left font rendering for any text.

Set SHX Font Path - Click to set directory containing
SHX font files. Shift+Click to clear. See SHX Fonts section
below for more.

TEXT OPTIONS TOOLBAR

The Text Toolbar, located on the upper toolbar in LightBurn
by default, is where you set properties on text shapes, like
which font to use, as well as size, spacing, and more.

The Text Toolbar looks like this:

The list of fonts in LightBurn is taken from your computer
system. If you want to use a new font in LightBurn, use the
facility provided by your operating system to install the font,
then re-start LightBurn.

Font - Select the font. Right click the font dropdown for
additional options. You can add the currently selected font
to your favorites. Favorites will appear at the top of the
font list. You can also choose to filter for SHX fonts or
system fonts.

Height - Sets the overall font height. The Height property
of fonts is not exact - It is generally the height of a capital
letter X in the font, but every font has an internal size that
is scaled by this height, and the dimensions aren't
required to be accurate.

HSpace - adjusts the horizontal character spacing as a
percentage of the font size. Positive numbers space the
characters out more, negative numbers move them closer
together.

VSpace - adjusts the vertical line spacing as a percentage
of the font height. Positive numbers increase the distance
between lines, negative numbers reduce it.

Align X - chooses the horizontal anchor position of the
text - Left, Right, or Middle

Align Y - chooses the vertical anchor position of the text -
Bottom, Top, or Middle. Top aligns text to the top of capital
letters, and Middle aligns to roughly the middle of the
capital letters. This is most useful when applying text to a
path.

Bold - Displays the font in bold typeface, if available

Italic - Displays the font in italics, if available

Upper Case - Forces all text to be upper case

Right-to-Left - Force Right-to-Left text rendering. Must
be enabled in settings. This will automatically be set if
enabled and current input language is Right-to-Left.

Welded - Enables automatic welding of characters. When
characters touch or overlap, as is common with script
fonts, enabling this option will automatically weld the
overlaps together.

The remaining two options are for Variable Text, like serial
numbers, dates, and so on. More information about Variable
Text can be found here.
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CURVED TEXT

After creating a piece of text, if you return to Selection mode

by clicking the Select tool  or pressing Esc, you will see
a blue dot near the text you've created, like this:

If you hover over the dot, your cursor will change to the

bend cursor. 

If you click and drag the dot, your text will bend around an
invisible circle, like this:

Double click the dot to clear the bend and restore the text.

New in v1.3

When bending text, you can use the "Distort" toggle to
choose whether to distort the text as part of the bend, or
leave the individual characters unchanged. 

APPLY PATH TO TEXT

If you want the text to follow a more complicated curve, you
can use the 'Apply Path to Text' function in LightBurn to
attach text to any shape in LightBurn. Draw your shape and
your text, then select both and go to Tools > Apply Path to
Text, or right-click and choose it from the pop-up menu:

Note that for text to remain editable you cannot delete the
path, so if it is not something you want engraved along with
your design, put the path on its own layer and set that layer
not to output, like this:

Curved text and text on a path will still automatically weld,
and can be used with the Variable Text feature as well.

SHX FONTS

LightBurn also supports the use of SHX font files which are
an old AutoDesk font format, mainly intended for use with
CNC machines. Most importantly, SHX fonts lack many of
limitations of standard system fonts and have the ability to
define "single line" fonts, such as this:

LightBurn does not ship with any included SHX fonts but
there are many to be found online for free with a quick
search. Once you have SHX files downloaded, LightBurn
must be told where they are. In the Font Settings dialog,
click on "Set SHX Font Path" and choose the directory where
your SHX files are located. It will not show the files as it is
merely a directory chooser.

Once LightBurn knows where to load the SHX fonts from
they should automatically show up in the Text Options
Toolbar font dropdown.
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SHX fonts are differentiated from normal fonts by the icon
next to each entry:

 denotes an SHX font

 denotes a standard operating system font

MOVING LIGHTBURN FILES WITH FONTS

When you save a copy of a file that contains text, LightBurn
automatically includes makes a copy of the text as a path
and embeds it into the file. If you open the file on another
computer that has the same font, you will be able to edit the
text as usual. However, if you open the design on a
computer without the font, LightBurn will warn you about
the missing font(s) and load the path embedded in the file.
This way your file won't break when you move to another
computer, although you won't be able to edit the text
without the correct font. 

If you want to move designs containing text between
computers, be sure to install all necessary fonts on all
computers you're using.

IMPORTING OTHER FILES WITH TEXT

If you are opening files not made in LightBurn that contain
text, please make sure that any fonts used in the file are
installed on your computer or that the text has been
converted to paths using whatever tools are available in the
other program. Different programs will use different terms
for this process, but terms such as 'welding', 'convert to
outlines', and 'convert to path' are commonly used.

Primary Docs UI

Shape Properties

In the Window  menu, you can enable the Shape Properties
panel, which will contextually display properties of any
selected shape. The contents of this panel will depend
entirely on the shape or shapes that are currently selected.

At the simplest, such as when only a Path shape, QR Code or
when multiple shapes are selected, the panel will only
display 3 properties:

Cut Order Priority: Sets the priority of this shape when
used with 'Order by Priority' in the Cut Optimization
settings. Lower values are cut first.

Power Scale: Scales the power used to cut this shape by
this percentage between Min Power and Max Power

Locked: Prevents movement or other changes to this
shape.

Note that locked shapes are shown without the usual
selection controls since they cannot be moved while locked:

When multiple shapes are selected, changing these values
acts on all selected shapes at once.

Other shape types include a wide variety of other properties
that can be set but will always also include the properties
listed above.
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IMAGE

Gamma: Adjusts the mid-tone curve for images. 1.0 is
normal. Lower values brightnen the mid tones, and higher
values will darken them.

Contrast: Increases or decreases image contrast.

Brightness: Increases or decreases image brightness.

Enhance Radius: Radius of edge enhancement - 0 is
none.

Enhance Amount: Increases or decreases edge
enhancement.

Enhance denoise: Use to reduce noise in smooth areas.

Note: Enhance is also often referred to as "Unsharp
masking", and will increase the contrast of edges in the
image. A larger radius spreads the effect across a wider area
near the edge being enhanced.

ELLIPSE

Width: X axis size component.

Height: Y axis size component.

POLYGON

Width: X axis size component.

Height: Y axis size component.

Sides: Number of sides. 

RECTANGLE

Width: X axis size component.

Height: Y axis size component.

Corner Radius: Sets the radius for curved corners on the
rectangle. 

TEXT

Max Width: Text will begin scaling if the length exceeds
this, use zero for no limit.. 
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Primary Docs UI Tools

Creation Tools

The shape creation tools are the basic ways you build stuff
from scratch in LightBurn, along with the Selection tool, and
the 'Click to Position' tool.

The tools are:

Creation Tools

Selection tool 

Click Selection

Drag Selection

Enclosing Selection

Crossing Selection

Selection Modifiers

Moving, Resizing, Shearing, and Rotating

Snapping

Draw Lines tool 

Measuring

Rectangle tool 

Ellipse tool 

Polygon tool 

Click to Move tool 

SELECTION TOOL 

You'll likely use this more than any other tool in LightBurn.
The selection arrow is used to choose which things in your
workspace you want to change, and there are number of
different ways that selection happens in LightBurn.

Click Selection

Point at the outline of a shape and click with the left mouse
button to select it. The shape will change from solid to an
animated pattern of dashes. There are several things you
can tell from this pattern:

The circle on the left is not selected. The circle in the middle
is selected, and it is a simple shape, because the pattern is
just simple dashes. The two circles on the right are grouped
- visible because the pattern is a combination of dots and
dashes.

The selection shown above is also comprised of unlocked
shapes, as denoted by the fact that the move, resize, and
rotate controls are shown. Locked shapes, however, do not
show any of these selection controls, as shown below.

The direction that the pattern animates shows the direction
that the shape will be cut in (unless you tell LightBurn that
it's ok to choose a different direction).

To clear the current selection, left click an empty space in
the view, or press the Esc key.

Drag Selection

If you click an empty space in the edit window and drag the
cursor, a selection rectangle appears. Drag the rectangle out
over a number of shapes and let go to select them. There
are two types of drag selection:

Enclosing Selection

If you drag from left to right, you'll see a red rectangle.
Selecting a shape with an enclosing selection means the
shape must be completely contained by the rectangle in
order to select it.

Crossing Selection

If you drag from right to left, you'll see a green rectangle.
Selecting a shape with a crossing selection means that if the
rectangle crosses the shape at all, the shape will be
selected:
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Selection Modifiers

To supplement click-select and rectangle selection,
LightBurn supports these modifier keys:

Shift  : Holding Shift while selecting will add the new
selection to the current one

Ctrl + Shift  / Cmd + Shift  : Holding both Ctrl
and Shift will remove the new selection from the current
one

Ctrl  / Cmd  : Holding Ctrl by itself will toggle the
selection state of the new selection

(Note that on MacOS, the Command key is used instead of
the Ctrl key)

Moving, Resizing, Shearing, and Rotating

When one or more shapes are selected, several controls
appear around them, like this:

The small squares around the outside of the selection can be
clicked and dragged to resize the selection from that side or
corner. If you move the mouse over one, the cursor will
change to show that the action is available.

When dragging one of the four corners, the shape will
maintain its relative width to height (aspect ratio) so it
doesn't 'stretch'. You can override that by holding the Shift
key while dragging a corner.

When dragging any of the sizing adjustments, the behavior
is asymmetric - the other side of the object acts like an
anchor and stays in place. Holding the Ctrl key (or Command

on MacOS) makes the action symmetrical, using the center
of the object as the anchor instead of the other side.

When dragging the non-symmetrical adjustments, you can
"shear" the entire design in the X or Y axis. This allows for
"corner-pinching" of your design, and maintains the same
center as you had before.

The center square that appears is a movement handle - you
can click and drag it to reposition the shape, however you
can also click anywhere on the boundary of the shape to do
this, and you don't even have to select it first - Simply click
the boundary, and while continuing to hold the left button,
drag the shape.

The circular arrows shown at the four corners are used to
rotate the shape. By default the rotation is "free", however
holding the Ctrl  key will snap it to 5 degree increments.

When dragging, scaling, or rotating shapes, the bottom
status bar in the main window will often show feedback, like
this:

Here I can see the position of my mouse, and the angle I
have rotated the shape to while I'm rotating it.

Snapping

When you move the mouse over a shape to select it, you will
occasionally see the cursor change to a small crosshair. This
shows that you are over a snap point, like a corner, node,
the center of a line, or the center of a shape. If you click at
this moment, the point you drag the object from will be that
snap point. When dragging an object to move it, as you get
near other objects, those objects may also snap the cursor
location, allowing you to position shapes perfectly with each
other. If you are close to a grid point, the selection will snap
to the grid as well.

• ⇧

• ⌃ ⇧ ⌘ ⇧

• ⌃ ⌘

⌃
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If you do not want shapes to snap when dragging, hold the
Ctrl key to temporarily turn off the snapping behavior.

DRAW LINES TOOL 

Hotkey = ( Ctrl  / Cmd ) L

Click the pencil to use the Line tool. Click anywhere on the
page to start a line, then click in a different location to place
the endpoint of the line. The Line tool will continue adding
segments until you either click back at the starting point to
close it, click the right mouse button to stop, or press the 

Esc  key.

To create curved lines, click and drag when placing a point.
You can combine curved and straight segments when using
the Line tool.

Measuring

A little known feature of the Line tool is that it is also
intended to be used for measuring distances. The status
display at the bottom of the main window shows the length
of the line being drawn, even before you've completed it.

If you want to measure the distance between two points in
your design, start a line at one point, then move the mouse
to the other point, but don't click yet. Look at the status
window to see the length of the line in progress. When you
have noted your measurement, right-click or press Esc to
cancel the line.

The status window shows:

dx: the distance along the X axis only

dy: the distance along the Y axis only

len: the length of the current line segment

It will also show the angle between successive line
segments as you create them

RECTANGLE TOOL 

Hotkey = ( Ctrl  / Cmd ) R

The rectangle tool is used to draw squares and rectangles.
Holding Shift while dragging will lock the width and height,
producing a perfect square. Holding Ctrl will drag the
rectangle or square from the center, instead of the corner.

With a rectangle selected, if you look in the Shape Properties
Window you can adjust the 'Corner Radius' property to
produce rounded rectangles, or frames with inward corners:

⌃ ⌘

⎋
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ELLIPSE TOOL 

Hotkey = ( Ctrl  / Cmd ) E

The ellipse tool is used to draw ellipses and circles. Similar
to the Rectangle tool, holding Shift while dragging will lock
the width and height, producing a perfect circle. Holding Ctrl
will drag the ellipse or circle from the center, instead of the
corner.

POLYGON TOOL 

The polygon tool is used to draw regular polygons, like
hexagons. Holding Shift while dragging will lock the width
and height. Holding Ctrl will drag the polygon from the
center, instead of the corner.

With a polygon selected, if you look in the Shape Properties
Window you can adjust the Sides property to change the
number of sides the polygon has:

CLICK TO MOVE TOOL 

Hotkey = Alt + L

The Click-to-Move tool is a quick way to jog your laser to a
location somewhere in the workspace. Select this tool, then
click anywhere on the page and LightBurn will issue a
command to send your laser there. This tool automatically
turns itself off after about 10 seconds, in case you
accidentally leave it on. Trying to select a shape and having
the laser move away from where you want it can be
confusing. 

Primary Docs UI

Cuts / Layers

The Cuts / Layers window in LightBurn shows the list of
operations you have in your design. The layers will usually
be cut in this order, but you can change that if you want.

This view gives:

A summary of all operations in the design

The type of operation (Line, Fill, Multi, or Image)

The main speed and power settings

Toggles to show whether the layer is output (sent to the
laser) or shown in the editor window.

If you select an entry in this list of operations, the values at
the bottom of the list will let you edit speed, power, number
of passes, and interval.

The buttons to the side allow you to manipulate the list of
layers:

Move

The first two buttons, "Move up / Move down", let
you re-order the entries in the list.

Delete

This button will delete all the content on the
selected layer.

Cache

⌃ ⌘

⎇
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These two buttons let you copy a layer's settings
(right arrow) into a cache and paste the settings
onto a selected layer. This can be very useful if
you want the same settings on multiple layers, or

want to use one layer's settings as the starting point for
further modifications on another layer.

ADDITIONAL TIPS

If you right-click the 'Output' or 'Show' headers at the top
of the list, you can quickly turn on, off, or toggle that
setting for all layers:

Right-clicking an entry in the layer list will flash all the
shapes using that color in the edit window, allowing you to
quickly see what's using this layer setting.

Holding the Shift key and clicking a layer entry will select
all shapes using that layer color. Note that if you have
shapes using this layer grouped with other shapes from
other layers, the shapes from the selected layer will be
removed from the group in order to select them, so this
operation can alter your file.

Double-clicking an entry in the layer list will bring up the
full Cut Settings Window, allowing you to edit to all the cut
settings, including many not shown here.

Cut Settings Editor

CUT SETTINGS EDITOR

The Cut Settings window in LightBurn is accessed by double-
clicking an entry in either the Cuts / Layers window or the
Material Library list. The window you see may vary from the
screenshot, as different laser features, LightBurn modes
(Beginner) or updates can change its appearance and
settings.

In the Cut Settings Editor (CSE) you can create, edit, adjust,
and clone layers and sub-layers for your projects. This gives
you finer control when operating your laser. Line mode
follows the vector lines in your design, fill mode scans back
and forth to remove material from the "inside" of a shape,
and offset fill removes material on the "inside" of a shape
following a spiraling pattern based on the outside shape. You
can create sub-layers to combine these modes, which
replaces LightBurn's older "Fill + Line" option while also
opening up many more options.

For a comparison of Line (left) versus Fill (right) modes, see
below.

• 

• 

• 

• 

4.5.2 Windows & Buttons

- 72/241 - (C) LightBurn Software, LLC

../img/CutsAndLayers-Cache.png
../img/CutsAndLayers-Cache.png
../img/CutsAndLayers-PopUp.png
../img/CutsAndLayers-PopUp.png
../../img/CutSettingsEditor/CSE_Line_Common.png
../../img/CutSettingsEditor/CSE_Line_Common.png
../../img/LineVsFill.png
../../img/LineVsFill.png


Operating Modes

There are four different 'modes' in LightBurn that choose
how the laser will render your design:

Line mode - traces along the outlines

Fill mode - fills the design with parallel lines

Offset Fill mode - fills the design with lines that follow the
original shape

Image mode - Works similar to fill, but with specific
settings for images

In all variations of the Cut Settings Editor, the most basic
settings are displayed at the top of the window (speed,
power, output toggle, air assist, and mode). The lesser used,
more specialized options follow below, and are split into two
panes - Common and Advanced.

We'll go through the different settings used in each mode,
and explain their use.

Shared / Basic Settings

All layers have a few settings that are the same, regardless
of the type of layer.

Speed: how fast the laser will (ideally) move when tracing
your design. Depending on your laser, its firmware settings
and limits, and the design, it may or may not actually reach
this speed.

The next two require a bit of explanation:

Max Power: The power level to run the laser at

Min Power: The power value used for corners, or when
moving at low speed (DSP only)

Note: On GCode based systems, you only get the "Max
Power" option. On DSP systems, you have the additional 'Min
Power' setting, which is used when traveling at low speed, or
when moving through corners.

If you are cutting at a low overall speed (for example, 10 to
20 mm/sec on a CO2 machine) the laser might only ever use

the 'Min Power' setting, so in that case it is best to use the
same value for both. If you are doing 'surface marking' you
ideally want Min Power to be just above the firing threshold
of the laser, so corners still produce a burn, but without
scorching.

Defaults and Changing Between Files

Colors normally start with their last used settings, but if you
wish you can set LightBurn to load default settings for each
layer when you create a new file. If this option is enabled, a
new drawing will have a clean slate with default color
settings for all layers. 

Working With Defaults

At the bottom of the Cut Settings Editor, there are three
buttons to manage layer default settings.

Make Default: Remember the settings for this palette color.
Whatever your current settings are will become the default
for this color.

Reset to Default: Reset the layer to the default settings.

Make Default for All: Your current layer settings will
become the default for all palette colors.

Layer defaults are separate from material libraries, and you
will likely find it useful to use the two together. A common
use for layer defaults is to set up layers with common cut
settings for your own projects, and then use material
libraries to apply settings for different materials and
processes.

Sub-Layers

Sub-Layers allow you to set multiple cut/engraving settings
on the same layer & geometry. This can enable the use of
single-setup etching & cleanup passes for galvo lasers, as
well as staggered engraving, cutting, and other operations
for more complex jobs regardless of machine type. You may
have up to 11 sub-layers per layer.

• 
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Comparison of Sub-Layers vs Single Layer

With the Sub-layer feature, you can configure count, type of
pass, speed, frequency, and more, without duplicating
geometry in your design.

To make a new Sub-layer, you can either click the plus icon
or the duplicate icon (two overlapping pages) in the tabs

area of the Cut Settings Editor. The plus sign will create a
new sub-layer with default settings, and the duplicate icon
will create a copy of the current sub-layer. The minus sign
icon on the far right will delete the currently open sub-layer,
so long as it's not the only sub-layer.

Main Window Changes (1.2.00+)

When using sub-layers, your Cuts / Layers window will show
the mode as "Multi", as seen below. You can quickly
reorganize and edit the tabs as you can within the full Cut
Settings Editor in the quick settings, at your convenience.

Additional Settings/Information

Constant Power Mode

This setting is only available on GRBL devices. By default,
LightBurn uses Variable Power mode (M4), which ramps
the power level of the laser up and down with the speed,
producng a more consistent burn. However, if you ask the
laser to move faster than it's able, it will never reach the
requested speed or the requested power level. It's generally
best to stick with the default of Variable Power mode and
adjust the speed to be within the range your machine can
achieve, but if you want the same behavior as LaserGRBL,
whch defaults to Constant Power (M3), you can enable this
option. We have more info on this in our troubleshooting
section.

Sub-layers in Use Single Layer View
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CUT SETTINGS - FILL MODE

Common Settings Advanced Settings
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In older versions of LightBurn the 'Fill' mode was referred to
as 'Scan'. We've updated the terminology to make it easier
for new users.

Fill mode permits you to instruct the laser to scan line by line
and fill in the shape you want, similar to how a paper printer
works. Fill mode will fill in closed shapes but not open
shapes.

Bi-directional Fill

When enabled, the laser will engrave in a side-to-side
sweeping motion, engraving in one direction and again for
the return direction. When disabled, the laser will engrave
traveling one way, then return to the start of the next line,
not engraving the return pass. Depending on the type of
laser, enabling this can save significant time on long
engraving jobs.

Cross-Hatch

When enabled, runs a second engraving pass 90 degrees
rotated from the first to ensure a consistent and thorough
fill.

Overscanning

When enabled, adds extra moves to the beginning and end
of each line to give the laser time to speed up before firing,
and slow down afterward. 

If your machine has low acceleration or you see darker burns
at the sides of your fills, you may need to increase the
amount of overscanning. If you do not see this setting, your
machine is likely a DSP controller and handles this
automatically in hardware.

Line Interval

Controls the spacing between scanned rows, and indirectly
controls 'Lines per Inch'.

Lines per Inch

A different, often more intuitive way of controlling the line
interval, or spacing between rows.

Scan Angle

Normally 0, meaning the laser will scan back and forth
horizontally across the image, progressing from the bottom
of the image to the top. If you set this to 180, the laser will
scan the image from top to bottom. Setting this to 90 will
scan the laser vertically over the image, progressing from
left to right.

If you have a DSP controller, we do not advise using angles
that aren't a multiple of 90 degrees. Horizontal and Vertical
scanning is supported natively by the hardware, and it will
automatically handle over-scanning beyond the sides of the
image to get the head to full speed before engraving starts.
Scanning at non-90 degree angles is "emulated" using
normal cutting moves. It works, but it's mostly useful as a
style option, and not recommended for general use.

Number of Passes

Sets how many times the laser will run this filled shape.

Angle Increment

This feature allows subsequent passes of the layer or sub-
layer to increment the scan angle automatically. 

Z Offset

If you have Z moves enabled, and your controller supports it,
the Z Offset setting can be used to move the laser head
closer to the material (inward) or farther away from it
(outward). Focusing deeper into the material can sometimes
help to cut thicker material, and lifting the laser away from
the material can produce a thicker line.

Z step per pass

When doing more than a single pass over a shape, the Z
step per pass setting allows you to tell LightBurn to raise or
lower the laser with each pass by some amount. This is most
often used for thick cutting or deep engraving, allowing you
to shift the focus point deeper with each pass to help
maintain efficient cutting.

If your system uses auto-focus, you may not be able to push
the focus point lower, because most systems treat the auto-
focus height as the lowest possible height (Z limit) to avoid
crashing the laser head. Be careful using Z moves, as they
do have the potential to physically damage your laser by
crashing the head into the material.

Fill Grouping

These options control which shapes are filled at the same
time on the laser. If you run your laser fast, OR your laser
accelerates slowly, it is often most efficient to scan things all
at once, so the laser spends most of its time moving at the
speed you've chosen, and less time changing direction. If
you are engraving slowly, or your laser accelerates fast, or
the design contains a lot of blank space, it can be more
efficient to fill clusters of close shapes, or just fill the shapes
one by one. If you aren't sure, try different options and use
the preview to estimate the time.

Fill all shapes at once: The default, this setting means
that everything on this layer will be filled at the same
time, sweeping back and forth across the whole job. If you

Note for long-term users Note

Warning for Z moves

• 
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are running the laser fast (300 mm/sec or more) this is
usually the most efficient option, with some exceptions.

Fill groups together: This setting will fill all shapes in a
group at the same time.

Fill shapes individually: This setting fills all shapes one
by one.

Advanced settings

Under the Advanced tab you'll find a few useful, but less
frequently used options.

Ramp Length

This setting can be used to slope the sides of an engraving
by varying the laser power, and is useful if you create rubber
stamps, particularly if the designs have thin regions that
need extra support. The ramp length controls how far from
the design the slope will extend.

Note: On a DSP controller, the ramp varies the laser power
from Min Power to Max Power, so you must set these
differently to get a ramped side. Typically you would set Min
Power to be just above the firing threshold of your laser.

Flood Fill

Flood fill tries to eliminate travel moves across blank space,
so it's perfect for engraving something like a large, empty
rectangle, where the blank area in the middle would
consume most of the time spent.

This option is incredibly useful when you need it, but is very

sensitive to machine tuning and backlash, and can end up
leaving gaps in your engraving if the design is complex and/
or your machine is not set up optimally. 

If used on complex designs, Flood Fill can produce engraving
paths that jump around a lot, and return later to fill in
missed spots, which is why it can leave gaps if the machine
isn't well tuned. Use it sparingly, and use the Preview tool to
see how the option will engrave your design so you aren't
surprised by the path it takes.

Fill + Line Behavior

In older versions of LightBurn, Fill+Line mode allowed
primitive Sublayer use to draw an outline around an
engraved shape. This has since been superseded. The
legacy behavior can be approximated with Sub-Layers, one
for Fill and a second one for Line with the same base motion
settings.

LightBurn will automatically convert pre-1.2 project files with
Fill+Line settings to Sub-Layers in 1.2, including Fill+Line
behavior. This produces two layers, one with your legacy
"Fill" settings, and a subsequent layer with "Line" settings,
to be run afterwards. Going backwards from current project
files to pre-1.2 LightBurn is likely to result in breakages
involving Sub-Layers due to how complex the changes are.

• 

• 

Warning

Danger
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CUT SETTINGS - LINE MODE

Common Settings Advanced Settings
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In older versions of LightBurn the 'Line' mode was referred
to as 'Cut'. We've updated the terminology to make it easier
for new users.

The image above shows the settings for 'Line' mode. In this
mode, the laser follows the exact path of your design,
tracing the lines with the beam enabled at the power you've
chosen. If you move quickly, or with low power, you will
likely just etch the surface (sometimes called vector
marking). If you move slowly and with high power, especially
with a CO2 laser, you will cut deeper, possibly through the

material. The onnly difference between surface marking and
cutting is the power and speed.

Cut Options

Number of Passes

How many times the laser will repeat the shapes on this
layer. Sometimes, when cutting thick material, trying to
engrave very deep, or using a lower power laser, more than
one pass may be necessary.

Perforation Mode

The dotted lines below were generated using a different
setting, called Perforation Mode. If you are trying to cut fold
lines in card stock, stitch holes in leather, or just make
dashed lines, perforation mode allows you to choose the
distance to cut, followed by the distance to skip.

This can also be very useful when trying to cut delicate
material with a powerful laser - Setting very low cut and skip
values, like 0.1mm each, toggles the beam on and off very
quickly, and gives you an effectively lower power output.
Varying the ratio between the two lets you adjust that power
- using 0.1mm for both cut and skip would give you the
effect of 50% of your chosen output power, because it is
spending exactly half of the time with the power on. Using
0.05mm and 0.15mm for cut and skip, respectively, would
be 25% of your chosen power, because it is only cutting for
25% of the total distance of the shape.

Tabs / Bridges

As Tabs / Bridges is a much more complicated feature, you
can find an in-depth walk through on the Tabs / Bridges
page.

Wobble (Galvo-only)

This option is only available if you are using a galvo laser.
Because galvo lasers move so fast, it can be hard to apply

enough power to a given area while in line mode. Wobble
can be used to trace small circles along the path of the line,
forcing the galvo to spend longer in each section of the line.
The 'Step' value refers to how far apart the circles are, and
the 'Size' value refers to the diameter of the circles (in
millimeters).

Gantry-Specific Settings

These settings will only be available if you are using a gantry
laser.

Z Offset

If you have Z moves enabled, and your controller supports it,
the Z Offset setting can be used to move the laser head
closer to the material (inward) or farther away from it
(outward). Focusing deeper into the material can sometimes
help to cut thicker material, and lifting the laser away from
the material can produce a thicker line.

Z step per pass

When doing more than a single pass over a shape, the Z
step per pass setting allows you to tell LightBurn to raise or
lower the laser with each pass by some amount. This is most
often used for thick cutting or deep engraving, allowing you
to shift the focus point deeper with each pass to help
maintain efficient cutting.

If your system uses auto-focus, you may not be able to push
the focus point lower, because most systems treat the auto-
focus height as the lowest possible height (Z limit) to avoid
crashing the laser head. Be careful using Z moves, as they
do have the potential to physically damage your laser by
crashing the head into the material.

Kerf offset

Kerf is used to mean the thickness of the cut itself when
using a cutting tool. If you use a table saw, and the blade is
2mm wide, it has a kerf of 2mm (or just slightly more). A
laser burns material to cut, and although the cut is very thin,
it does have width, and this width needs to be compensated
for if you are trying to make parts that fit together, like a
tabbed box, or an inlay. Kerf offset works exactly the same
as the Offset tool in LightBurn, but it happens "on the fly" as
the cut data is generated for your laser, so it does not alter
the original design. 

Note for long-term users

Warning for Z moves
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Using outward kerf moves the laser beam outward, away
from the shape, and using inward kerf moves it inward, into
the shape. LightBurn accounts for the fact that holes in a
shape will need to be offset in the opposite direction, as
shown here - the solid lines are the original shape, and the
dashed lines are the result of shifting the kerf out or in:

Advanced Settings

Under the Advanced tab you'll find useful, but less
frequently used, options. This tab will not be available if you
are using a gantry laser.

Start / End pause time

These options can be used to add a delay at the beginning
of a cut, the end, or both. If you also enable the 'Cut
Through' option, the beam will be turned on during this
pause, which can be used to 'prime' the cut, for example
when cutting very thick material. The 'Power %' value sets
the power of the laser during this pause.

If used without the 'Cut Through' toggle enabled, it can be
used to add a delay to let the gantry settle down after a
rapid move, or allow time for an air assist solenoid to
engage.

Overcut

This option tells LightBurn to keep cutting closed loops for
the specified distance, which can help when cutting through
thick material, where the start of the cut sometimes doesn't
make it all the way through.

Override PWM Frequency

If you have an RF Excited tube, this setting allows you to
control the PWM frequency of the pulses sent to the laser,
and can change the edge finish on certain materials.

Override PPI

Only available on Trocen controllers, the PPI setting (Pulses
Per Inch) lets you tell the laser to send an exact number of

pulses per inch of travel, instead of varying the beam power
directly. This is useful for delicate materials like paper, and is
similar to using Perforation Mode, but is handled by the
hardware itself.

Lead In / Lead Out

Lead-in and Lead-out are optional lines or curves added to
the start or end of a cut. When cutting thick material,
particularly if using 'Cut Through' delays, or cutting metal,
there is often a mark left at the start of the cut that is
slightly thicker than the rest, and can leave an indent on an
otherwise smooth edge. With this setting, you can add a
small line to the start or end of a cut, so that mark happens
off the cut line itself. The 'Angle' value controls the
placement of the lead line - a positive number tells
LightBurn to put the lead line outside the shape, and a
negative number means to put it inside. You can choose to
make the lead a straight line, or a short arc.

The shape above on the left is using an arc set to +45
degrees, so it starts outside the shape. The one on the right
is a line set to -20 degrees, so it appears inside the shape.

Dot Mode

When enabled, the laser will pause and pulse at regular
intervals along the path, instead of cutting continuously. The
'Time' value specifies the pause delay in milliseconds, and
the spacing parameter sets how far apart the pulses are.
This can be an effective way to do stitching holes, or cut
very thin or delicate materials, but the constant pausing can
shake the machine - using Perforation Mode is often
preferable for this reason. This setting is not available on all
lasers.
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CUT SETTINGS - OFFSET FILL MODE

Common Settings Advanced Settings
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This mode is a recent addition, and will fill an outline with
lines that follow the shape of the object. If you have ever
worked with a CNC router, it would be called an "offset
pocket" operation. 

For comparison, a traditional Fill is on the left, and an Offset
Fill on right.

Raster fill is preferred for general use, however offset fill can
save time in certain cases if you have a slower machine, or
the shape you are filling is hollow, like this:

In this case, you can see that the left image has many more
traversal moves (non-cutting movement of the laser, shown
in red), where the right side does not. Offset fills take
considerably longer to generate because the computations
to generate the path are much more complex.

Aside from the differences in path generation, settings here
are similar to the regular fill mode.

CUT SETTINGS - IMAGE MODE

This mode is only available for image shapes, and lets you
choose options that control how LightBurn renders the
image data on the laser.

The image above shows the settings available for images.
Many of these will be familiar from Fill mode with the rest
specific to image engraving. Note that on a CO2 laser it's
likely that you will be running at a low power and/or very
high speed, whereas a diode laser may be run at full power,
depending on material.

These settings do not allow you to control things like image
brightness or contrast. Instead those are set on a per-image
basis and can be accessed via the Shape Properties panel. 

To see a side-by-side comparison of the source and output
image, while being able to change both the layer settings
described in on this page and the image shape properties,
checkout the Adjust Image tool.

Image Settings

Bi-directional scanning

When enabled, the laser will engrave in a side-to-side
sweeping motion, engraving in one direction and again for
the return direction. When disabled, the laser will engrave
traveling one way, then return to the start of the next line,
not engraving the return pass.

Negative Image
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This will invert your image during engraving. Light becomes
dark, dark becomes light. This is useful for engraving slate
or glass, where burned areas become lighter.

Overscanning

When enabled, adds extra moves to the beginning and end
of each line to give the laser time to speed up before firing,
and slow down afterward. If your machine has low
acceleration or you see darker burns at the sides of your
fills, you may need to increase the amount of overscanning.
If you do not see this setting, your machine is likely a DSP
controller and handles this automatically in hardware.

Line Interval

Controls the spacing between scanned rows, and indirectly
controls 'DPI'.

DPI (Dots Per Inch)

Controls the pixel density of the output - this is simply
another way of representing line interval that is more
intuitive for some. DPI (dots per inch) is just 25.4 / interval.

Scan Angle

Normally 0, meaning the laser will scan back and forth
horizontally across the image, progressing from the bottom
of the image to the top. If you set this to 180, the laser will
scan the image from top to bottom. Setting this to 90 will
scan the laser vertically over the image, progressing from
left to right.

NOTE: If you have a DSP controller, we do not advise using
angles that aren't a multiple of 90 degrees. Horizontal and
Vertical scanning is supported natively by the hardware, and
it will automatically handle over-scanning beyond the sides
of the image to get the head to full speed before engraving
starts. Scanning at non-90 degree angles is "emulated"
using normal cutting moves. It works, but it's mostly useful
as a style option, and not recommended for general use.

Z Offset

If Z moves are enabled, this setting controls how much to
raise or lower the Z axis when executing this fill. Lifting the
laser a few mm, for example, can make the beam wider,
allowing the use of larger interval values, which can make
filling a large area faster.

Cells per inch

Number of Halftone shading dots to compute per inch. Only
enabled when the Halftone Image Mode is selected.

Halftone angle

Angle of the Halftone shading patern. Only enabled when
the Halftone Image Mode is selected.

Number of Passes

How many times to repeat the entire engraving process.

Ramp Length

Length to ramp in and out of the sides of engraved features.
Typically used for rubber stamps.

Pass-Through

This prevents the image from being resampled internally at
all and disables the normal image modes described below.
Line interval / DPI will be directly tied to the size of the
image. This is best used for images that have been pre-
processed for laser engraving outside of LightBurn.

Image Mode

The Image Mode setting is arguably the most important
setting of them all for images. It will define what your
resulting engrave will look like and there are many modes to
choose from. Below you can see a description of all these
modes, with an example of how that mode changes the look
of thise original image.
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A simple on / off switch if the image is dark / bright at a
given location. This should only be used for images that are
two-color black/white to begin with, like an image you
dithered outside of LightBurn. Don't use this mode for
grayscale or color images.

Also called ordered dithering, this is a step above threshold
for grayscale images, and uses densely packed on/off dots
to approximate shading, using an ordered/regular grid
pattern. This is ok for general use, but works best for images
with large areas of solid fill, where diffusion dithering can
cause unwanted artifacts (see below).

A good "in between" mode for solid color or smooth shaded
images. It resembles Jarvis but preserves detail better,
though very light or dark areas may be blown out.

Also called error diffusion dithering, this is the best choice
for smoothly shaded images, like photos. This also
approximates shading with simple dots, but does so without
evident patterning, and tends to produce more subtle
shading.

High quality dithering. Slightly faster than Jarvis and a good
choice for smooth shaded or photo images.

High quality dithering. Usually the best choice for smooth
shaded or photo images.

Emulates newspaper halftone. It has good shading, but is
visibly patterned. Good for higher DPI settings, or
Smoothieware controllers.

Good quality shading for high DPI images. It is similar to
newsprint but can have variable cell size and pattern angle.

Useful for line drawings or handwriting as it tries to detect
hard edges.

With a CO2 laser, grayscale mode can achieve variable

depth (3D) engraving rather than shading. Images typically
need to be specifically created for this use. With a diode
laser this can provide great shading but is harder to get right
than plain dithering. 

When previewing a Grayscale engraving, be sure to check 
Shade according to power  otherwise you will see a
completely black preview since, unlike other modes,
Grayscale scans every portion of the image, just at varying
levels of laser power.

ExampleThresholdOrderedAtkinsonDitherStuckiJarvisNewsprintHalftoneSketchGrayscale

Note
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Fill Grouping

These options control which images are filled at the same
time on the laser. If you run your laser fast, OR your laser
accelerates slowly, it is often most efficient to scan things all
at once, so the laser spends most of its time moving at the
speed you've chosen, and less time changing direction. If
you are engraving slowly, or your laser accelerates fast, or
the design contains a lot of blank space, it can be more
efficient to fill clusters of close shapes, or just fill the shapes
one by one. If you aren't sure, try different options and use
the preview to estimate the time.

Fill all shapes at once: The default, this setting means
that everything on this layer will be filled at the same
time, sweeping back and forth across the whole job. If you
are running the laser fast (300 mm/sec or more) this is
usually the most efficient option, with some exceptions.

Fill groups together: This setting will fill all shapes in a
group at the same time.

Fill shapes individually: This setting fills all shapes one
by one.

TABS / BRIDGES

Sometimes it is helpful to include tabs (sometimes called
bridges) in objects that you are cutting out so that they do
not fall out immediately but can be removed later. The
concept comes from the CNC world but is much simpler in
the context of a Laser. Simply put, it's where you skip a very
small section of a cut, often less than 1mm in length. In the
example below, the left square has no tabs applied, while
the right has a single 1mm wide tab on each side.

Basic Usage

First, note that you will need to disable Beginner Mode in
the LightBurn Settings otherwise the tabs functionality will
not be available. Once that is done, you will see the "Add
Tabs" tool is available:

You can only add tabs to shapes that are in Line mode. Once
the Add Tabs tool is selected you will see the Insert Tab

cursor ( ) when hovering over a shape which you can
add a tab to.

Simply click where you would like a tab, and a red circle will
apear where you clicked, denoting that a tab will be placed
there.

• 

• 

• 
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Tabs default to 0.5mm in width and you can place many tabs
on any shape. The system will, however, limit how close any
two tabs can be based on the currently set tab size.

If a tab needs to be moved, simply click on it again and drag
it to a new location, even on another shape.

Finally, you can delete a tab by double-clicking or
shift+clicking the tab.

Advanced Usage

In a Line mode cut setting's option dialog you will now see a 
Tabs / Bridges section which allows more control.

Global Enable / Disable

The Tabs / Bridges group has a checkbox in the top-left.
Flipping this to off will supress any tabs on that cut layer
without losing any previously configured tabs or tab settings.

Tab Generation

Manual - Any tabs must be manually placed using the
methods described above.

Automatic - Tabs will be placed on all cut layer shapes,
based on the values of Even Spacing, Tabs Per Shape,
and Skip Inner Shapes.

Tab Size

Defines the total length of any tabs in whatever the
currently configured system unit type is (mm or inch). The
system will skip cutting for this distance, if possible.

Even Spacing

When automatically generating tabs, each contiguous path
section will have at least one tab applied at the very start of
the path and then again at this distance interval (mm or inch
depending on unit settings).

Tabs Per Shape

When automatically generating tabs, using this option will
place this number of evenly spaced tabs on each contiguous
path section for each shape on the cut layer.

Limit Max Tabs

This option allows you to set an upper bound on how many
tabs each object can have automatically generated.

Tab Cut Power

If set to anything other than 0%, tabs will have pulsed cuts
across the distance of the tab instead of just skipping it
completely. In the example below, the top tab is set to 25%
whereas the bottom tab is set to 75%.

Not all laser controllers can reliably vary the power mid-cut
so this was a way to implement "partially cut" tabs in a
consistent way. By increasing the amount it pulses on during
the tab you can further weaken the tab overall.

Skip Inner Shapes

When enabled any shapes that are completely contained by
another shape in the same cut layer will not have automatic
tabs applied. This does not effect manual tab placement.

Clear Tabs

Delete all tabs (manual or automatic) from every shape on
this cut layer.

• 

• 
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Primary Docs UI Libraries

Art Library

The Art Library is a way to quickly store and recall artwork
that you use on a regular basis and want quick access to
when designing.

On the left side of the window it shows the libraries that are
currently loaded, and the right side shows the artwork in the
currently selected library. Artwork can be easily imported
into the library from files on your hard drive, or from a
selection in your current project. When you want to use
something from the library, just grab the thumbnail from the
right view and drag it into your project.

Note: The library only stores artwork, much like the
contents of your AI, SVG, DXF, or image files. It does not
store the cut or fill settings applied to the artwork.

Library Files

Each library you create is a file on your hard drive containing
all the graphics inside it in a compact form. You can copy
library files between computers to share the contents.
LightBurn remembers which libraries you have loaded.
Unloading a library file just removes it from your list of
loaded libraries, but doesn't delete the file or its contents,
which makes it easy to bring in seasonal or holiday specific
libraries when you need them, then unload them to reduce
clutter when you don't.

To create a new (empty) library, click the 'New' button and
choose a location and a name to store the library file. Once
created and selected, you can immediately start adding
content to it.

Adding artwork to a Library

If you have files on your hard drive that you want to add you
can click the Import button. This will let you import multiple
files at once if you want to, and each one will become an
entry in the current library. You can also select something in
your current project and click 'Import Graphic from Project'
to add the selected artwork to the current library.

You can also right-click in the library view, like this:

From the pop-up menu, you can add the current selection to
the library, rename the selected library graphic, or delete it.

Adding artwork from the Library to your project

When you want to use an item from the library, locate it in
the thumbnail view on the right, then simply drag it into
your project wherever you would like it to appear, and drop
it. You can also click 'Add Graphic to Project' in the buttons
along the bottom.

Loading and Unloading Libraries

If you have libraries that you use rarely, or are seasonal (like
Halloween, Christmas, Easter, Spring, Fall, etc) you can
unload them when you are no longer using them by
selecting the library on the left, and clicking the 'Unload'
button. This just removes it from the view, but does not
delete the file from your hard drive. When you need it again,
click the Load button, and locate the file on your hard drive.
It will be added back to the list and usable until you unload it
again.
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Primary Docs UI Libraries

Material Library

LightBurn's Material Library provides a way to store and
organize presets for different operations on different
materials, and have a way to quickly apply them. To add
presets to the material library, you set up a cut layer
however you like and save it to a library. You set a material
type, thickness (if appropriate), and a short description.
Libraries can be saved to shared drives to access your
settings conveniently from multiple computers.

Presets can be applied to a layer by selecting the library
entry and assigning or linking it to the layer.

ACCESSING THE MATERIAL LIBARY

To get started, make sure you can see the Library Window.
In the default layout, it's behind the Laser Window, so you
may have to click to show it. If you don't see it there, make
sure the Library Window is turned on by going to Window >

Library.

CREATE NEW MATERIAL LIBRARY PRESETS

Material library presets are created by copying settings from
existing cut layers.

Select one of your cut layers, then click the Create new from

Layer button in the Library window.

Fill out the detail sheet with the Material Name, Thickness

(if relevant), Title (if relevant), and Description

Now you can use the new entry anytime in the future by
assigning it to a new cut layer.

Material Library Details

USE MATERIAL LIBRARY PRESETS

Presets are used by assigning or linking them to a cut layer
in your project. To assign or link a preset to a cut layer:

Select a layer you want to assign the preset to, or an object on
that layer.

In the material library, select to preset you want to apply to
the cut layer.

Click either Assign or Link

1. 

2. 

3. 

Name Description

Material
Name

The name of the material this applies
to. Presets are grouped by material.

Thickness The thickness of the material. Use No

Thickness for surface operations like
engraving or scoring that don't
depend on the material thickness.

Title Only available when No Thickness is
selected. Used to describe the
general category of preset, such as
"engrave" or "score" and group
presets in a similar way to grouping
by thickness.

Description Describe the preset.

1. 

2. 

3. 
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If your current selected layer has Sub-Layers in any
capacity, using "Create new from layer" will assign all
Sublayer details to that object, and render with "Multi" in the
Cut Settings Editor.

Assign

Assigning a material library preset to a layer is equivalent to
manually copying cut settings written in a notebook into the
layer settings. You can modify the layer's cut settings
without affecting the saved preset, and you can modify the
saved preset without affecting the layer. This is often useful
as a starting point for creating new presets, or using an
existing preset with minor modifications.

Link

Linking a material library preset to a layer will make a
connection between the library and the layer. Modifying a
preset will also update the layer's cut settings, and you will
be unable to modify the layer's cut settings in the Cut
Settings Editor unless you unlink the layer. This is often
useful for files that you will be running again in the future, so
that future improvements to your custom presets will be
automatically applied in your project.

MANAGING MATERIAL LIBRARIES

Modify Existing Presets

Existing Material Library presets can be managed by
selecting the preset's description and using the buttons on
the right side of the Library window.

Edit Cut

Click Edit Cut to open the Cut Settings Editor. This allows
you to change any of the cut settings as you would normally
and saves them back to the library.

Edit Description

Click Edit Description to modify the Name, Thickness and
Description for the highlighted entry.

Duplicate

Click Duplicate to create a copy of the highlighted entry.
This can be helpful in quickly adding to your library. 

Hint: Combined with Edit Description and Edit Cut you
can keep the same "Material Name" and "Thickness" to
create 'nested' entries (e.g. 3mm cut, scan and image).
Keeping just the "Name" while changing the "Thickness"
allows nesting of different thicknesses of the same material. 

Delete

Click Delete to remove a single cut setting entry from the
library.

Save a Library

As you fill out the Library with your favorite materials, it is
always a good idea to periodically save your additions. To do
this, click the Save button.

Duplicate a Library

Click Save As to create a complete copy of your active
library and saves it under a new name of your choice.

New Library

Depending on your workflow, you may want to have multiple
libraries to work from. You can start a new Material Library
any time by clicking the New button at the lower-right
corner of the Library window. This will open a new, blank
library ready to fill out and save.

Note
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Load a Library

Selecting Load provides access to your previously saved
Material Libraries. Clicking on it will open a dialog allowing
you to select and open a saved Material Library. Your chosen
file will then become the active library for use.

ADVANCED USAGE

Multiple Lasers

If you have multiple lasers, it's typically best to create a
material library for each laser. When you save a library, it is
linked to the currently active device. In the future, when you
select that device, the library associated with it will load
automatically. When you change material libraries, LightBurn
will check any linked layers against the newly loaded
material library. If there's a matching preset in the new
library, LightBurn will automatically transfer the link over to
the new library and update the layer's cut settings.

Multiple Computers

Multiple computers can access a single Material Library file
hosted on a network drive or from cloud service storage
(e.g. Dropbox, Google Drive, iCloud, OneDrive, etc.). To open
up a shared Material Library on a different computer, use the
Load button in the Library window.

Please note that if you have multiple computers pointing to
the same Material Library file, updates made from one
computer won't show on the other computer(s) until
LightBurn is restarted or the library is reloaed with the Load

button.
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Primary Docs UI Ruida

File List Window

This window is only supported on DSP controllers that allow
hosting files on the controller, and allows you to see and
manage the files hosted there. 

If not working with DSP controllers, this menu will not
present itself or be usable. This is intended behavior.

Hit the Refresh button to query your controller for the list of
hosted files. You can select a file and press Start to run it,
Delete to remove it from the controller, or Download to save
it locally. Pressing Upload will let you choose a local cut file
to send to the controller (this is not the same as the current
job, which you can upload with the "Send" button in the 
Laser window.

It is worth noting that some controllers, particularly Ruida,
can take significant time to delete a file from the beginning
of the list if there are many files (or large files) following it.
We suspect that the controller is compacting the internal
storage when you do this, so if you are planning to delete
multiple files, it is faster to delete from the end of the list
first.

The 'Delete All Files' button is generally much faster than
deleting files one by one.

The 'Calc Time' button is available only on supported
controllers (Ruida) and will compute the time taken to run
the job on the controller itself. With engraving jobs this can
take a considerable amount of time to do, as the controller is

basically simulating the job internally, and the math is
complex. When it completes, the duration to run the file will
be shown in the 'Info' column.

Info
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Primary Docs UI GRBL

Console Window

On GCode machines, the console window allows you to
directly input commands and see messages from the
controller itself.

You can type a command in the text box and the console will
output the results. Examples would be manual G-Code
commands or retrieving configuration details from your
connected device. 

If the controller encounters an error during execution, it will
be shown here as well.

If you have commands that you use frequently, you can
store them in one of the macro buttons. Right-click a button
to bring up the options to change the macro contents. Give
the button a meaningful name, and enter one or more
commands to send to the controller when the macro button
is clicked.

Enable the 'Show All' toggle switch to display all commands
sent between LightBurn and your controller.

Note, the console window functions are not available on 
DSP controllers, like Ruida, Trocen, or TopWisdom as these
are not GCode based, and do not accept GCode commands.

Primary Docs UI Settings

Settings 

The Settings window in LightBurn controls global user
preferences for LightBurn - these are the settings that apply
regardless of what laser(s) you set up. These are split into
two pages - Display / Units settings and File settings.

DISPLAY & UNITS SETTINGS

The first page is the display and units settings, shown below:

Display / Graphics

Settings in this section control the display and presentation
of LightBurn.

Beginner Mode

Beginner Mode simplifies the interface by removing options
new users are unlikely to use. It can be turned on and off at
any time from this screen. When Beginner Mode is active,
you'll see the message below in the title bar.

Although Beginner Mode can make it easier to get started, it
also mean that your interface will look a little different than
most video tutorials or screenshots you'll see.

If you're searching for a button or features and you don't see
it, it might be because of Beginner Mode, but it could also

be because you're using a machine that doesn't support the
feature you're looking for. LightBurn's interface adapts to
only show you the features that are compatible with your
machine type.

More Info
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Curve Quality

This controls the precision LightBurn uses in displaying
curves on the screen. All curves are displayed as a series of
short lines, but the higher this value is, the shorter those
lines will be. You can see the difference below.

If you're working with files containing thousands of curves
and your computer is lagging you may want to try reducing
this value. If you need your curves to be very precise, you
may want to increase it.

Enable Anti-aliasing

Anti-aliasing smooths the appearance of lines on your
screen. Enabling anti-aliasing will make your design
previews look much nicer, but does increase demand on
your machine. If you notice your computer lagging,
especially on older computers or when working with very
complex designs, you may want to try disabling this setting.

Filled Rendering

When enabled, LightBurn will display filled shapes directly in
the edit window. This takes longer than rendering the wire
outlines, and it can hide things from you behind those filled
shapes that may still be sent to the laser, so we recommend
using this only for spot-checking your work, and not for
general editing.

Use Dark Background

Shows the main edit window using a dark color scheme
which may be easier on people with light sensitivity.

Show Palette Button Labels

This setting, enabled by default, shows numbered labels on
the color palette swatches, making it easier to tell the more
similar entries apart. This is also useful for users with color
blindness or other vision impairments.

Use System Clipboard

Enabling this makes copy and paste operations slightly
slower, but allows LightBurn to:

Copy and paste across different runs of LightBurn, or
between two running copies of the app

Paste images copied from other software or web browsers

Paste text directly into the edit window, auto-creating a
text object for you

Invert mouse wheel zoom direction

This toggle allows users to override the scrolling behavior
within LightBurn to better match their preferences for
macOS or Windows.

Show full-screen line cursor

When enabled, this feature draws a cross-hair that spans the
entire edit screen, which can make it easier to line up
graphics.

Show Rotary Enable on Main Window

This adds a toggle to the main window in the Laser pane to
easily confirm whether rotary is enabled or not at a glance.

Show Cylinder Correction Enable on Main Window

This adds a toggle to the main window in the Laser pane to
easily confirm whether cylinder correction (for engraving of
cylindrical objects without a rotary) is enabled or not.

• 

• 

• 
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Toolbar Icon Size

This slider allows you to manually change the scaling of icon
elements in the LightBurn UI. This allows for manual
overrides for HiDPI screens, UI scaling, and hard of seeing
users. Not all UI elements may fit on screen if increased too
high.

Font Size

This slider allows the end user to decrease or increase the
font size for LightBurn window text anywhere in the
program. This allows for manual overrides for HiDPI screens,
UI scaling, and hard of seeing users. Not all UI elements may
fit on screen if increased too high.

Setting either of these sliders to be too high may result in
clipping of UI elements, due to being an assumed size. If you
scale them up or down such that you cannot reach the
menu items to open the menu and shrink them, please use
the trick listed here to reset; hold Shift  while launching
LightBurn.

Units & Grids

Inches / mm

LightBurn internally operates in millimeters, but can display
in either millimeters or inches. Speeds can be represented
as either units per second or units per minute. Users with
diode lasers will likely prefer the units per minute setting,
whereas CO2 lasers generally express speeds using units per

second.

Grid Contrast

This allows you to adjust the brightness of the grid in
LightBurn's main window relative to the background.

Visual Grid Spacing

The visual grid is set to 10mm by default. Note that this is
independent of the Grid Snap setting below.

Grid Snap Distance

Positioning of lines and other primitives will snap to the Grid
Snap distance unless overridden using the Ctrl key. The
default for this is 1mm.

Click Selection Tolerance

This is how close you have to be to a line or vertex, in screen
pixels, to click it. Increase this number if you have trouble
selecting things, decrease it if you find yourself selecting
things you didn't mean to.

Object Snap Distance

Controls how close, in screen pixels, your cursor has to be to
an object vertex or center to engage the object snapping
behavior.

Snap to Objects / Snap to Grid

LightBurn has two snapping behaviors which can be enabled
/ disabled here. Snap to Objects will snap your pointer
location to the nearest object center or vertex when creating
new objects, or drawing lines, making it easier to connect
and align shapes. Snap to Grid will snap your cursor position
to the nearest grid location, as specified by the Grid Snap
value. Note that the Grid Snap and the Visual Grid do not
have to be the same.

Shape Move Increments

When moving objects with the cursor keys in the edit
window, these values control the distance to move the
selection, when using the arrow keys by themselves or with
the Control or Shift modifiers.

Info

⇧
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FILE SETTINGS

General Import Settings

Group Imported Shapes

This toggle groups shapes imported from a single file
together automatically so they don't get scattered in a
complex design.

Select Imported Shapes

This permits LightBurn to automatically select the shapes
imported from a file in your editor to adjust and edit them as
needed without needing to manually select them.

Import Hidden Layers from AI Files

When importing AI (Adobe Illustrator) files, you may want to
import layers hidden in the source file for construction,
design, etc for lasering. 

Allow Importing to Tool Layers

Allows files to be imported directly to LightBurn's tool layers.

Font Settings

Default Font

This is the font LightBurn will attempt to use for all blocks of
text made with the Create Text Tool.

Default Height

This is the default height (in millimeters) of text LightBurn
will attempt to make when using the Create Text Tool.

Set SHX Font Path

LightBurn allows the use of SHX fonts for single-line &
"quick" text to laser. LightBurn will attempt to load them
from the folder specified in this dialogue. 

It's suggested that this folder is placed in a location you can
easily access, your Documents folder, where you store your
LightBurn projects, etc. It is not suggested this is stored
within the LightBurn application folder (ie. C:\Program 
Files\LightBurn\ ).

Enable Right-to-Left Font Support

This allows LightBurn to render and utilize fonts for
languages that are intended to be used right-to-left, such as
Urdu.

DXF Import Settings

Units

DXF files do not store the measurement system that was
used to create them. If you create an object that is 5 inches
wide, it might import as 5mm wide, because LightBurn can
only see the '5'. Similarly, if your object was created in
microns, it might import huge. Set this value as appropriate
before importing DXF files to ensure correct scaling.

Auto Close Tolerance

DXF files are often saved as a collection of discrete pieces,
instead of continuous paths. The Auto-Close Tolerance value
tells LightBurn to connect any lines or curves that are on the
same layer and closer together than this value.

Other Settings

Auto Save Interval

You can set the frequency of your auto-save by adjusting the
value in minutes here. Setting the auto-save interval to 0
disables the automatic backups.

Auto-launch files in running copy of LightBurn

This toggle attempts to open any LightBurn project files
opened on your computer within a running copy of
LightBurn, rather than opening an additional copy of the
program.

Save Cut Selected / Selection Origin to Project

This saves the cut selected and selection origin items to the
file you're currently editing in, for any number of files.

Save Job Origin to project

This saves specific information about the origin of your job
to the project. One example of a potential use is a "custom
origin" when using a jig or fixture for your laser.

Ignore 'Start' button if monitor is off / asleep

This toggle prevents you from accidentally starting the laser
by presing the wrong key when waking the computer. This is
particularly useful on lasers that don't have enclosures with
safety interlocks, such as most diode and galvo lasers.

Save state of Move / Scale / Rotate switches

This stores the state of the Move, Scale and Rotate switches
to persist across multiple uses.

Info
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Save Job Log

This instructs LightBurn to save which project file was run,
on what laser profile, and at what time.

Automatically check for updates

This permits (or denies) LightBurn the ability to
automatically check for updates to itself, and inform you of
them. This may be useful if your license is out of date and
you want to hide the update notification.

Ignore out-of-bounds shapes if possible

This instructs LightBurn to not send shapes outside your
work area to your laser, permitting use as a construction
area.

Play error sound if file send fails

This produces an audible chime in the event uploading a file
to a DSP controller fails.

Load default layer settings on new or restart

Colors normally start with their last used settings. If this
option is enabled, a new drawing will have a clean slate with
default color settings for all layers. Default settings can be
updated using the "Make Default" Button in the Cut Settings
Editor. If this option is enabled, it may make sense to also
use Material Libraries to store layer settings and make them
easy to reuse.

Use Internal Load / External Load / Bypass Load

These settings permit you to use non-native system
dialogues to perform file/save/open operations with
LightBurn. This can be useful to avoid crashing or hanging
on certain programs modifying or using native dialogs.

Output Settings

Curve Tolerance

This setting is similar to the Curve Quality setting above,
except that it controls the quality of output to the laser.
Because it specifies the maximum amount of error allowed,
the lower the value, the more accurate the curve will be. A
value of 0 would be "perfect", but would create very dense
data, as some lasers can only process line segments. Most
users will be fine leaving this at the default value of 0.05
mm.

In the above image, the blue curve between the two points
is the ideal shape. The black line is a straight line between
them, and the red line shows the error (how far the line is
from the curve). LightBurn measures this error, and if it's
equal to or lower than the Curve Tolerance value, it outputs
the straight line. If not, the curve is subdivided into two
linear segments and the process repeats with each new
segment. Those segments are shown below in violet, along
with their new error values. You can see that the two new
lines do a much better job of approximating the original
curve.

Most people will probably never need to change this - the
default is 0.05mm, which is about 1/2 the width of a typical
beam. Note that this is the maximum error value allowed, so
typical output will be better than this, and this only affects
curves, not straight lines or vertices, which are exact.

Technical Details

4.5.2 Windows & Buttons

- 96/241 - (C) LightBurn Software, LLC

../img/OutputTolerance.png
../img/OutputTolerance.png
../img/OutputTolerance-SubDiv.png
../img/OutputTolerance-SubDiv.png


Primary Docs UI Settings

Device Settings

After initial setup, you can access device settings under the
Edit > Device Settings menu.
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WORKING SIZE

This is the working size of your laser bed. Set this to the
maximum X and Y travel for your laser. Note that this setting
on GRBL & DSP devices does not affect the laser itself, it's
just to tell LightBurn how large the work area of the laser is.

ORIGIN

This is the origin corner or 0,0 location for your laser. If you
have a GCode based system, this is almost always at the
front left, regardless of the location of your limit switches.

If you have a DSP laser, like Ruida or Trocen, the origin is
usually where the limit switches are placed, and will will be
the corner the laser seeks when powered up.

If your laser output is mirrored horizontally or vertically,
move the dot to the opposite corner, horizontally or
vertically, depending on the direction that the output is
mirrored, and that will correct it.

LASER OFFSET

If your laser has a red-dot pointer that is not aligned with
your beam, you can enable the Laser Offset value to
compensate for this when framing and positioning.

Increasing the value will move the red dot further from the
origin, and decreasing the value will move it closer to the
origin. For instance, if your laser's origin is in the back right
corner, and the red dot is a bit further to the right than it
should be, you can increase the x offset to move it to the
left.

Z Axis Controls

Enable Z Axis: turn this on to allow LightBurn to control the
Z axis of your machine, IE the height of the laser above the
workpiece.

Enabling Z control means that LightBurn will always emit Z
values for a running job, and therefore requires that you set 
either the "Relative Z moves only" toggle below, or a
material height value on the main cut panel. If you to not

set relative mode, and do not set a material height, the

default of 0 may cause LightBurn to raise your bed to a

point where the workpiece could contact the head of your

laser.

Reverse Z Direction

Most DSP systems have "0" as the highest point, with
positive numbers moving the laser head further from the
bed, however some systems reverse this. Toggle this switch
to change the overall direction for Z moves.

Relative Z moves only

This setting tells LightBurn to read the height of the machine
when the job starts, and uses that height as the starting
point for all Z moves, ignoring any specified material height.
This is the simplest way to work, as you just set your focus
manually, and LightBurn will perform all moves relative to
whatever height your machine is at when the job starts. 
Note: for DSP systems this requires that you are connected
to the machine.

Optimize Z Moves

By default, LightBurn will always retract the Z back to the
initial height (the material height) after completing a shape
with a Z offset. This is done for safety. Enabling 'Optimize Z
Moves' will prevent this constant retract / plunge behavior,
only issuing Z moves when the Z changes. If you know your
material is flat, and none of the Z moves will position the
laser low enough to run into anything on your work table,
this can save a lot of time.

SCANNING OFFSET ADJUSTMENT

Scanning offset is useful when doing raster or vector
scanning at high enough speeds that delays in your power
supply cause the firing point to be a little behind where it
should be. See the help for Scanning Offset Adjustment
here.

The Add , Delete , Import  and Export  buttons allow you to
create, edit, and manually import & export your scanning
adjustments with user users, or explicitly make a backup
before making changes.

OTHER OPTIONS

Note that this section will appear differently depending on
the type of controller you have, and not all settings will
appear for all controllers.

Fast Whitespace Scan

When engraving an image, LightBurn normally moves at the
same speed across the entire image. If you are engraving
slowly to get a good burn, but the image contains a lot of
empty space (white space), this takes a long time. With the
Fast Whitespace switch enabled, LightBurn will boost the
speed through blank areas to the speed you indicate, if it is
faster than the current engraving speed. This can save
significant time.

Since Marlin treats G0 and G1 moves identically, this value
is used to specify the speed for rapid moves. If you do not
set this value, LightBurn will use the same speed as the G1
moves.

Note

Note
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Enable $J Jogging

On newer versions of GRBL (1.1 and later) $J is a custom
jogging mode that has several benefits over normal jogging,
which just sends simple G0 or G1 moves. The new jog
format does not affect the GCode parser state, and if soft
limits are enabled, any jog command that would go out of
bounds is simply ignored, without trigging an error or alarm.

This setting also allows cancelling a jog move, which
LightBurn uses for Continuous Jog - You press and hold a
move arrow to begin jogging in a direction, then release the
button to stop (cancel) the jog move. Continuous Jogging is
enabled in the Move Window. The switch to enable
Continuous Jogging will not appear unless $J jogging is
enabled.

Enable DTR signal

Standard serial ports have a pin (Data Terminal Ready, or
DTR) that the host enables to tell modems that software is
ready to receive data, and some devices require this signal
to begin communication. Many programmable hobby-level
controllers, like Arduino based systems, use the DTR pin to
reset the controller. LightBurn usually sets this value for you,
but if you find your GCode controller won't communicate,
toggling this setting might help.

Use G0 moves for overscan

By default, all scanning moves emitted by LightBurn are G1
moves, where only the power value is varied, for consistent
speed and power output. Some controllers, like FabCreator
Smoothieware boards, have a non-zero power value for their
minimum output, and can end up burning during the
overscan portion of an engraving. Turn on this setting to use
G0 moves for overscan to eliminate this.

Enable laser fire button

Diode lasers often don’t have a red-dot pointer like CO2
lasers do, so it is often useful to enable them at low power
for focusing or framing. (Please do NOT do this if you have a
CO2 laser, as the beam is invisible and this could blind you

or start a fire). Turning on this setting will enable a button
and a power setting on the Move Window that allows you to
turn on the laser at low power for focusing and positioning.

When the 'Fire' button is enabled, you can hold the Shift key
when framing to enable the beam.

Laser on when framing

This triggers the active laser to run when running the
"Frame" operation on GCode based devices. This is useful as
a test button.

This will use the laser's tube when otherwise a user may not
have been expecting this behavior. Use caution when
changing this setting.

Enable Out of Bounds warning

DSP controllers automatically check for out-of-bounds
conditions, but GCode controllers do not have advance

knowledge of the data being run, and therefore can't do this.
Enabling this flag will tell LightBurn to warn you if a job will
cause your system to travel out of bounds. Note that this
requires your system to have been properly homed,
reporting coordinates correctly, and with the workspace size
set properly.

Return to Finish Position

When running jobs in 'Absolute Coords' or 'User Origin'
mode, enabling this flag tells LightBurn to send the laser to
the specified position after a job is run. This is a convenience
to move the laser head out of the way for unloading
material.

S-Value Max

GRBL and Smoothieware use the S-Value (spindle speed
setting) to control the PWM power output to the laser. This
setting is the number that corresponds to 100% power in
LightBurn. Smoothieware typically uses a value from 0 to 1
and supports fractional numbers in between. GRBL defaults
to 0 to 1000 for newer versions of GRBL, or 0 to 255 for
older ones. The S-Value Max setting in LightBurn must match
your controller setting, or you'll either get not enough power
output (if LightBurn's setting is lower) or very small power
numbers will set your laser to full power (if LightBurn's
setting is higher). The corresponding setting in GRBL is $30
for the firmware versions that support it.

Baud rate

Not all controllers communicate at the same rate. The
default in LightBurn for GRBL controllers is 115,200 baud
(bits per second), and for Marlin it's 250,000 baud. Some
Marlin controllers use 115,200, and some GRBL controllers
go as low as 9600. If you are having difficulty getting your
controller to communicate, and you're sure the firmware is
supported, contact the manufacturer to see if they can tell
you the correct baud rate for the board - it might be different
than the default.

OTHER OPTIONS

Some devices (Ruida) may show an "other options" category
of the Device Settings window. In this, you'll find laser 2
controls, file increment options, bounds when framing check,
and more. 

Increment File Name on Send

This option will automatically increment file names when
sending jobs to your laser to make identifying separate runs
easier and maintain your file history.

Tab Pulse Width

A configurable width of your tab pulse when using the tab
setting in a layer or sub-layer.

Enable Job Checklist

This tickbox,
and the
associated Edit
button, shows
the user a text
box with a list of
items when

Danger
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starting a laser job. This may be useful to remind the user of
things like exhaust fans, aligning the origin of a device, and
more.

Start / End Delay

Start Delay and End Delay allow you to configure the specific
offset before the job begins cutting. On some Ruida setups,
this permits the exhaust fan to start up / spin down after the
job is "done cutting". 

This feature is only present on Ruida controllers, and only
functional on controllers with compatible wiring. Your results
may vary.

ADDITIONAL SETTINGS

The Additional Settings page contains settings used by the
preview simulation engine to calculate acceleration timing,
traversal speeds, and enforce speed limits when computing
the time it will take to complete a job, and when simulating
the job. These must currently be set manually by the user to
match your controller settings, though our goal is to handle
this automatically if possible.

New in V1.3: For DSP controllers only, we have a button to
sync the laser's overscan settings with the preview,
providing much more accurate time estimates.

Primary Docs UI Settings

Machine Settings

Many of the controllers supported by LightBurn have user
configurable device parameters and, in many cases, you can
edit those parameters directly from the Machine Settings
dialog in LightBurn. Notable exceptions are Smoothieware
and Marlin, which do not currently allow use of the Machine 
Settings  dialog.

While connected to your machine you can go to Edit > 
Machine Settings  and will be presented with the following
dialog (sometimes after a brief delay while the parameters
are read from the contorller):

The content of this dialog will be different for every
controller type so we won't go through every option and
value here. The parameter names are intended to be
relatively self-explainatory but if you do not understand what
something does, definitely do not just go about changing it.
Look in the documentation for your controller or search on
the LightBurn Forums for more info.

We would like to specifically call out the Vendor Settings
section that will appear for Ruida controllers. These settings

Info
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are typically set at the factory where your laser was
manufacturered or configured and it's best not to touch any
of these unless you really know what you are doing.

Beyond the parameters that you can change there are five
operations that can be taken with the buttons at the bottom
of the dialog:

WRITE

Write all currently modified parameters back to the
controller. This must be clicked before you close the dialog
as the parameters are not sent to the controller as you
change them, only after clicking the Write  button.

READ

This will reload the settings from the controller. Note that
any changes you made will be lost if you have not written
them to the controller first.

SAVE

Save the controller parameters to a .lbset  file. This allows
you to backup your controller parameters so they can be
reloaded later in case of accidental change or loaded on
another machine which you would like to be configured in
the same way.

LOAD

Load a .lbset  file and overwrite the current controller
parameters with its contents. Warning: this will overwrite 
all parameters! Be sure to back up what you had first with
the Save  option and only load parameters from a known
and trusted source!

In some cases your laser manufacturer will actually provide
this file for you, as a backup.

CALIBRATE AXIS

The Calibrate Axis  tool is provided as a shortcut to getting
your machine axis movement distances dialed in and setting
the steps/mm  parameter on your controller. Please note that
this is no replacement for knowing the true steps/mm  value
for your specific machine. You can read more on our steps/
mm page.

To use this tool, you will need to follow these steps:

Choose an axis to calibrate with the Calibration Axis
option. This will display the current steps/mm  setting
directly below.

Choose a distance you want to move that axis as a test.
200mm, for example. Then enter that in the Requested 
Distance  field.

Instruct your laser to move that distance. If you cannot do
that from a built in control screen, you may have to back
out of Calibrate Axis  and use the jogging functions on
the Move Window to move the selected distance.

Measure the actual distance moved in whatever way is
easiest for your particular machine, with the most
accurate measurement tool you have. Calipers or a ruller
with fine degredations would be best.

Back in the Calibrate Axis  dialog, enter the measured
value into the Actual Distance  field. This will show you
the newly calculated steps/mm  value below.

Finally, click on the Write  button to persist this value to
the controller.

Note: It may require multiple iterations of these steps to
dial everything in to an acceptable level of accuracy,
especially with less accurate measuring tools. Though, the
larger the Requested Distance  value, the easier it is to
measure the difference. Simply repeat the same steps, using
the same requested distance each time. The new steps/mm
value should continue to become more accurate the more
times you repeat this process. 

• 

• 

• 

• 

• 

• 
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4.5.3 Tools & Wizards

Primary Docs Tools

LightBurn Tools & Wizards

This is a list of all the standard tools offered in LightBurn to
make your projects easier and to edit your designs more
directly.

IMAGES

Image Adjustment

Image Tracing

Image Masking

ALIGNMENT & FIXTURING

Center Finder

Snapping Tool

Docking Tool

Cut Shapes

EDITING & MEASURING

Edit Nodes Tool

Measure Tool / Ruler

Modifier Tools

Two-Point Rotate

Tab/Slot Resizer

GENERATORS & VARIABLES

Material Test Generator

QR Code Creator

Variable Text

Formatting

Primary Docs Tools

Adjust Image Tool

The Adjust Image tool is designed to greatly simplify the
process of tweaking image properties such as contrast,
brightness, and gamma while also changing the engrave
settings. Best of all it allows you to instantly see the results
of these changes with both the image properties and
engrave settings applied.

The Adjust Image tool can be accessed by selecting any
single image, right clicking, and choosing the Adjust Image
option.

On the top left the original grayscale source image is
displayed. On the top right is the processed result of the
chosen settings. Just like in the main edit window, you can
use the mouse scroll wheel to zoom in and out on the image
and clicking and dragging to move the image around. The
source image and output image are kept in sync while
zooming and moving around.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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LAYER SETTINGS

The Layer Settings group on the left contains settings that
correspond directly to those found in the Cut Settings Editor,
as highlighted below:

When adjusting an image and changing these settings, it will
update those values on the cut layer currently used by the
image selected when you click the OK button. If you click
Cancel, nothing will be changed. It should be noted that
these settings will affect any image on the same layer.

The most important setting here is the "Image Mode"
dropdown as it will allow you to choose from the various
image processing modes we have. Unlike changing this
setting from the Cut Settings Editor, you get to see what
that image mode looks like immediately, side-by-side with
the source image.

IMAGE SETTINGS

The Image Settings group on the right contains settings that
correspond directly to those found in the Image Shape
Properties panel. In the Adjust Image window, they're
provided as easy to use sliders, so that you can very quickly
tweak these values to get the desired result.

PRESETS

LightBurn offers two image presets within the Adjust Image

window, as well as the option to save your own frequently
used image settings as custom presets.

The Basic preset is a good starting point for your own
engravings or custom presets. The Black Paint on White is
similar, but inverted for engraving light marks onto dark
surfaces.

Save Image Preset

The first button next to the Presets dropdown allows you to
save your current settings as an image preset. You can
choose which layer and image settings are included in the
preset. Any settings not included won't be changed when
the preset is loaded.
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Delete Image Preset

The second button allows you to delete presets. Make sure
the preset you want to delete is selected in the dropdown
first.

Export/Import Image Preset

The third and fourth buttons allow you to export and import
image presets, which is useful for backing up your presets
and for moving them between computers.

Tracing Images

LightBurn has a feature that will trace the outline of a
bitmap image and convert it to a vector graphic. This works
best for content that has very clear edges, like a silhouette
or a cartoon. It does not work very well for photographs,
though with some cleanup those may be usable as well.

We have an excellent tutorial video for this feature on our
YouTube channel here: Image Tracing Tutorial

To start, import an image object into LightBurn, select it,
then choose Tools -> Trace Image from the menu (or press
Alt-T). You can also select an image, then right-click and
choose Trace Image from the pop-up menu.

You'll be presented with the Trace Image dialog, with your
image showing in the window, like this:

In the image above, the purple lines are the vectors that
LightBurn has produced from the image being traced. If you
want to be able to see them more clearly, click the "Fade
Image" button, and the image will dim. You can also zoom
and pan using the same controls as the preview window
(mouse wheel to zoom, and click-drag the view with either
left or middle mouse).
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Controls

The preview window can be panned and zoomed just like the
edit window, using the middle mouse button to pan and the
mouse wheel to zoom. Double-clicking the middle mouse
button resets the view.

The Cutoff slider controls the lower end of the range of
values that LightBurn will outline with vectors, and the 
Threshold slider sets the upper end. The default is 0 to
128, which traces around all values in the range of 0 to 128
brightness, excluding lighter values in the range of 129 to
255 brightness.

By adjusting these two controls, it is possible to trace around
a narrow range of the image.

Selection range

By clicking and dragging within the trace window you can
specify a portion of the image you would like to trace. Once
the area is defined, you can grab and drag a corner of it to
adjust, or just single-click to reset it.

Ignore less than

This setting tells the vectorizer to ignore anything smaller
than this many pixels in area. If you are trying to vectorize a
noisy image, increasing this may help.

Smoothness

Bitmap images are made of pixels, and pixels are rectangles.
Image tracing tries to infer shapes from these arrangements
of rectangles, and has to smooth out the results or
everything would just look like stairs. Part of the process is
trying to recover smooth shapes from jagged lines, and this
number controls how aggressive the smoothing is. A value of
1.333 is the maximum, and will make almost everything into
curves. A value of 0.0 will produce all straight lines. The
difference is shown below:

Notice in the left image, with a Smoothness of zero, the area
highlighted in red is made of several line segments, whereas
the same area in the right image is a continuous curve. The
area shown in blue is also sharp in the left image, but with
the Smoothness value set to maximum, the image at right
shows how even sharp corners become smoothed, and this
is rarely desired. The default value of 1.0 is a good mix
between producing smooth curves while still maintaining
sharp corners.

Optimize

After generating lines and curves, the image trace feature
will attempt to merge similar lines and curves together to
reduce the node count of the result. The Optimize parameter
controls how aggressive this is. 0 means no merging. The
default of 0.2 is a nice balance between accuracy of the
result and node count.

Fade Image

Dims the image to make it easier to see the resulting vector
shapes

Show Points

Enables the display of the points (nodes) of the resulting 
vector trace. Enabling this is useful when you are tuning the
Optimize parameter to see the resulting points.

Sketch Trace

Sketch trace is intended to help with tracing handwriting or
hand-drawn images, for instance tracing a recipe to engrave
onto a cutting board. Without this setting, the threshold
used to determine whether a pixel is filled or empty is
consistent across the entire image. With this setting
activated, LightBurn will consider its pixels neighbors more
heavily to compensate for inconsistencies in both lighting
and the darkness of the image you're tracing. You can see
more at this timestamp of our tracing video.
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Image Masking / Cropping

If you have an image for which you would like to only
engrave a portion of that image, you can use the Image

Mask feature to mask off the area of the image to be
engraved. At the simplest this is the same as doing a basic
crop to the image, but you can go so much further than that
with masking.

BASIC USAGE

At the simplest this process consists of an image and single,
simple shape:

As shown here, the shape is using a Tool Layer which can be

useful for this process as the masking shape will not also be

output. If you also need to cut along the mask then simply

use any of the normal tool layers for this process.

Now select both shapes. You can then apply a mask by
either selecting Tools > Apply Mask to Image or right
clicking on the selection and choosing Apply Mask to

Image.

Note: You cannot mask using a layer set to Fill, as the filled
output would cover the visible image. Any shape you wish to
use as a mask must be either a Tool layer, or set to Line
mode.

The mask will now be applied to the image as you can see
below:

As you can see in the above screenshot, the selection box is
still the same size as it was before. This is because the
entire image still exists, but the mask is providing a
windowed view into that image. If you select just the
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masking shape or the image, you can move it to reposition
the mask.

No image data is lost during this process and you can still
reposition the image or mask even after saving and
reopening a project at a later time. However, as you can see
in the preview below, only that part of the image that was
masked off will be output:

ADVANCED USAGE

What we've shown above amounts to merely an advance
crop feature but image masking can go much further. For
example, you can mask an image using multiple shapes.

When using multiple shapes to mask an image, all shapes 
must be on the same cut/tool layer and those shapes must

be grouped together. Otherwise the Apply Mask to Image

option will not be available._

But you can, of course, go far beyond that. Any closed shape
can be used as a mask and the easiest way to think about
how that mask is applied, is that anywhere LightBurn would
normally fill that closed shape in Fill Mode will now be
"filled" with the image instead. For example:

Note
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Just remember that you must group together all shapes to
be used as a mask first.

Removing a Mask

If you would like to remove the masking you can either
simply select, then delete the mask shape or shape group,
or you can select the image, right click, and choose 
Remove Mask from Image:

Using the Remove Mask from Image option will preserve
the mask shape (or shape group) for later use.

Flattening a Mask

Finally, if you would like to "bake in" an image mask, you can
select the image, right click and choose Flatten Image

Mask. This will make the mask permanent, actually
removing the now unused image data as well as deleting the
image mask shape. As you can see below, the selection box
is now smaller and the mask shape is now gone:

4.5.3 Tools & Wizards

- 109/241 - (C) LightBurn Software, LLC

img/RemoveMask.png
img/RemoveMask.png
img/FlattenedMask.png
img/FlattenedMask.png


Primary Docs Tools

Circle Center Finder

The Center Finder tool is found in the Laser Tools menu. It is
useful for finding the center of circular stock, as well as
defining that stock in the LightBurn workspace.

Getting Started

Home the machine. 

If you machine does not have home switches make sure to
start the machine with the laser head at the 0,0 point of
your work space (Typically lower left corner for g-code
machines) 

If the stock you are referencing is light or can be moved
easily make sure to secure it some how so it does not get
bumped during the operations. 

Setting the Points

Point 1

Jog the laser head to the first position on the edge of your
circle, as shown in the wizard. 

Note - You must JOG the laser with the laser control

panel or from the Move tab for Center Finder to work.

Point 2

Jog the laser head to the next position on the edge of your
circle, as shown in the wizard. 

• 

• • 

• 
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Point 3

Jog the laser head to the last position on the edge of your
circle, as shown in the wizard. 

Move to Center

The last step will show you the calculated center of your
circle and allow you to jog to that point. 
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It will also allow you to create a "Guide Circle" on Tool Layer
1 that will give you a representations of your stock in the
workspace. 

Setting Origin

Absolute Origin

If you use "Absolute Origin" for your workflow, move your
design to the guide circle, and make sure your "Start From:"
point is set to "Absolute Coords"

User Origin - Center

If you use "User Origin" for your workflow, make sure the
center radio button is clicked. 

After you move the laser to the center of your work press
the "Origin" button on your DSP control panel or the "Set
Origin" Button on the Move tab. 

Notes

The more on accurate your point placement is, the better.
If you have a red dor laser that is accurate, one trick is to
try to split the dot on the edges of your stock.

You can set the points in any order. The guide is just a
helpful reference. 

This tool can find the center of any shape that can be
"described" with a circle diameter. 

Shapes like Squares (pick 3 corners)

• 

• 

• 
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Equilateral Triangles

Hexagons 

Troubleshooting

Set a Point Wrong - Hit the "Reset" Button. This will
clear ALL points saved. Just start from the current point.
You can set the points in any order. 

Unable to query the current position of the laser -
This happens when Lightburn is unable to get the position
of the laser from the control. Often the laser is still
moving, or another command is still in process. Click ok,
and try again after waiting for a few seconds. If it
continues happening make sure the control is still
connected and is showing "Ready" at the top of the
"Laser" Tab. 

Not enough seperation between points - You have not
moved the laser away from the last point or not far
enough to make a good calculation. Try moving farther
away and set the point again.

Unable to Calculate Center - Lightburn can't calculate
center, or it would be outside your workspace. This
typically happens on machines without home switches
and that were not started properly. Restart your machine
with the head at your machine origin and try to run the
wizard again. 

• 

• 

• 

• 
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Snapping Tool

When moving objects around the work area, you may notice
that on certain points your cursor changes to a different
icon. This allows you to use that point to snap a moving
shape to another.

SNAPPING BEHAVIORS

LightBurn will automatically align your selection to snapping
points if you see the cursor change to a snap cursor before
you click:

 - The selection will snap to a point

 - The selection will snap to a line

 - The selection will snap to the midpoint of a line

 - The selection will snap to the center of an object

Hold Ctrl/⌘ to toggle object snapping (Disable by default,
may be enable if Settings were changed).

Hold Alt to make snapping 'stickier' - you can snap to things
from farther away.

Primary Docs Tools

Docking Tool

The Docking tool can be used to bring your objects closer
together in your workspace, to allow for more efficient use of
your space.

Each of the Docking buttons will tell your selected objects to
move in that direction, until they hit something.

By default, the Docking tool will move all selected objects,
as far as they will go.
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If no other objects are hit, the edge of the workspace will be
used.

Grouped objects will move together, so if any of them stop,
the whole group will stop.
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ADDITIONAL OPTIONS

The Docking tool comes with a few extra features to change
how it works. These options can be found next to the
Docking buttons:

Move as group

The Move as group  setting treats separate objects as if they
were grouped. 

This means that they will only move until one of the objects
stops, and the rest of the selected objects will also stop.

Lock inner objects

The Lock inner objects  setting keeps objects inside other
objects together. 

When this setting is Off, the inner objects will continue to
move, even when the outer object has stopped.
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When turned on, the setting will keep the inner objects with
the surrounding object.

Note that this does not affect objects that are overlapping;
in this case, the objects will each move independently,
finding their own object to dock against (unless you use the 
Move as Group  option above).

Padding

The Padding  setting allows you to specify a distance that will
be maintained between objects that are docked. 

By default, this value is 0.0, which means that objects will
dock right against each other.
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By increasing this value, you can have objects leave some
space when they meet.

Note that the Padding is only applied in the direction the
objects are docking - it won't be enforced in the other
directions. 
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You can fix that extra padding by moving the objects away,
then back:

The units for the Padding tool (in / mm) are the same as
other tools, such as the Numeric Edits tool.
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Edit Nodes Tool 

The Edit Nodes tool allows you to edit the nodes, lines, and
curves that make up a shape in LightBurn. Note that built-in
primitives in LightBurn, like Text, Ellipses and Rectangles,
cannot be edited without converting them to a generic path
object first using Convert to Path.

NODE EDIT

Video Tutorial: Trim and Extend

SNAPPING

Note that in all of the above tools, when creating a new
shape, you will occasionally see the cursor change if you
hover over a point on an existing shape. This means
LightBurn is going to snap what you're about to make to that
point. You can bypass this behavior by pressing the Ctrl key
(Command on MacOS). LightBurn will snap to object centers,
end points of lines or curves, or center point of lines or
curves, in addition to just snapping to the grid.

PATHS AND SHAPES - CONVERT TO PATH

In LightBurn, all vector objects are stored as paths - a series
of points connected by lines or curves. If you use the Draw
Lines tool, you are directly creating what LightBurn calls a
Path shape. Path shapes are the "lowest level" thing you can
make in LightBurn.

Rectangles, Circles, Polygons, and Text shapes are different -
They store the information used to build the path, and if any
of that information changes, the path is discarded an re-built
from scratch.

For example, Rectangle shapes know their Width, Height,
and whether the corners have a radius. If you edit the
'Corner Radius' property on a rectangle shape, the path that
LightBurn has built is thrown away, and a new one with the
new radius is created. Similarly, if you change the font
applied to a text shape, the old version of it is discarded and
a new one is built using the new font.

If you want to node edit a shape, it has to be a path shape -
using the Convert to Path function in LightBurn on a built-in
shape type tells LightBurn to turn it into an editable thing
that is just points and curves, and that it's ok to throw away
the information about the original type of thing it was.

Action Windows /

Linux

macOS Notes

Smooth
corner
node

S S while
hovering
over a
node

Convert
line to
smooth
curve

S S while
hovering
over a line

Convert
curve to
line

L L while
hovering
over a
curve

Convert
smooth
node to
corner

C C while
hovering
over a
node

Delete
node

D D while
hovering
over a
node

Delete
line

D D while
hovering
over a line

Insert
node
point

I I while
hovering
over a line
or curve

Insert
node at
midpoint

M M while
hovering
over a line
or curve

Break
shape at
point

B B while
hovering
over a
point

Trim line T T while
hovering
over a line,
trim line
under
mouse at
next
intersection

E E while
hovering

Action Windows /

Linux

macOS Notes

Extend
line

over a
point,
extend line
from point
under
mouse to
intersection
with
another
shape

Align to
angle

A A while
hovering
over a line,
press 'A' to
align it to
the nearest
horizontal,
vertical, or
45° angle
(new in
v1.3)
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Primary Docs Tools

Measure Tool 

With the measurement tool you can view a wide array of
useful information about any shape object. To use this tool,
click on the icon in the Creation Tools toolbar. ( Alt + M )

It will display the following dialog:

As you hover the curor over shapes, it will highlight any
indiviual shape in green and the line or curve segment the
cursor is currently over in purple, as you can see below:

The values show in the measurement dialog are as follows:

Nodes: Number of vertices (beginning or ending points of
line/curve segments) in the shape.

Lines: Number of straight lines in the shape. 

Curves: Number of arcs or bezier curves in the shape. 

Perimeter Length: Total length of all line/curve
segments in the shape.

Closed/Open: Whether or not the shape is closed.
Defined as all line/curve segments beginning and ending
on nodes shared with another line/curve segment. 

Area: The total area of the shape. Value is empty if shape
is not closed.

Segment Length: Length of the line/curve segment
currently highlighted in purple. 

Start Point: X,Y coordinate of the start node of the
currently highlighted line/curve segment. 

End Point: X,Y coordinate of the end node of the
currently highlighted line/curve segment. 

Difference: End Point values minus the Start Point Values 

Angle: Angle of the line between the start and end points.
In the case of regular line segments this is the angle of
the line itself. 

Arc Radius: For curves that are perfect circular arcs and
not complex bezier curves, this is the radius of that arc.
Value is empty otherwise.

Arc Center: For curves that are perfect circular arcs and
not complex bezier curves, this is the center point of that
arc. Value is empty otherwise.

Below you can see further examples of the state of the
measurement tool dialog, based on the type of segment
being measured.

DRAG MEASURE

If you need to measure the distance between two shapes
you can click and drag between and two anchor points and
get the above information but pertaining to the two nodes. 

⎇

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Primary Docs UI Tools

Modifier Tools

The modifier tools, as the name suggests, are primarily used
to modify existing shapes.

The tools are:

Modifier Tools

Offset

Weld

Boolean

Boolean Assistant

Boolean Union

Boolean Subtract

Boolean Intersection

Video Walkthrough of the Boolean Operations

Arrays

Grid Array

Circular Array Tool

Virtual Arrays

Start Point Editor

Radius Tool

Add a Radius

Remove or Change a Radius

Troubleshooting Radiuses

Warp and Deform (version 1.4+)

Warp Selection

Deform Selection

OFFSET

Hotkey = Alt + O

The offset tool is used to create outlines around existing
shapes, either inward or outward, offset from the original by
a given amount. We use the offset tool in the 'Making a
Simple Project' topic, so that's a great introduction.

The corner style option chooses how outward corners are
offset:

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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The offset tool remembers the last set of options you used,
and if you hold the Ctrl key when you click the offset button,
it will perform the offset operation using the previous
settings, without bringing up the dialog.

WELD

Hotkey = Ctrl/⌘ + W

Clicking on the Weld icon will join all the selected shapes
into a single entity that is the outline of all the selected
shapes. Note that Weld requires closed shapes, but will
accept an arbitrary collection of inputs, and tries to do the
right thing, but sometimes gets it wrong. If you weld
something and the middle content disappears, use Boolean
Union instead.

BOOLEAN

The boolean tools are used to combine shapes into more
complex shapes. The three different Boolean operations are
shown here:

Union keeps the area covered by either shape - it merges
them.

Difference is the 2nd shape removed from the first.

Intersection keeps the area covered by both shapes.

Boolean Assistant

Hotkey = Ctrl/⌘ + B

Because it can be hard to remember which operation (or
which order) is going to do the thing you want, we've added
a new Boolean Helper that will let you preview each of the
Boolean operations before deciding on one.

Click any of the first 4 buttons to see what that operation
will look like, or click the 'Reset' button to see the original
shapes. If your design is not complex, hovering over the
buttons will also work. When you see the result you want,
click the 'Ok' button to keep it, or click 'Cancel' to revert.

Boolean Union

Union is similar to weld, but works with 2 selected objects
only. However these selected objects can actually be
grouped items, not just a single vector shape.

Boolean Subtract

Hotkey = Alt + -

Boolean subtract (also called Boolean Difference) will
remove the area that the second selected shape overlaps
the first shape by. The order in which you select shapes will
determine the outcome. This tool also works with grouped
items. If you end up subtracting the items in the wrong
order, Undo, then perform the operation again - The undo
switches the order of the items, so a simple Undo and click-
again of of the Subtract button is a quick fix.

 Boolean Intersection

Hotkey = Alt + *

This will create a shape from 2 selected shapes that has an
outline defined by only the areas in which the shapes
overlap. This tool also works with grouped items.

Video Walkthrough of the Boolean Operations

Click for a Boolean demonstration video

The above video describes in more detail how the various
Boolean operations differ, and why welding text to a circle
should be done with a Boolean Union instead.

ARRAYS

Arrays allow you to make regularly spaced copies of a
shape. LightBurn offers both grid and circular arrays.

Grid Array

The Grid Array tool allows you to copy a shape (or shapes)
with regular spacing horizontally, vertically, or both, and

• 

• 

• 
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includes options to adjust spacing, to shift odd rows, mirror
the shapes, and more.

The X and Y columns settings let you specify how many
copies of your shape to make in each direction. 

Total Width and Total Height are convenience options that
allow you to tell it the maximum size to occupy/ It will set
the X Columns and Y Rows values to whatever is necessary
to fill the specified size without going over, based on the
other provided settings.

Spacing can be specified between edges (how much padding
between shapes) or between centers (absolute object
spacing). 

Column and Row Shift values let you offset alternate
columns or rows, and you can mirror them as well, allowing
you to more efficiently pack oddly shaped items together,
like this:

Circular Array Tool

The Radial Array (or circular array) tool lets you create
copies of a shape (or shapes) around a central point. This is
useful for creating ornamental patterns, clock faces, and
more.

You can manually enter the point of rotation, but it's much
simpler to create a shape to use as the center point, and
select that shape last. The created copies can be rotated or
not - Numbers on a clock, for example, are often left upright
for readability, but roman numerals are usually rotated.

In the above example, the small center circle was selected
last, and the 'Use last selected object position as center'
option is chosen, along with 'Rotate object copies' to
produce the pattern.

Virtual Arrays

There is also a Virtual Array option that can be selected by
checking "Create Virtual Array" at the bottom of the Grid
Array dialog. Instead of making copies of the original
shapes, this will generate virtual clones of the original that
stay synced at all times. When using a virtual array, the
virtual clones will render with a dashed outline and muted fill
color to denote they are virtual:
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Note that these virtual shapes are not selectable and will
always be laid out based on the array options you provided.
However, any changes made to the original shapes are
automatically reflected in the array.

Beyond just altering the original shapes, there are many
operations that can be done after the fact to virtual arrays,
all of which are available from the shape context menu. This
menu is available from any shape that is currently part of a
virtual array. You do not have to select all shapes in that
array first.

Edit Array: Display the "Create Grid Array" dialog again,
but for this existing array. This allows you to modify any of
the parameters and even convert it back into a normal
array, by unchecking "Create Virtual Array".

Duplicate Array: Virtual arrays cannot be selected
directly, only the shapes included in them. So this allows
you to duplicate an entire virtual array and all of the
shapes in it.

Flatten Array: Convert the virtual array into a standard
array where all shapes are separate copies and no longer
synced to the original shapes.

Remove from Array: Remove the currently selected
shape(s) from the virtual array.

Add to Array: Add any currently selected shapes not in
the virtual array to the array. Note, you must select at
least one shape that is in a virtual array and one shape
that is not in a virtual array currently.

START POINT EDITOR

The Start Point edit tool lets you tell LightBurn where to start
cutting a shape, and in which direction. By default, the
starting point is the first point of the shape, and the
direction will be the direction that the selection marquee

• 

• 

• 

• 

• 
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animates in. In the Optimization Settings, if you tell
LightBurn to choose the best starting point or best direction,
it can choose a different point than the default if it will
reduce cutting time. The Start Point editor lets you force the
starting point and direction.

With a shape selected, click the 'Start Point' tool and you'll
see the starting point and direction indicated by an arrow. If
the arrow is gray, it means this shape is displaying the
default point and direction, but it is not forced. If you click
any node on the shape, the arrow will move there, and turn
blue, indicating that the user has chosen this as the starting
point and direction.

Holding Shift and clicking a point will choose the opposite
direction, and holding Ctrl and clicking the shape will clear
the starting point back to the default.

RADIUS TOOL

You can fillet (round over) sharp corners using the Radius

Tool. It also allows you to remove radiuses from corners,
turning them into sharp points.

Fillets have all kinds of applications, and they can be
combined to form more complex shapes.

Add a Radius

To add a radius, click the radius tool, change the radius
value to reflect the size you want your rounded corner to be.
Then click on the object, and the specific corner you want to
round out. 

If you change the radius to a negative number it takes a
fancy little bite out of the corner. 

Remove or Change a Radius

As of release 1.3, you can use the radius tool to delete
rounded corners (returning them to a sharp one) by clicking
on them. This even works on imported designs that were
made in different software, as long as the software exported
actual arcs.

After removing a radius you can then apply a differently-
sized one to the corner, as normal.
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Troubleshooting Radiuses

Radiuses can only be applied where straight (vector) lines
meet in a connected corner, and where there is room for the
radius to be applied. 

When the radius tool is active, the icon changes as you
hover over a corner to indicate whether or not the radius
tool can be used.

If the cursor isn't appearing as you hover over a corner,
make sure you've selected the radius tool in the Creation
Tools. The Radius icon should be highlighted. Also check that
you have selected the object you wish to edit by clicking on
it.

If that still isn't working, check that the connected lines are
straight. It's possible for lines that appear straight to be
curves, especially in imported files. Select the Edit Nodes
Tool, hover over the line either side of your corner and hit 
L  on your keyboard. 

If a radius still can't be applied it might be because the two
lines that make up the corner aren't actually joined at that
point. To check, move the corner using the Edit Nodes Tool, if
it splits off into two lines, bring the one you moved back
toward the other so that they snap together and join, and
then try the radius again. 

If you are having trouble converting a rounded corner back
into a sharp one, it could be because there is not a true arc
at the corner. This is most common with imported shapes,
because some programs export arcs as a series of tiny lines.
You can try repairing these with Optimize Selected Shapes.

To exit the radius tool, hit Escape on your keyboard. 

WARP AND DEFORM (VERSION 1.4+)

You can find both Warp Selection and Deform Selection

under the Tools menu. Both tools can be used on single or
multiple objects by selecting the objects and then selecting
the tool. You can modify text, shapes, or images by dragging
the handles.

While using warp and deform:

Double click on a handle to reset it.

Hold Shift  while dragging a handle for horizontal
symmetry.

Hold Ctrl  / Cmd  while dragging a handle for vertical
symmetry.

Warp Selection

Warp Selection uses four handles, one at each corner.

Icon Meaning

Click to fillet corner

Click to remove fillet

Can't fillet - corner is next to a
curve

Can't fillet - not enough space

• 

• ⇧

• ⌃ ⌘
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Deform Selection

Deform Selection uses 16 handles, arranged in a 4x4 grid.

You can grab and drag the blue dots at the corners and
intersections of the grid to deform the shape. See the
animation below for examples.

Primary Docs UI Tools Editing

Two-Point Rotate and Scale

This feature allows you to rotate an object around a pivot
point.

HOW TO USE

First, select the object you want to rotate.

Then, click the "Two-Point Rotate / Scale" button in the
"Arrange" menu (or Ctrl + 2 ) to start the use of the
tool. 

In the bottom right corner of the window, LightBurn will ask
you to select the first point (the center of rotation). Click on
a point in the editing area to do this. 

⌃
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If the point you're selecting is a corner point, the mouse
cursor will change to a crosshair. This can help if you're
trying to rotate around a very specific point.

After confirming your first point, the instructions in the
bottom right corner will update to ask you to select the
second point. Your cursor will also change.

By clicking and dragging you can rotate the shape, and
LightBurn will give you a preview as you move your mouse.

When the mouse is released, your object will be rotated as
intended.
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Slot & Tab Resizer (v1.3+)

ABOUT

This is a separate tool from the tabs/bridges tool, which can
be used to leave a part connected to the material it is being
cut from so it doesn't fall out immediately.

Have you ever wanted to use a jointed design that was
made for a different thickness of material, or wanted to cut
it at a different size/scale, but the thought of manually fixing
all the joints is painful? 

The Resize Slots tool searches for slots or tabs of a specific
size, and let you choose a new size for them to be, taking a 
lot of the hard work out of it! 

USAGE

This tool currently works on two main forms of geometry:

Slots, like those found in 3D puzzles or partitions in trays,
somewhat similar to a traditional halved joint or dado. 

Tabs, like a tenon or the fingers in a box joint, usually
found in boxes and drawers.

STEPS

You'll need to know the length of the lines you want to adjust.
You can use the Measurement Tool to find it if you are unsure.

Ungroup your shapes if necessary. Then select your objects
and click Tools > Resize Slots in Selection.

The tool searches for tabs or slots within the selected objects,
and then searches within that geometry for lines with the
length you specify in Old Material Thickness. Any slots or tabs
identified by the tool are highlighted in red. The lines that will
move are highlighted in blue and shown with an arrow
indicating the direction and distance they will move.

Click the 'OK' button to confirm.

SETTINGS

Old Material Thickness: The current length of the lines
you want to adjust.

New Material Thickness: The length you want to adjust
the lines to.

Tolerance: Allows you to 'fuzz' the Old Material Thickness
slightly. This helps if the lines vary slightly in length. It
also allows you to put in the measurement of the material
the part was designed for, and use the tolerance to allow
for any kerf offsets built into the existing design.

Adjust Slot Depth: Adjust the bottom/innermost line of
the slot. This allows you to keep the outer size of the
assembled piece the same.

Adjust Slot Width: Adjust the sides of the slot. This
would typically be used when the slots are meant to
intersect on the interior of a lasercut piece instead of on
the corners, like boxes.py's tray insert

Adjust Tab Height: Adjust the top/outermost line of the
tab. This allows you to keep the interior size of the
assembled piece the same, while making it bigger or
smaller on the outside.

TROUBLESHOOTING

The tool doesn't yet work on internal slots/ cutouts/
mortises as it's tricky for the computer to determine which
direction they should grow/shrink.

The tool searches ungrouped objects. If it's not
recognising the tabs or slots in your design, try 
ungrouping your objects. 

The tool only works on sharp (not filleted/rounded)
corners. Some tools (like boxes.py) default to adding small
loops on internal corners and small filets/rounded corners
on external ones. The external filets ones can be removed
using the Radius Tool and the internal loops can be
removed using the Offset tool set to 0. 

The tool requires well-formed shapes as an input. If the
shape has extra nodes, or if any of the lines are
technically curves (even if they're straight), it will interfere
with slot/tab detection. The highlighted sections in the
image below show examples of problematic shapes. You
can use optimize selected shapes to try to repair these
shapes.

Info

• 

• 

1. 

2. 

3. 

4. 

• 

• 
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• 

• 

• 
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Primary Docs UI

Material Test

ABOUT THE MATERIAL TEST FUNCTION

LightBurn has a built-in feature for generating test patterns.
You can use this to identify the best settings for your laser
and material combination. You can find it in the LightBurn
menus by going to Laser Tools > Material Test

The settings in this dialog box will let you configure your test
pattern. To the right, you'll have buttons to preview the test
pattern, frame it on the material, start, pause, and stop.

MATERIAL TEST EXAMPLE

The example to the right shows what you can expect after
running a material test. On the left side, you can see a range
of speeds, and on the bottom you can see a range of power
levels. At the top, you can see the settings for interval, 
passes, and frequency. The material test generator
defaults to varying power and speed, but you can choose
to make your grid with any 2 of the avalible settings with the
"param" dropdowns.

Galvo lasers with the appropriate source can also test Q-

pulse combined with the above options.
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USING THE MATERIAL TEST FUNCTION

The rows and columns can be controlled independently,
using the settings in the dialog box.

At the bottom of the dialog box, you'll see buttons for "Edit
Material Setting" and "Edit Text Setting". Each of these
buttons will open a cut settings editor window for you to
adjust the settings you want to use. The material settings

will control the settings for the test grid, aside from the two
parameters being tested. The text settings will allow you
to set the cut settings for the text labels.

SAVING AND EXPORTING

At the top are buttons allowing you to save, delete, export,
and import presets. There is also a dropdown allowing you to
select a saved preset. This is useful if you have custom
settings you like to run frequently, for instance a smaller test
pattern you want to use on metal tags or a range of settings
you want to test on different woods.

To access presets for the material test, go to File > Open

prefs folder And then in that opened directory the presets
will be under ./presets/material_test_presets.lbmt

Primary Docs UI

Interval Test Tool

ABOUT INTERVAL SETTINGS

Finding an appropriate interval setting is an important part
of optimizing your engraving quality. The interval refers to
the distance between lines when raster engraving.

Diagram of the effect of interval spacing on engravings

If your interval setting is too high, you'll need more power to
achieve the same burn, and you may see gaps between the
lines. You may also see stepping on curved edges.

Appropriate interval settings will give you a darker, deeper
engraving with cleaner edges.

Lowering your interval settings too far will increase your
engraving time, with minimal increase in engraving quality.

USING THE INTERVAL TEST TOOL

Every type of machine and material will process differently,
so the Interval Test is a quick way to determine appropriate
settings for a given combination of machine and material.

After running the Interval Test, look at your test squares
closely with good lighting. You'll want to look for an etch in
which you don't see defined lines between the passes (too
high an interval) and passes don't appear to overlap (too low
an interval). This can vary significantly between materials.
See the video above for visual examples.

Place a scrap piece of the material you're testing into your
laser, and adjust your focus appropriately.

Figure out how much material you have available for the
interval test. The default settings for the material test will
produce a test grid about 150mm long and 50mm tall. You
may need to run multiple tests, so keep that in mind.

Adjust your settings.

Preview the test to make sure the output is what you expect.

Frame the test to make sure it's placed and sized appropriately
for the material

Press start to run the test.

If you're using the Material Library to save and apply cut
settings, don't forget to create or update a material preset
with the appropriate interval. If you aren't familiar with the

1. 

2. 

3. 

4. 

5. 

6. 
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Material Library, you might want to give it a try - not having
to figure out optimal settings every time saves a lot of time
and effort. 

INTERVAL TEST SETTINGS

Speed and Power

The speed and power to use for all the swatches. If you've
already run a speed and power test with our Material Test
tool (see video on YouTube), you can go with those settings.
Otherwise, your laser manufacturer likely has recommended
settings available to use as a starting point.

Min and Max Interval

The lowest and highest interval settings to use for the test.
For most CO2 and Diode lasers, using an interval below
0.1mm is unnecessary.

Steps

How many sample squares to create. Reducing this will
reduce the material needed, but will also result in larger
differences between each test square.

Size

The size of the sample square. Reducing this will reduce the
material needed, but may make the results harder to read.

Simple Fill or Dithered Image

Simple Fill will generate squares with a solid black fill. 
Dithered Image will fill the square with a dithered gradient
to help you see what your gradients will look like when
photo engraving.

QR Code Generation

QR Codes are square 2D barcodes that can be scanned by a
mobile device with a camera. They are able to store and
convey a wide variety of information, such as simple text, a
URL, or even WiFi access information, such as the example
shown below.

Most modern mobile devices with a camera include some
sort of built in QR code scanning ability, often direct from
the stock camera application. Simply point the camera at
the code and it will recognize it and provide a prompt to
proceed with whatever information is contained. If this does
not work, check the documentation for your specific device.
In some cases, you may need to download a barcode
scanning application.

USAGE

LightBurn can easily generate QR Codes for you using the
QR Code tool. Navigate to the Tools  Menu and then select 
Create QR Code  as shown below.
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With the QR tool selected, click and drag in the Edit Window
where it will show a square being drawn, this will be the
initial size of your QR Code. Once you release the mouse
button, you will be shown the QR Code Properties  dialog.

From here there are 3 main options for QR code content:

Raw content: typically plain text or URLs

WIFI: Creates a WiFi access point configuration code for
mobile devices.

Contact: Creates a "Contact Card" code which will load
contact info into your mobile device's contacts.

As you enter QR Code content you will see the QR code in
the edit window update in realtime. The more content you
add, the smaller the sub-squares will become to fit all of that
data. You can always scale the size of the QR Code after the
fact, if needed.

Note that you may also edit an existing QR code object by
selecting it, right clicking, and choosing the Edit QR Code
option. This will bring up the same QR Code Properties  dialog
as before with all the information filled in.

Raw Content

This is the simplest and most flexible option as it allows you
to enter any text you would like. At the simplest this is just
basic plain text or a URL. But there are a wide variety of
other options supported by many mobile devices such as
email addresses, phone numbers, geo-location information,
and more. There is a great list explaining the options and
how the text must be formated on the zxing barcode
scanner documentation.

• 

• 

• 
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WiFi

With with WIFI tab you can create a barcode that, when
scanned, will allow that mobile device to automatically
contect to a WiFi access point with all of the connection
informtation provided.

The input options are:

Network name / SSID: The configured name of the access
point

Password: The WEP or PSK password for the network if one
is required (see Authentication type below)

Hidden network: When checked this specifies that the
SSID of the network to connect to is not broadcast publicly
and that the mobile device should act accordingly.

Authentication type: Choose from WPA/WPA2, WEP, or
None. Typically most modern access points use WPA2.
Check the configuration on your access point if you are
unsure.

Once you've entered the WiFi access point information the
content under the Raw Content  tab will automatically be
updated to reflect the WiFi configuration. As shown below:

The WiFi raw content format is described in more detail in
the zxing barcode documentation.

Contact

With the Contact tab you can create barcodes that contain
contact information which can then be automatically loaded
into a mobile device's contacts storage.

• 

• 

• 

• 
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Just like with the WiFi tab, once infomation is entered on the
Contacts tab, if you go back to the Raw Content tab you will
see the raw contact card shown, which in this case is in the 
"MECARD" format.

CUT SETTINGS

Because of the way QR Codes work it's assumed that there
is a high amount of contrast between the light and dark
sections of the barcode. Most importantly the dark sections
must be completely filled so you should be sure to use the 
"Fill" mode on the cut layer being used for the QR Code. If in
LightBurn you see the QR Code render as shown below, that
means you either are not using "Fill" mode on that cut layer
or filled rendering is turned off.

You can enable filled rendering from the Window  menu by
choose Filled / Coarse  or Filled / Smooth

If you would rather not enable filled rendering in the edit
window, you can also see a preview of what the filled QR
code will look like by launching the cut Preview. You will, of
course, still need to have the QR code on a "Fill" mode cut
layer.
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Once in "Fill" mode, be sure to set an appropriate power
level for the material you are using in order to provide
sufficient contrast between the fill engraved areas and the
base material similar to what you see below:

Variable Text

Primary Docs Text & Fonts Tools

VARIABLE TEXT IN LIGHTBURN

Variable text is a feature that allows you to use special
codes in your text entries that will be substituted for
something else when you send the data to the laser (or the
preview). Variable text can be used for:

Date or time stamps

Serial numbers

Displaying cut settings

Merging a CSV file into your designs

In all of these cases, the text in LightBurn is set to one of the
dynamic text modes, and the text entered is used to tell
LightBurn what you want it to display. You select the text
mode like this:

With the mode selected, you enter one of the special codes
for that mode, and when you preview, save, or send the file
to the laser, LightBurn will replace the text with the desired
output.

The different formatting codes are listed here: Variable Text
Formats

Variable Text Manager

If using serial numbers or a CSV file, you have additional
controls, available in the Variable Text window in LightBurn,
shown below:

The values shown are:

Current: The current serial number, or row from the CSV
file, that will be displayed.

Start: The first serial number you want to use, or the first
row in the CSV file to be used.

End: The last serial number to use, or the last row in the
CSV file to use.

Advance by: Imagine you are creating a series of numbered
labels. Rather than cutting each one separately, you would
most likely want to do several at once on a page. The
"Advance by" value tells LightBurn how many entries to

• 

• 

• 

• 
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advance ahead when you click the Next or Previous buttons,
or when it automatically advances to the next page for you.

The buttons on the right are for:

Previous: Go to the previous page of values (decrements
the Current entry by the 'Advance by' amount)

Next: Go to the next page of values (increments the Current
entry by the 'Advance by' amount)

Test: Displays the text that will be output, for as long as the
button is pressed.

Reset: Resets the Current value to the Start value

Auto-Advance: When this switch is enabled, each time you
press one of the 'Start', 'Send' or 'Save as..' buttons in the
Laser window, LightBurn will automatically advance the
Current value by the 'Advance by' amount. If you are
running a large batch of parts, names, serial numbers, etc,
each time you send a job to the laser the software will
advance to the next batch.

Text objects within LightBurn have a property called Offset.
This value is added to the current variable text index when
evaluating the text object. This allows you to have text
objects on your design that display different serial numbers,
or different rows from the CSV file.

If you created a design with 4 name tag labels on the page,
you would set the Variable Offset value for each of the four
labels to 0, 1, 2, and 3, and tell the Variable Text manager to
advance by 4 with each run.

Automatic Arrays

When copying a text shape using Grid Array, Circle Array, or
Copy Along Path, LightBurn can automatically advance the
'Offset' value on your variable text objects for you. In this
way you can quickly create full sheets of items containing
serial numbers or CSV file references.

VARIABLE TEXT FORMATS

These are the different formatting codes used for Variable
Text in LightBurn.

Date / Time text format

When using the Date/Time mode for text, the system will
automatically substitute special combinations of characters
with values for the current local date and time.

For example, if your text field is "d/MM/yyyy" the system
would replace it with "15/6/2019". The values you can use
for substitution are listed below.

These expressions may be used for the date:

These expressions may be used for the time:

Output Expression

the day as number without a
leading zero (1 to 31)

d

the day as number with a leading
zero (01 to 31)

dd

the abbreviated localized day name
(e.g. 'Mon' to 'Sun'). Uses the
system locale to localize the name.

ddd

the long localized day name (e.g.
'Monday' to 'Sunday'). Uses the
system locale to localize the name.

dddd

the month as number without a
leading zero (1-12)

M

the month as number with a
leading zero (01-12)

MM

the abbreviated localized month
name (e.g. 'Jan' to 'Dec'). Uses the
system locale to localize the name.

MMM

the long localized month name (e.g.
'January' to 'December'). Uses the
system locale to localize the name.

MMMM

the year as two digit number
(00-99)

yy

the year as four digit number yyyy

Expression Output

h the hour without a leading zero (0 to
23 or 1 to 12 if AM/PM display)

hh the hour with a leading zero (00 to
23 or 01 to 12 if AM/PM display)

H the hour without a leading zero (0 to
23, even with AM/PM display)

HH the hour with a leading zero (00 to
23, even with AM/PM display)

m the minute without a leading zero (0
to 59)

mm the minute with a leading zero (00
to 59)
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Any sequence of characters enclosed in single quotes will be
included verbatim in the output string (stripped of the
quotes), even if it contains formatting characters. Two
consecutive single quotes ('') are replaced by a single quote
in the output. All other characters in the input string are
included verbatim in the output string.

Formats without separators (e.g. "ddMM") are supported but
must be used with care, as the resulting strings aren't
always reliably readable (e.g. if "dM" produces "212" it could
mean either the 2nd of December or the 21st of February).

Example format strings (for the date & time 21 May 2001
14:13:09.120):

Serial number text format

When using the Serial mode for text, the system will
automatically substitute certain special combinations of
characters with the current serial number value, and other
characters control how it is formatted.

These expressions may be used for serial numbers:

The number of characters used controls how many digits the
system will display. If the serial number is larger than the
number of digits allowed, as many digits as will fit from the
end of the number will be displayed. For example, if your
serial number is 1234, the table below shows how that
number would be formatted for each of the displayed
formatting inputs:

You cannot mix decimal and hexadecimal formatting in the
same text entry, and you cannot split a serial number with
other characters. For example, this string is not valid: ddd-
ddd because of the hyphen between the two groups of
format characters.

Like the Date / Time formatting, any text between a pair of
single quotes is copied exactly to the output, and a pair of
single quotes together is replaced by one single quote in the
output.

CSV/Merge text format

When using the CSV/Merge mode for text, the system will
automatically substitute certain special combinations of
characters with entries from the selected row of a CSV file. A
CSV file is "Comma Separated Values" - a very simple text
format that uses a line in the file as the row, and commas to
separate columns in the file.

For example:

In a CSV/Merge entry in LightBurn, the text you enter uses
the percent sign followed by a number to look up a column
in the current row of the CSV file. For example, using this
text with the above table:

 I'm thinking of buying %0 - it costs $%1

Would display:

 I'm thinking of buying LightBurn - it costs $80

Columns are numbered starting from 0.

Expression Output

s the whole second without a leading
zero (0 to 59)

ss the whole second with a leading
zero where applicable (00 to 59)

z the fractional part of the second, to
go after a decimal point, without
trailing zeroes (0 to 999). Thus
" s.z " reports the seconds to full
available (millisecond) precision
without trailing zeroes.

zzz the fractional part of the second, to
millisecond precision, including
trailing zeroes where applicable
(000 to 999).

AP or A use AM/PM display. A/AP will be
replaced by either "AM" or "PM".

ap or a use am/pm display. a/ap will be
replaced by either "am" or "pm".

t the time zone (for example "CEST")

Input Result

dd.MM.yyyy 21.05.2001

ddd MMMM d yy Tue May 21 01

hh:mm:ss.zzz 14:13:09.120

hh:mm:ss.z 14:13:09.12

h : m : s ap 2 : 13 : 9 pm

Output Expression

The serial number as a decimal
value

d

The serial number as a
hexadecimal value, lower case

h

Output Expression

The serial number as a
hexadecimal value, upper case

H

Tells LightBurn to pad the number
with leading zeros

0

Input Output Input Output

d 4 0d 4

dd 34 0dd 34

ddd 234 0ddd 234

dddd 1234 0dddd 1234

ddddd 1234 0ddddd 01234

dddddd 1234 0dddddd 001234

LightBurn,80,10

Corel,300,20
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Cut Setting text format

When using the Cut Setting mode for text, the system will
automatically substitute certain characters with values from
the cut setting applied to the text.

Like the Date / Time or Serial number formatting, any text
between a pair of single quotes is copied exactly to the
output, and a pair of single quotes together is replaced by
one single quote in the output.

Expression Output

C followed by a number, pulls settings
from the numbered cut layer (ex,
C03) for the remainder of this string

s speed, as a number in the current
speed units

S speed, including the current units
(like mm/sec)

p max power, as a percentage

P max power, including the percent
sign

m min power, as a percentage

M min power, including the percent
sign

d / D DPI, as a number, always dots per
inch

Expression Output

i interval, in the current distance
units

I interval, including the current
distance units (like mm)

L Displays the name of the laser. Can
optionally be followed by a
character index to start displaying
from, and optionally, a comma and a
2nd number for the number of
characters to display. For example, if
L displayed 'Ruida 6442G', L6 would
display '6442G', and L6,4 would
display '6442' (without the quotes)

z Z offset for the current layer, in the
current distance units

Z Z offset for the current layer
including the units (eg, mm)

q Q-pulse width

Q Q-pulse width, followed by 'ns' to
indicate the units

k frequency in kHz

K frequency in kHz, followed by 'kHz'
to indicate the units
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4.5.4 Hotkeys and Gestures

Most feature hot-keys can be found next to the action in the
menus. 

Hotkey Editor (version 1.3+)

As LightBurn has added more features, it's become harder to
find available hotkeys that will work with a variety of
keyboard layouts. Version 1.3 has added a hotkey editor, so
you can cusomtize most of LightBurn's shortcuts to your
liking. Any button on the toolbar can be given a hotkey, and
the editor includes a search function to help you find them.

Access the Hotkey Editor through the menu: File >> Edit

Hotkeys

The Hotkey Editor Window

General Usage Hotkeys

MOUSE

Selection: Left click, or band-box

Shift + click adds to the current selection

Ctrl/⌘ + click removes from the current selection

Drag: Left-click & hold on an object, drag it

When dragging, Shift will keep the drag vertical,
horizontal, or 45 degrees

When dragging, Ctrl means "don't grid / object snap"

When sizing, the default is retain the current aspect ratio,
holding shift unlocks it.

When sizing, Control means "resize from center"

Zoom: Mouse wheel (zooms relative to the cursor)

View drag: Middle-mouse click and drag

Double clicking text: Auto chooses text mode and
places cursor.

KEYBOARD

View drag: Hold space-bar + left-click & drag (useful for
Mac, or users without a mouse wheel)

Delete: Backspace or Delete keys

Select Mode: Pressing the Esc key while in the
workspace will return to the selection tool

Move

Arrow keys move the current selection

Shift + arrow moves in large steps

Ctrl/⌘ + arrow moves in small steps

MENU HOT-KEYS

File

Edit

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Action Windows /

Linux

macOS

New Ctrl + N ⌘ + N

Open Ctrl + O ⌘ + O

Import Ctrl + I ⌘ + I

Save Ctrl + S ⌘ + S

Save As Ctrl + Shift + S ⌘ + Shift +
S

Save As
Gcode

Alt + Shift + L Alt + Shift
+ L

Export Alt + X Alt + X

Print (Black
Only)

Ctrl + P ⌘ + P

Print (Keep
Colors)

Ctrl + Shift + P ⌘ + Shift +
P

Exit Ctrl + Q ⌘ + Q

Action Windows /

Linux

macOS

Undo Ctrl + Z ⌘ + Z

Redo Ctrl + Shift +
Z

⌘ + Shift + Z

Select All Ctrl + A ⌘ + A

Invert
Selection

Ctrl + Shift +
I

⌘ + Shift + I

Cut Ctrl + X ⌘ + X

Copy Ctrl + C ⌘ + C

Duplicate Ctrl + D ⌘ + D

Paste Ctrl + V ⌘ + V

Paste in
place

Alt + V Alt + V

Delete Delete /
BackSpace

Delete /
BackSpace

Convert to
Path

Ctrl + Shift +
C

⌘ + Shift + C

Convert to
Bitmap

Ctrl + Shift +
B

⌘ + Shift + B
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Vector Tools

Image Tools

Window

Laser Machine Tools

Cuts/Layers

GLOBAL HOTKEYS

The following work from anywhere while objects are
selected.

Action Windows /

Linux

macOS

Close Path Alt + C Alt + C

Auto Join Alt + J Alt + J

Optimize Alt + Shift +
O

Alt + Shift +
O

Delete
Duplicates

Alt + D Alt + D

Action Windows /

Linux

macOS

Draw Line Ctrl + L ⌘ + L

Rectangle Ctrl + R ⌘ + R

Ellipse Ctrl + E ⌘ + E

Edit Nodes Ctrl + ` ⌘ + `

Add Tabs Ctrl + Tab ⌘ + Tab

Create / Edit
Text

Ctrl + T ⌘ + T

Offset Shapes ALt + O ⌘ + O

Weld Shapes Ctrl + W ⌘ + W

Boolean Union Alt + + Alt + +

Boolean
Subtract

Alt + - Alt + -

Boolean
Intersection

Alt + * Alt + *

Boolean
Assistant

Ctrl + B ⌘ + B

Break Apart Alt + B Alt + B

Cut Shapes Alt + C Alt + C

Action Windows /

Linux

macOS

Adjust
Image

Alt + I Alt + I

Trace Image Alt + T Alt + T

Action Windows /

Linux

macOS

Preview Alt + P Alt + P

Zoom In Ctrl + = ⌘ + =

Zoom Out Ctrl + - ⌘ + -

Zoom to Page Ctrl + 0 ⌘ + 0

Preview Alt + P Alt + P

Action Windows /

Linux

macOS

Toggle
WireFrame/
Filled

Alt + Shift+
W

Alt + Shift
+ W

Frame Selection Ctrl + Shift +
A

⌘ + Shift
+ A

Square Frame
Selection

Alt + R Alt + R

Rubber Band
Frame

Alt + Shift +
R

Alt + Shift
+ R

Action Windows /

Linux

macOS

Rotary Setup Ctrl + Shift +
R

⌘ + Shift
+ R

Position Laser Alt + L Alt + L

Pause Pause

Stop Ctrl + Break

Reset Device
Connection

Right Click
"Devices"

Action Windows /

Linux

macOS

Flash items
on Layer

Right Click
Layer

Right Click
Layer

Select all
items on
layer

Shift+Click
Layer

Shift+Click
Layer

Action Windows /

Linux

macOS

Group Ctrl + G ⌘ + G

Ungroup Ctrl + U ⌘ + U

Flip Horizontal Ctrl + Shift +
H

⌘ + Shift
+ H

Flip Vertical Ctrl + Shift +
V

⌘ + Shift
+ V

Mirror Across
Line

Ctrl + Shift +
M

⌘ + Shift
+ M

Align Left Ctrl + Shift +
←

⌘ + Shift
+ ←

Align Right Ctrl + Shift +
→

⌘ + Shift
+ →
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EDIT WINDOW SPECIFIC

The following work only while focused on the edit window.

Tool In-use - Hot-Keys

NODE EDIT

Action Windows /

Linux

macOS

Align Top Ctrl + Shift +
↑

⌘ + Shift
+ ↑

Align Bottom Ctrl + Shift +
↓

⌘ + Shift
+ ↓

Align Centers
Vertically

Ctrl + Shift +
PgUp

⌘ + Shift
+ PgUp

Align Centers
Horizontally

Ctrl + Shift +
PgDn

⌘ + Shift
+ PgDn

Move H-Together Alt + Shift +
H

Alt + Shift
+ H

Move V-Together Alt + Shift +
V

Alt + Shift
+ V

Push forward in
draw order

PgUp PgUp

Push backward
in draw order

PgDn PgDn

Push to front Ctrl + PgUp ⌘ + PgUp

Push to back Ctrl + PgDn ⌘ + PgDn

Action Windows /

Linux

macOS

Rotate 5°
clockwise

Ctrl + Shift +
. (decimal)

⌘ + Shift +
. (decimal)

Rotate 5°
Counter-
clockwise

Ctrl + Shift +
, (comma)

⌘ + Shift +
, (comma)

Rotate 10
clockwise

Ctrl + .
(decimal)

⌘ + .
(decimal)

Rotate 10
Counter-
clockwise

Ctrl + ,
(comma)

⌘ + ,
(comma)

Rotate 90
clockwise

. (decimal) . (decimal)

Rotate 90
Counter-
clockwise

, (comma) , (comma)

Rotate 45
clockwise

Shift + > Shift + >

Rotate 45
Counter-
clockwise

Shift + < Shift + <

Two Point
Rotate Tool

Ctrl + 2 ⌘ + 2

Align Left L L

Align Right R R

Align Top T T

Action Windows /

Linux

macOS

Align Bottom B B

Align Centers
Vertically

C C

Align Centers
Horizontally

E E

Move Selection
to Page Center

P P

Action Windows /

Linux

macOS Notes

Smooth
corner
node

S S while
hovering
over a
node

Convert
line to
smooth
curve

S S while
hovering
over a line

Convert
curve to
line

L L while
hovering
over a
curve

Convert
smooth
node to
corner

C C while
hovering
over a
node

Delete
node

D D while
hovering
over a
node

Delete
line

D D while
hovering
over a line

Insert
node
point

I I while
hovering
over a line
or curve

Insert
node at
midpoint

M M while
hovering
over a line
or curve

Break
shape at
point

B B while
hovering
over a
point

Trim line T T while
hovering
over a line,
trim line
under
mouse at
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PRINT AND CUT

CAMERA

KEYPAD JOG

Note - Numlock must be enabled in Windows and

Linux to use Keypad jogging

Jog moves the laser in the jog increments set in the Move
tab. 

To activate keypad jog you must first click in the workspace
area and not have the text tool active. (Press Esc for the
selection tool for example)

HELP

Pressing F1 while hovering the mouse over the edit
window will bring you to the documentation page for the
editing mode you're in.

Pressing F1 while hovering the mouse over some tools will
show you help for that tool.

Otherwise, pressing F1 will bring up the Help & Notes

dialog window.

Printable Hot Key Guide

Click to Download

Action Windows /

Linux

macOS Notes

next
intersection

Extend
line

E E while
hovering
over a
point,
extend line
from point
under
mouse to
intersection
with
another
shape

Action Windows /

Linux

macOS

Start Wizard Alt + 0 Alt + 0

Set First Target
Position

Alt + 1 Alt + 1

Set Second
Target Position

Alt + 2 Alt + 2

Align Output to
Targets

Alt + 3 Alt + 3

Align Output to
Targets (no
scaling)

Alt + 4 Alt + 4

Action Windows /

Linux

macOS

Update
camera
overlay

Alt + C Alt + C

• 

• 

• 
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4.6 Advanced Topics

Primary Docs Advanced Primary Docs

4.6.1 Optimization Settings (Cut Planner)

The cut planner gives you a great deal of control over the
ordering of your cuts - you can let LightBurn try to choose
the best path for you, order it piece by piece yourself, or
somewhere in between. If you have "Order by Layer" as the
only entry in the list at the top (the default), it will behave
the way you're used to. After selecting your choices in the
Cut Planner, use the Preview (Alt-P) to see how your choices
have impacted things by using the slider at the bottom of
the window.

Access these settings by pressing the Optimization Settings
button shown here:

The settings are displayed in this dialog (and the defaults
are shown here):

Order By

You can select what the initial ordering parameters will be.
You have a choice of Layer, Groups or Priority. As well you
can use a combination of these three choices in any order
you wish.

Note that the order is important. If you order by layer, then
groups, the list of shapes will be split into lists by layer first,
then those lists will be sorted by group, and finally, the
remaining optimizations will be applied. If you order by
groups first, then by layers, the list of shapes will be first

split by root-level groups, then the shapes within each set
will ordered by layer, and so on. This is good for doing large
projects where you want an entire multi-layer item to
complete before moving on to the next, in case you have to
interrupt the project, or something goes wrong.

Each 'Order By' option produces a set of outputs that is then
fed into the next option (if any), and so on. Each resulting
set is then optimized with the additional options (like inner
shapes first, reduce travel moves, etc).

ORDER BY LAYER

If you choose Order By Layer, the cut planner will apply all
remaining optimizations to the first layer, then the second
layer, and so on.

ORDER BY GROUPS

If you choose Order By groups the cut planner will apply all
remaining optimizations to all the objects in a root-level
group, then the next Grouped object, and so on. Objects not
part of a group are treated as being in a group together.

ORDER BY PRIORITY

If you choose Order By Priority, the cut planner will apply all
remaining optimizations to the objects with the highest
priority (Assigned in the Shape Properties Window) first, then
the next lowest and so on.

Optimizations

These optimizations are applied to each cutting set of
outputs from the above ordering as a set.

CUT INNER SHAPES FIRST

As the name implies, if there is an object within another
object, and both are being cut, it will cut out the inside
object before the outside one.

CUT IN DIRECTION ORDER

This will try to cut the shapes in your project in the specified
direction - top to bottom, left to right, etc.

REDUCE TRAVEL MOVES

This will have the cut planner try to order the cuts in a way
that it will choose objects beside each other to try and
reduce non cutting travel moves.

REDUCE DIRECTION CHANGES

The cut planner will try to choose nearby cuts that allow it to
keep moving in the same direction, which keeps the laser
moving faster.

HIDE BACKLASH

This option is similar to the 'backlash repay optimize' setting
found in RDWorks - It produces a cutting order that reduces
or eliminates the misalignment between the start and end

4.6 Advanced Topics
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points of a cut caused by loose or flexing belts, or other
forms of play in the mechanical parts of the laser. Enabling
this option will force some of the other options to give it the
most flexibility when planning the cutting path.

CHOOSE BEST STARTING POINT

Allows the system to start a cut at any point within a shape,
not just the first point. Works best when "reduce travel
moves" is also enabled.

CHOOSE CORNERS, IF POSSIBLE

The cut planner will attempt to start a cut at a sharp corner
to minimize burning or staining on the surface of an item.

CHOOSE BEST DIRECTION

The cut planner will attempt to choose the best direction to
cut in.

REMOVE OVERLAPPING LINES

The cut planner will remove lines that overlap each other
that would cause the laser to cut in the same place twice.

LightBurn v1.3 and later

Starting in LightBurn 1.3, the cut planner will remove lines
that only partially overlap, and has a user-adjustable
distance setting for recognizing lines as overlapping.

Older versions

In older versions of LightBurn, the cut planner will remove
any line fully covered by another line, but will not remove
partial overlaps, like this:

(the lines are offset from each other slightly here to be able
to see them)

4.6.1 Optimization Settings (Cut Planner)
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Primary Docs Tools

4.6.2 Cut Shapes Tool

The Cut Shapes tool in LightBurn allows you to cut vector
shapes in a project using a closed shape as the cutting tool.
It is intended for cutting a project into smaller sections that
can be run separately, allowing you to create projects that
are larger than will fit within the area of your laser. Large
scale designs make heavy use of this feature. (1)

Cutting a single project larger than your laser: https://
www.youtube.com/watch?v=n__saOKVupA

To use the Cut Shapes tool, select the shapes you wish to
cut, then add the cutting tool shape to your selection (the
last shape selected is the cutting tool). In the Tools menu,
select 'Cut Shapes' and the software will perform the cut.

An example is shown below - the black oval is used as the
cutting shape, and the result is shown on the right,
separated so you can more easily see the cut line.

In this zoomed in view, near the lower-left you can see that
when the red shapes were cut, the software added a new
line, closing those shapes, but did not add anything when
the green lines were cut. This is because the red layer is set
to 'Fill', and in order for the resulting shapes to fill correctly,
they need to be closed. The green layer is set to 'Line' mode,
so those shapes are not closed when cut.

Key points to remember:

The last shape you select is used as the cutting tool

The shape used as the cutter must be a single closed
shape

The cutting tool shape is discarded - if you need it again,
make a duplicate of it (Ctrl+D)

Shapes that are cut will be closed if they are set to 'Fill', or
left open if they are set to 'Line'

1. 

• 

• 

• 

• 
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4.6.3 Print and Cut with LightBurn

"Print and Cut" normally refers to the ability to print a design
on a printer, then have it automatically cut it out with a
blade or laser cutting machine by using registration marks
on the print to align the cut to it.

Print and Cut in LightBurn is used to align your current
project to something you've previously output. The most
common use for this is, as above, printing a file with a
design on it and then using the laser to cut out the design,
but it can also be used to align multiple jobs on your laser.

You can use it to register two halves of a large job with each
other, for example, to cut something larger than your
machine. We have a tutorial that shows how to do this here: 
Cutting a single project larger than your laser

You can also use it to register multiple passes over the same
job - For example, you could use your laser to lightly
engrave an outline, remove it from the machine to paint it,
then put it back in the machine, align it using Print & Cut,
then engrave a different area in the same project.

Note: In order for the output to be positioned correctly on
your laser, you must use Absolute Coords as the positioning
mode, otherwise the output will not match the position of
the print.

Registering a printed file with a laser cut job:

As an example, take this design, printed on sticker paper:

I've imported the same design into LightBurn, with the cross-
hair markers, and added an outline to the dragon using the
offset tool:

The important part in this file is the two cross-hair marks -
these are the target marks that you will use to align the
cutting path with the printed sticker. They don't have to be
cross-hairs, but these are simplest to align with, as the 
center of the selected object is what is used for alignment
when recording positions. Each target marker must be a 
single object that can be selected - If you draw two lines to
make a crosshair, group them.

The red lines are set as cut vectors, with an appropriate
power and speed, and the black lines can either be set not
to output, or simply deleted.

After placing the printed version of the file in the laser,
follow these steps to align the laser output with the print.

Note: There is now a wizard for Print and Cut that will guide
you through the steps below. You can start the wizard by
clicking Laser Tools > Print and Cut > Start Wizard, shown
here:

You'll be presented with the Print and Cut wizard, shown
here:

4.6.3 Print and Cut with LightBurn
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Or, you can do the steps using the menu items instead.

Using the red-dot pointer of your laser, jog the laser head to
align with the center point of one of the two cross-hair
marks. You cannot move the laser head by hand for this -
you have to jog the laser either with the buttons on the laser
control panel, or in the Move window in LightBurn.

In LightBurn, select the same cross-hair mark, then go to
Laser Tools > Print and Cut > Set First Target Location, like
this:

Now, jog the laser to align the red dot pointer to the center
of the second marker.

In LightBurn, select that second cross-hair mark, and again
choose Tools > Print and Cut > Set Second Target Location:

You will notice that in the above image, the menu option for
'Set First Target Position' has the icon highlighted as well -
this means that the First Target Position is set and active.

After setting both targets, the menu will automatically
enable the 'Align Output to Targets' option for you, like this:

You will also see the "(Print & Cut mode)" message in the
status window, like this:

If you preview at this point, the orientation of the preview
should match that of the print on your laser:

In the above image, you can see the preview image is
rotated slightly clockwise, matching the orientation of the
printed image in the laser.

Note: In order for the output to be positioned correctly on
your laser, you must use Absolute Coords as the positioning
mode, otherwise the output will not match the position of
the print. The accuracy of the result will be affected by the
accuracy of your red-dot pointer, so using one that is either
a cross-hair beam pointer or a red-dot marker that is in the
same beam path as your laser is ideal.

After running the job on the laser, this is the result:

4.6.3 Print and Cut with LightBurn
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When finished, you can turn Print & Cut off by un-
highlighting the 'Align Output to Targets' option:

That will turn off the Print & Cut mode.

USING SHARP CORNERS IN YOUR FILE INSTEAD OF TARGETS

The Print & Cut feature measures the difference in position,
orientation, and scale between the two positions you mark
with your laser and the corresponding positions you select in
the software. You do not actually need to output the markers
in LightBurn, they simply need to exist so they can be
selected.

The sticker image shown above has a very sharp corner at
the tip of the tail, and one on the lower jaw - These would be
acceptable locations to use as alignment targets as well,
which would allow you to register to a job even without
visible registration marks:

By putting the markers on the green layer, then setting that
not to output, they're available in LightBurn to select, but
wouldn't be part of the actual cutting job sent to the laser.
When aligning to the first target, you'd point the red dot at
the tip of the tail, and in LightBurn select that marker. Then
repeat the process by pointing your red dot at the tip of the
lower jaw, and select the marker in that location in
LightBurn.

4.6.3 Print and Cut with LightBurn
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Gantry UI DSP Rotary

4.6.4 Rotary Setup (DSP)

This will walk you through setting up and using your rotary
attachment with LightBurn for gantry (non galvo) lasers. For
that overview, please see here.

In the top menu bar, click the Laser Tools menu (or just Tools
in older versions of LightBurn), then Rotary Setup, and it will
open the rotary setup window, shown here:

The window may look different depending on the type of
controller you have, and in fact, you may not be able to
access this menu item at all - most Trocen controllers, for
example, require setting rotary parameters through a menu
on the controller panel itself.

Info

Chuck Roller

4.6.4 Rotary Setup (DSP)
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General Rotary

Choose whether you have a chuck style or roller
attachment.

Click the enable rotary check box (it will turn green when
enabled).

In the steps per revolution box, enter the number of steps
it takes your attachment to make one full revolution. For a
chuck rotary, this will be one rotation of the chuck, and for
a roller, it will be one full rotation of the roller, NOT the
item. For GCode devices with a dedicated rotary axis, this
number should just be "360 degrees". If not using a
dedicated rotary axis, you'll have to use trial and error to
dial in the correct travel distance using the Test button.

Click the Test button to verify that the roller or chuck
makes one full rotation, pauses, then returns.

Enter either the diameter of the object to be engraved or
it's circumference, the other value will be automatically
calculated.

Align your object under the laser head in a position where
the X axis will start and rotate the object in the rotary
attachment to the point where you want the Y axis to start
engraving.

When using the rotary, it's generally a good idea to use
"current position" as the "Start From" setting.

Click Start to run your job, or if you have a DSP controller,
you can use Send to send it to the controller to run it from
there.

Remember to uncheck the use rotary attachment

check box once you are finished so that you do not
mess up your next regular project.

Notes

If the object slips on the rollers of a roller type
attachment, wrap the rollers with some sort of non-slip
material or even rubber bands.

You can also try placing some weights inside the object
such as ball bearings or other small round objects, this will
help press the object against the rollers.

If you end up with a flat part at the 'bottom' of the

engraving, it means your rotary gear mechanism has
backlash. In general, tightening any belts in the rotary
device will fix this, but if not, you can place a small line a
few mm below the bottom of your design, set to very low
power, like 0.1%, and set it as the first layer to run. The
rotary will spin to this position, then back up over that few
mm of gap, and will take up the backlash with that
movement.

DSP Specific Setup

If using a Ruida controller, disconnect the Y axis stepper
connection and connect the rotary attachment to the Y axis.
If using Smoothie or Grbl, C3D, or Smoothieware controllers,
click the "A" axis selection. (See below on how to configure
your controller steps before you proceed).

If you are using a DSP controller (Ruida, etc), when you
change the rotary setting you need to power-cycle the
controller, as some of the internal logic isn't adjusted for the
rotary setting unless you do this. Change the setting, close
the Rotary Setup window to write the change to the
controller, then power off the control board and power it
back on. You will likely need to press the Esc (or stop) button
on the controller to prevent it from trying to home itself, as
the Y axis will not home properly.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Note
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4.6.5 Scanning Offset Adjustment

Modern lasers are capable of moving very fast, and with
remarkable precision, however firing the beam still takes
time. Some power supplies and tubes may respond in
microseconds, but others take longer. At higher speeds,
belts will pull slightly as well, and all of these things can
cause the output of the laser to shift slightly when
engraving.

At 100 mm/second, 254 dots per inch means your dots are
0.1mm in length, fitting 1000 of them in 100mm. At 100
mm/sec, if your power supply and tube take 1 millisecond to
fire, your engraving will be offset by a full dot width.

At 500 mm/second, that 1 millisecond delay means you'll be
off by 5 dots, or 1/2 a millimeter. Still not very much, but
visible. Adding a bit of mechanical stretch to this will
increase the offset.

The result often looks like ghosted edges. The image below
is a 20mm square at 1000 mm/sec, with a 1ms delay,
resulting in a full mm of skew between scans:

LightBurn has a setting to counter this, called Scanning
Offset Adjustment, in the Device Settings. Other software
may refer to it as 'Reverse Interval' or 'Reverse
Compensation':

To use this feature, you need to measure the response of
your machine at a couple of different speeds. Create a small
rectangle in LightBurn, 50mm wide and 10mm high, set it to
scan, and set the interval to 0.5mm. If you are on a GCode
based device, enable overscan, and set it to 5% or greater
to be sure the machine is not slowing down before reaching
the ends. (Ruida devices overscan automatically). Note that
in the image below I have power set to 0 - Don't do this. You
will need to set the power high enough to mark your
material.

Run this rectangle at multiple speeds, like 100mm/sec,
200mm/sec, 300mm/sec, and so on. Depending on your
hardware you may not even need to use these settings,
however here is example output from a machine that does:

4.6.5 Scanning Offset Adjustment
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To compensate for this, measure the distance between the
ends of the lines at each speed, and enter the speed and
distance values into the scanning offset adjustment table.
LightBurn will use this information to compute the correct
adjustments for other speeds as well. A minimum of two
measurements are needed for it to work. Note you will need
enter half the measured value - The software moves each
line by the amount you specify, so each pair of lines only
needs to move half the distance.

There is an excellent tutorial online at Cartonus.com here:
http://cartonus.com/how-to-improve-engraving-quality-of-
laser-machine/

You may need to do this multiple times, making minor
adjustments to get clean results at each speed. After
entering the measurements for the above speeds, the
resulting corrected output looks like this:

4.6.6 Line Wobble

A different, but equally common problem, is line wobble,
often caused by too high an acceleration setting. When
doing the test cuts above, you may notice lines that look like
this:

4.6.6 Line Wobble
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If so, your machine is moving too quickly between the rows,
and you're seeing physical "bounce" in the gantry because
of it. Lowering the acceleration setting for your Y axis can
correct this.

4.6.6 Line Wobble
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Advanced DSP GRBL Galvo Tools

4.6.7 Using a Camera

This page is no longer in use, and should redirect you to the
updated camera guides. If that fails, please see the updated
guides here

4.6.7 Using a Camera
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4.6.8 Fusion 360 DXF Export

When designing laser cut projects in Autodesk's Fusion 360
the easiest file format to export is DXF. To make sure all the
design details we want are present, we'll make a special
sketch and export it to get it all into LightBurn.

Start file

Finish your part and save your file. 

New Sketch for export

Start new sketch

and select the top surface of the part

Project Features

When we select the top surface of the part you'll notice that
all the connected features highlight. These are automatically
projected and their outlines will automatically get added to
the sketch. 

We will need to add the eye of the dragon and the inner
features of the "g" and "B" from the part. To do this start the 
Project tool from the Create menu. 

Select the islands in the part and hit ok on the project menu
and Finish Sketch. 

4.6.8 Fusion 360 DXF Export
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Check the sketch

Once you finish the sketch it will be active so you can see
the contents. 

Turning off the rendered body enables you to ensure that all
of the design geometry is selected & ready to be used.

Save as DXF

To export the the sketch, Right Click on the sketch you
created in the model tree and click "Save as DXF"

Check Drawing in LightBurn

Open up LightBurn with a new file and Click Import.

This will bring the .DXF file into LightBurn and the contents
will be fully selected automatically. 

Tip

4.6.8 Fusion 360 DXF Export
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Checking for Errors or Duplicates

Occasionally you can create duplicate lines using the Project

tool in Fusion 360. To remove any stray or duplicate lines,
select the entire design, ungroup the drawing, and use the 
Delete Duplicates tool in the Edit Menu.

All Finished!

Your drawing is ready to use!

4.6.8 Fusion 360 DXF Export
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4.7 Camera

Advanced DSP GRBL Galvo Tools Camera

We've split the camera guide up into multiple pages. If you followed a link to a specific section of the older guide, you may need to go
to one of those additional pages.

4.7.1 Camera

You can use LightBurn's camera features to:

Position artwork on material/objects

Trace designs from the camera image

Monitor your laser

To use the camera, enable the Camera Control window by
going to the Window menu and selecting it. You'll see a
window like the one below, and you can select a camera
from the dropdown.

Screenshot of the camera control window.

Using a Camera

If you've already got a camera installed and calibrated, and
it shows a clear, undistorted view of your laser's bed when
you select it, you can use your camera to position designs
with the camera overlay and to trace artwork using the
camera.

Camera Setup

LightBurn only supports the use of UVC-compatible cameras.
Because of differences in how cameras work between
operating systems, some software cameras (such as OBS
Studio's "Virtual Camera") may not present as a camera at
all to LightBurn, or may render incorrectly. 

If you don't have a camera installed, or if your camera's
view is distorted, our guides can help you with selecting,
installing, and calibrating a camera.

Selecting a camera

Installing a camera

Calibrating a camera

Aligning a camera

Help! I can't find the camera info I'm looking for.

• 

• 

• 

Info

• 

• 

• 

• 
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Camera DSP GRBL Galvo Tools

4.7.2 Camera Selection

LightBurn's camera features require the use of a USB
camera. A wide range of cameras have been used
successfully, but if you don't currently have a camera and
want one known to work well with LightBurn, we sell several
different cameras along with a suitable mount. LightBurn
also includes calibration presets for these cameras, which
simplifies the setup process. You'll need to choose an
appropriate camera for your laser based on the size of your
laser and the height you'll mount the camera at. 

Aim to select a camera with a minimum mounting height

about 2" more than the distance from your intended mounting

point to the surface of the work area

If you're planning to buy one of LightBurn's cameras, we
have a built in tool to help you select an appropriate
camera. Open the "Help" menu in LightBurn and choose
"Camera Selection Help". LightBurn will use the laser size
shown at the top to create a list of the minimum mounting
heights for each of our cameras. Select a camera that needs

about 2" less than the distance from the laser bed to your
mounting location to leave a little room for adjustment.

LightBurn's camera selection tool, showing minimum mounting

heights for each camera given the size of the laser

Interactions between cameras and computers are,
unfortunately, a complex topic. LightBurn currently only
works with USB cameras, and only some cameras will work
correctly. Additionally, some computers may cause
complications with the use of cameras. In some cases
(especially with newer computers such as M1 Macs), this
comes from incompatibilities between USB 3.0 ports and
older USB 2.0 cameras.

Can I use a camera I already have?

4.7.2 Camera Selection
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4.7.3 Camera Installation and Focusing

The best place to mount the camera is directly above the
center of the bed of the laser, with the bed completely
visible. The best way to accomplish this is usually to mount
the camera on the inside of the lid, so the placement is
correct when the lid is open.

Diagram showing ideal placement

Camera installed in a laser

Mounting tips:

The camera should be focused as well as possible. Most
LightBurn cameras are manually focused by twisting the
lens.

The camera must be solidly mounted to be in exactly the
same position when using it. If you mount to the lid of
your laser, make sure the lid opens to the same place
every time. You can use a cord or rod to ensure the lid is
always at the same position when opened.

If your camera is in a mount, make sure it doesn't move
within the mount. A small piece of EVA foam or even
tissue can hold the camera securely in the mount.

Mount your camera so it isn't in the path of the laser
head, and run the cable so it is not in the path of the
beam. Ramming the laser head into your shiny new
camera is a great way to increase your blood pressure.

Focus the camera so as much of the bed is in focus as
possible. Some cameras, like the 5mp-60, have a narrow
focus depth, and if mounted high, can be tricky to focus. If
this happens, focus on a circle that is roughly half-way
from the center of the bed to the edge of the image, like
this:

If you can't get the entire area in focus, try to focus

approximately where the green circle is

The camera system depends on the camera being in the
same position relative to the work area of your laser and the
same distance from the top of the material. If your laser
uses a variable focus distance instead of a variable height 
work table, you will need to align for the material height you
are using.

Cameras used with LightBurn should plug in to your
computer as directly as possible. An active USB 2.0 amplifier
to extend the distance may work, but is not guaranteed. Do
not connect your USB camera to any USB port on your laser.
USB 2.0 has a native max length of approximately 16 feet.
(5 meters).

To use LightBurn's camera functionality, you must use 
Absolute Coords mode, so LightBurn can accurately position
the work. If you use an older Trocen controller, they do not
allow setting this mode from software, so you must change
the working mode through the controller menu.

• 

• 

• 

• 

• 

Warning

Info

Info
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4.7.4 Camera Calibration

Camera lenses are not perfectly flat, and distort the image
they capture. This effect is stronger on the fisheye lenses
needed to capture the viewing area of larger lasers. To use
your camera effectively, you'll need to calibrate the camera.
This takes a little effort, but once your camera is calibrated
well, it's not a process you'll need to repeat often.

If you're using an official LightBurn camera you can use one
of the presets instead of calibrating manually. Select the
preset using the dropdown on the first page of the 
Calibration Wizard.

Overview

In order to work properly, the calibration image must be:

undistorted

perfectly flat

surrounded by a 6mm (1/4") or larger margin

About 1/3 of the size of the camera's viewing area, when
viewed through the camera

Older versions of this guide gave a specific size for the
calibration image, but that will vary based on the size of
your work area and the height of your camera. You want the
image to take up about 1/3 of your camera view. You can
scale the image up or down when printing it, as well as
raising or lowering the image to adjust how much of the
camera view it takes up.

Download and print the following image: Calibration-
Circles.png.

If your laser has a honeycomb bed or other surface with a
lot of visible circles, you should cover it with something to
block that pattern.

Make sure the bed of your laser has good, consistent
lighting and the camera is in focus.

In the "Laser Tools" menu, open the "Camera Lens
Calibration" wizard. 

Mount the calibration image to something stiff and flat,
such as cardboard, foam board, wood, or a clipboard.

Follow the directions in the Camera Lens Calibration
wizard. For more help, continue below.

CAMERA LENS CALIBRATION WALKTHROUGH

This process only depends on the camera's lens, not on its
placement in your machine - as long as the camera and
calibration pattern are perfectly still, you do not need to
mount the camera in the machine to perform the lens
calibration.

Camera Lens Calibration walks you through capturing
multiple images of the calibration image you've printed out.
The software analyzes how the pattern appears in the
images, and compares that against its internal knowledge of
how the pattern should look. It determines the amount and
shape of distortion produced by the lens of the camera, and
computes a lens correction that is accurate for your camera.

After following the steps from the overview above, you
should be ready for the calibration process and looking at a
screen like this one:

Lens calibration window. The honeycomb bed in the

background will cause problems later if it isn't covered.

Choose your camera in the list, and you'll see the view from
the camera in the area to the left. With the correct camera
selected, click Next.

The view will change to include a capture button, and a
diagram to show you how to position the printed pattern. For
the first capture, place the pattern in the center of the field
of view of the camera, with the printed face of the card
pointed directly at the camera, as shown in the small view
up top. If you cannot easily match your capture image with
the suggested image, you may need to adjust the scale of
your printed card, or leave the camera out of the machine
for lens calibration.

Calibration Image Details

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Note on camera placement
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Preparing for the first image capture. I've covered the

honeycomb bed with sheets of newsprint.

Click the Capture button and you should see something like
this:

First capture complete. I've attached the calibration pattern to

a piece of cardboard to keep it flat and smooth.

Above the image on the right you see:

Image 1 (2592 x 1944) : Pattern found - Score: 0.31 - Not 

bad! Click Next

This tells you:

The image was successfully captured

The resolution of the captured image is 2592 x 1944
(higher is better)

The calibration pattern was found in this image

This image scored reasonably well - Lower scores are
better. In this image, after distortion removal, the
positions of the dots in the image align with the positions
of the real dots with an average error of only 0.31 pixels -
That's pretty good, and just barely outside our target
score of 0.3 pixels of error.

You may find that although the circles themselves are clear
and undistorted, the background around them is noticeably
worse. This is temporary and is the result of only having a

single calibration image to work with. As you continue, your
computer will collect more information about your camera's
lens distortion and the rest of the image will clear up.

If the calibration pattern is not found, LightBurn will tell you
so. Make sure the calibration image faces directly toward the
camera and occupies roughly the same amount of view area
shown in the "suggestion" image. It is okay if the calibration
image is rotated within the view if that makes it easier to
place.

Example of calibration image rotated within camera view

As you advance through the captures, the suggestion image
will update. The first five images are the center of view,
followed by bottom, left, right, then top. If your camera has
a very strong fisheye effect, it may be necessary for you to
move the non-center images inward a little to get a
successful capture. This is ok.

The final four images are the corners, and these can be
difficult to capture with high-distortion cameras. If your first
5 images score very well (below 0.3) you are allowed to skip
the final four images (the 'Next' button will shows as 'Skip' in
this case). If you are having trouble capturing the last four
images and don't have the option to skip, you can place the
card anywhere within the view and capture that instead - We
don't verify that your placement matches what we're
suggesting.

Even after only a few good captures, the image on the right
should appear to be free of lens distortion, as shown here:

A poorly calibrated result will still show lens distortion, and
may have other artifacts, like the "wobble" seen in the
lower-left of the gray image below:

• 

• 

• 

• 
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If you aren't getting good results, you can re-capture the
current image, or just go back to the beginning and try
again. It can take a few tries to get a feel for how to align
the card with the camera to get the lowest score.

When you have advanced through all the steps, and you are
satisfied that you have a good calibration result with a nicely
undistorted image, click Finish to save the results. You can
also click the "Align Camera" button in the final page to take
you to the next wizard automatically.

4.7.4 Camera Calibration
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4.7.5 Camera Alignment

Now that the camera is calibrated, you can move on to the
next step, camera alignment. This process tells LightBurn
where your camera is in relation to the workspace of your
machine.

Before you start, make sure the camera is firmly mounted in
the position it will be when using it. You can mount the
camera to a movable piece of your laser, like the lid, as long
as the position of the camera is the same when you use it as
it is when you go through the alignment process.

Preparation

Make sure your camera is securely mounted and correctly
positioned, as described above

Make sure you have a piece of material you can burn the
calibration pattern onto. This should be at least 200mm x
200mm (roughly 8" square), but you may want larger
materials for large lasers.

Focus your laser based on the material you're using.

In the "Tools" menu, choose "Calibrate Camera Alignment"
to start the alignment wizard. Choose the same camera
you did for the Lens Calibration wizard.

After verifying that you see an image from the camera,
click "Next" to enter the alignment wizard.

You should see something similar to this.

Cutting the Alignment Pattern

The rest of this process will be completed within the Camera
Alignment Wizard. This tool uses your laser to cut a target
pattern onto a piece of material, such as card stock, paper,
cardboard, or thin wood and asks you to indicate the center
of the targets.

Camera Alignment Wizard window

STEP 1

Place your material in the center of your workplace. The
material thickness setting can be ignored if you don't usually
use it.

STEP 2

Enter appropriate speed and power settings to get a
moderately dark mark without burning through. This will
vary based on your laser and the material you're using, so
we can't provide these for you.

On a large laser, it may help to scale the pattern up in this
step to increase accuracy. Make sure you use large enough
material. On a 900x600mm laser, I used a little over 200%
scale.

STEP 3

Frame the pattern to make sure it's positioned on the
material you're using.

STEP 4

Run the cut. If it's not dark enough, you can adjust the
settings and run it again. When the pattern is clearly visible
and easy to see, click "Next".

• 

• 

• 

• 

• 
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Your target pattern should look like something like this

Don't move the target marker image after cutting it! The
location within the laser is important to make sure the
process works correctly.

Capturing the Target Marker Image

From this screen, you'll capture the alignment image. Use
the jog or "send to corner" buttonsto move the laser out of
the view of the camera. When the camera has a clear view
of all four targets, click the Capture button. You should see
an undistorted version of the camera view appear in the
right side of the window, with all four corner targets visible,
as shown below:

Camera alignment capture window

Camera alignment capture completed. The image should be

clean and undistorted. If not, please use the lens calibration

wizard to calibrate the camera.

Click "Next" when complete

Marking the Targets

On this page you 'tag' each of the targets by double-clicking
in the center of each one in order. You can pan and zoom
around the image using the same controls as the LightBurn
edit and preview windows. When you double-click, a red '+'
mark will appear. Place a marker in the center of each of the
four targets, in the order they are numbered (1, 2, 3, 4). If
you place one incorrectly, you can double click near it to
shift it around, or click "Undo Last" to remove it and try
again.

Marking the targets.

Place each marker as accurately as you can. Zooming in can
help.

Warning

4.7.5 Camera Alignment
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Zooming in on the target

Here's an example of a correctly placed marker.

Marking the target

When you have placed all four markers in order, zoom back
out and verify that all four are visible and clearly centered
on the targets, like this:

Final placement of all four markers.

Click Next to finish the marker placement screen and click
Finish to complete the process and store the results. You're
done!

Now that everything is aligned, open the Camera Control
window again, and click "Update Overlay" or use Alt

+ C  to capture and project whatever happens to be in the
camera view onto your workspace, as shown:

Click the "Fade" button to dim the background image, or the
"Show" button to toggle it off and on.

⎇
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4.7.6 Using the Camera

You can use the camera in LightBurn to display an overlay in
the workspace, allowing placement of designs directly on
objects or oddly shaped materials. You can also trace
artwork from the camera.

To begin, you'll want to make sure the Camera Control

window is visible. It can be turned on from the Window

menu if not currently active.

The camera control window.

Camera Control Window

You can also right-click on the window to open the camera
selection tool, calibrate and align your camera, and import/
export your camera calibration and alignment settings. As of
version 1.4, you can import and export head-mounted
camera settings in addition to fixed cameras.

Tracing from the camera

Tracing an image using the camera works in the same way
as the regular image trace function, and you can find more
detail on the trace settings on that page.

To begin tracing, click the Trace button in the Camera

Control window. This will bring up a preview of what will be
traced.

Tracing artwork from the camera

Camera trace preview

It's likely that the artwork you're tracing won't take up the
camera's entire view. In the image above, you can see that
the edge of the paper and the honeycomb bed are both
being caught in the trace, when all I really want is the
LightBurn logo. You can draw a boundary around the artwork
you want to trace to tell LightBurn to ignore everything
outside that boundary.

Camera Select the appropriate camera

Update

Overlay

Capture a new image to use as the
camera overlay

Trace Open the camera trace dialog

Save

Settings

Save the Shift and Scale
adjustments

Fade Toggle whether or not the camera
overlay is dimmed

Show Toggle whether or not the camera
capture is visible as an overlay

Width/

Height

Scale settings for the camera
capture

X Shift/Y

Shift

Shift the camera capture

Preview A preview image of what the
camera sees
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Only the area inside the rectangle will be traced.

After pressing the OK button, the artwork is processed.

The traced logo is visible on top of the camera overlay

Using the Overlay

The camera overlay can make placing designs easier. When
using it, LightBurn will automatically switch the Start From

setting to Absolute Coords. This is necessary so the
artwork placement on the screen matches the output on the
laser. Also remember to update the overlay when you move
things around on the laser bed.

Using the camera overlay to place the traced logo on an object

Final result, showing the LightBurn logo engraved on a tag as

shown in the overlay
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4.8 Troubleshooting

Troubleshooting

4.8.1 Troubleshooting

This section will try to cover the most common problems
encountered with a few different types of machines, as well
as some common issues in LightBurn itself.

Choose the topic that most closely matches your issue:

Connection issues

Controller error (GRBL)

Controller error (Ruida / DSP)

Output to laser is wrong

Problem in LightBurn

• 

• 

• 

• 

• 
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4.8.2 Troubleshooting - Connection Issues

Can't connect to the laser

Make sure you have any necessary drivers installed for
your laser. If your machine came with its own software,
you might have to install that in order to get the driver for
your device.

A common driver for Chinese diode lasers is this one: 
https://sparks.gogo.co.nz/ch340.html

On Windows systems, a driver for Ruida and TopWisdom
controllers is available at the end of the LightBurn installer
- just check the box for the FTDI driver. (See Installation:
Windows)

If you use a Trocen controller, you might have to install
LaserCAD to get their driver.

Make sure you are physically connected to the laser, and
have chosen the correct type of laser or controller in
LightBurn, and the right connection method.

Some systems don't automatically connect - you might
have to choose the correct port the first time. (See 
Connecting to the Laser for details)

Losing connection

The most common reasons for connection loss with USB are:

Poor quality USB cables, lacking shielding or noise
suppression. If your laser came with a cable, try a
different one.

USB cable length - USB cables are limited to 16 feet. If
your cable is longer than this, it may need an amplifier or
active extension for the signal to remain strong enough to
be read correctly at the other end.

Another device on the same circuit as your laser, like a
mini-fridge, air compressor, water chiller, etc. Any of these
things powering up may cause a small power drop that
can make the laser 'brown out' and temporarily
disconnect or reset.

Poor bonding / grounding - Bonding is tying the various
metal parts of a device together, so that if one part builds
up a charge, all the other parts build up the same charge.
If your laser is not bonded, static can build up on the laser
head or rails. If the laser is not grounded (earthed), that
static build-up can eventually discharge through the USB
connection to the PC, causing comms errors. This is
especially common with lasers driven by belts that

interact with plastic wheels. Tying the frame parts of the
laser to each other, and a ground connection can
eliminate this.

USB port sleeping

If it thinks a connection is idle, Windows can put the port
into a power-save mode, which can make your device stop
talking to it. This is especially common with laptops.

If you are having issues where you often lose the USB
connection after a period of time, try the following:

Windows 7: https://pattersonsupport.custhelp.com/app/
answers/detail/a_id/14917/~/disable-power-management-on-
windows-7-machines 54

Windows 10: https://www.windowscentral.com/how-prevent-
windows-10-turning-usb-devices 202

Connecting to the wrong port

If you have multiple devices connected to your computer, it
is possible that LightBurn will see the other devices and
attempt to communicate with them. If this becomes a
problem, you can force LightBurn to ignore the extra ports
with a PortExclude.txt  file.

Go to File >> Open Prefs Folder to open LightBurn's
prefs directory

Create a file called PortExclude.txt

In that file, list the ports you want to exclude, exactly as
they show up in the port selection drop down in LightBurn.
Each port should be on its own line

Save the file, and LightBurn will ignore the ports you've
told it to filter out

Copy the name exactly as

shown in the dropdown

• 

• 

• 

• 

• 
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Troubleshooting

4.8.3 Troubleshooting - GRBL

GRBL has a number of different internal error codes that you
might see when using LightBurn. These are the most
common:

BUSY

If you are getting the 'Busy' bar in LightBurn, but the
machine does not move, make sure you are actually
connected to the controller. You may need to select a
communication port (see connecting to the laser) and if you
can't choose a port, it's possible that you need to install the
drivers or software that came with your machine before your
computer can talk to it (see connection issues).

MACHINE IS BUSY OR PAUSED

If you are seeing this error, most likely you have not actually
connected to the machine yet. Make sure you have installed
any drivers required by your hardware, and make sure you
have chosen a communication port to connect to. When
connected, the console should contain messages sent from
the controller. If you are not connected, look in the laser
window where the mouse pointer is shown below:

If you click where it says "(Choose)" and the list does not
contain any names, or you have tried them all, you might
need a driver for your controller to connect to the computer.
A common one for Chinese diode engravers is this one: 
https://sparks.gogo.co.nz/ch340.html

ALARM:2

You are trying to send the machine outside of its known
working area, and GRBL has prevented this in order to
prevent damage to the machine. This can happen for several
reasons:

You are actually trying to run a job that exceeds the size
of the machine work area.

You are trying to run a job in 'Current Position' or 'User
Origin' mode and haven't properly set the Job Origin or
User Origin settings. Read here: Coordinates and Job
Origin

You have your machine misconfigured, possibly trying to
run a negative workspace machine without a workspace
offset: Common GRBL Setups

ERROR:5

This means that LightBurn sent the command to the
controller to home it, but the controller does not have
homing enabled or configured. The most likely reason for
this is that the machine does not have homing switches, and
you turned on 'Auto-home on startup' in the device settings.

• 

• 

• 
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4.8.4 Troubleshooting - Ruida errors

The following are the most common errors encountered with
Ruida controllers.

NOT ENOUGH EXTEND SPACE

Your artwork is too close to the side of the machine for the
speed you are running it at - the machine does not have
enough room off the sides of the design to speed up / slow
down. Move the design inward, away from the sides, or go
slower.

FRAME SLOP OVER

The design itself is crossing one or more of the machine
sides. You can continue, but the controller will not draw
the part of the design that is out of bounds.

WATER PROTECT

You have water protection enabled, and the controller is
not seeing a signal from the water protection sensor. This

usually means water is not flowing through the tube, but
can also mean the sensor is faulty, or the wiring is
incorrect.

MACHINE PROTECTED

You have 'door sensor' protection enabled, and the
controller is not sensing the door switch is closed. This
usually means the machine lid is open, but can also mean
the door switch or wiring are faulty.

MACHINE IS BUSY OR PAUSED

This can happen for a number of reasons, all stemming
from a lack of communication between the controller and
the software. LightBurn will show this error if it the laser is
currently busy and not accepting commands, or in some
cases if it wasn't able to communicate with the laser at all.
Check that there is not an error displayed on the controller
screen, and that LightBurn is actually connected to the
controller. You can verify (or reset) the connection by
right-clicking the 'Devices' button. You should see 'Found
RDC644xG' (or whatever type of controller you have) in
the center of the status bar below the main window.

• 

• 

• 

• 

• 
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4.8.5 Troubleshooting - Output Issues

OUTPUT IS MIRRORED OR BACKWARDS

The 'Device Origin' setting, found in the menus under Edit
=> Device Settings, controls the orientation of what gets
sent to your laser. If you have the origin for the device set
incorrectly, your output will be mirrored or upside down
when run.

For DSP controllers (Ruida / Trocen / TopWisdom / etc) the
Origin setting for the device should match the corner that
your laser homes to when first powered.

For GCode controllers (GRBL, Smoothieware, etc) the
Origin is almost always front-left, but in rare cases may
not be.

POWER OUTPUT IS NOT THE SAME AS OTHER SOFTWARE (GRBL)

If you have a GRBL device, there are two possible causes for
this:

You're using 'Variable Power' mode (M4), and asking your
machine to travel faster than it is able to. This is the most
common problem we see, especially when comparing
LaserGRBL output with LightBurn. LightBurn uses 'variable
power' mode by default (M4), where LaserGRBL uses
'constant power' mode (M3).

With variable mode, when the laser is stopped, the power
level is zero. As the laser head accelerates toward the speed
you request, the power level is increased as well. In this
way, the output burn is much more consistent. However, if
you ask the laser to go faster than it actually can, it will
never reach the requested speed, and never reach the
requested power level either.

The correct solution is to simply use a speed within the
allowed speed range of your machine, or, if you want the
same behavior as LaserGRBL, click the 'Constant Power'
toggle switch in the layer settings of LightBurn:

The 'S-value max' setting in LightBurn could be incorrect -
this number tells LightBurn which 'S' value corresponds to
maximum output for your machine, normally set in the
$30 firmware setting. Current versions of GRBL default to

1000 for this setting, while older versions use 255. The
number itself doesn't matter much, but the controller
setting and LightBurn have to agree. If your controller
expects "1000" to mean full power, and LightBurn sends
"255", you'll get roughly 1/4 the output power you expect.

OUTPUT IS SHAKY OR WOBBLY

OUTPUT IS SLANTED OR SKEWED

EDGES OF ENGRAVINGS ARE BURNT OR TOO DARK

On GCode devices, enable 'Overscanning' in your Fill or
Image layer setting. If you already have this enabled, you
might need a larger value for the overscan setting,
particularly if your acceleration is low.

EDGES OF ENGRAVINGS ARE FUZZY OR BLURRY

First, make sure that your X-axis drive belt is tensioned
correctly. If it is loose, you'll see blurred or fuzzy sides when
engraving, as well as 'bent' or inaccurate shapes when
cutting. If the belt is properly tensioned, you likely need to
add scanning offsets.

CORNERS ARE NOT CUTTING OR MARKING

When using a DSP controller, the Min Power setting is also
sometimes referred to as 'Corner Power', because it sets the
power level of the laser when the machine is moving slowly,
like when cutting a sharp corner. if your Min Power value is
too low, when the laser slows for corners the power value
might fall below the firing threshold of your laser. This will
leave gaps in the output at the corners, and at the points
where cuts start and stop. Increase the Min Power value.

CORNERS ARE BURNT OR TOO DARK

Similar to the above, if the Min Power setting is too high, the
power value may not be reduced enough when the laser
slows for corners, and can leave burn marks at corner points
or the start / stop points of the design. If this is happening,
reduce the Min Power setting.

LASER IS LOSING POWER / NOT CUTTING AT LOW SPEEDS

On DSP controllers, If you are running a cut at very low
speed, set your Min Power and Max Power values to match.

There is a setting in the Machine Settings, called 'Start
Speed', that specifies the value where the controller begins
ramping the power from Min to Max power. If the laser is
moving at this speed or slower, only Min Power is used. This
setting is 10mm/sec by default on Ruida controllers, but
some machines may have it set as high as 15 to 20 mm/sec,
or may have it set lower.

• 

• 

• 

• 

• 
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Troubleshooting

4.8.6 Troubleshooting - LightBurn

Click the link below that most closely matches your problem:

Cut might be out of bounds error?

Trouble working with shapes in LightBurn?

Trouble with imports or exports?

Trouble with cutting / engraving settings?

Cut might be out of bounds error

If you get a pop-up that your cut might be out of bounds,
there are a few common causes:

You're using a 'Start From' setting like 'User Origin' or
'Current Position', but don't understand how those work,
or haven't chosen an appropriate job origin setting. Try
using 'Absolute Coords', and read here to understand how
the different modes work: Coordinates and Job Origin

Your artwork exceeds one or more of the boundaries of
your laser - make sure the art fits, and that if you have
Overscanning or Kerf offset enabled, there's room for the
overscan / kerf moves

On GCode devices, it's possible to have a 'workspace
offset' programmed into the controller. This could be
confusing LightBurn into thinking that the laser position is
out of bounds, even though it's not. See Common Grbl
Setups

• 

• 

• 

• 

• 

• 

• 
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Troubleshooting

4.8.7 Troubleshooting - LightBurn Editor

WELD NOT WORKING:

If you are trying to Weld text inside a ring, and the text
disappears, use 'Boolean Union' or 'Boolean Subtract'
instead. Read the docs and watch the video for Booleans
here: Boolean Tools

SHAPES DISAPPEAR WHEN FILLED:

Most likely the shapes are duplicated, sitting right on top of
each other. Try Edit > Delete Duplicate Shapes and try
again, or manually edit to remove the duplicates. We have a
FAQ entry on our forum for this here: https://
forum.lightburnsoftware.com/t/why-do-things-disappear-
when-i-fill-them-but-not-when-i-cut-them/1342

OPEN SHAPES SET TO FILL:

If you're getting this error, it means you have shapes that
you are trying to fill that are not closed loops. Most likely
your shape is a group of disconnected lines, not a single
closed loop. Try un-grouping your shapes, then click 'Edit >
Auto Join' (Alt+J)

NEGATE A VECTOR SHAPE:

If you're trying to negate (invert) a vector shape, you need
to put a boundary around it in the same color as the shape
itself, or remove a boundary from around it. We have a FAQ
entry on our forum that describes this here: https://
forum.lightburnsoftware.com/t/how-do-i-invert-negate-a-
vector-engraving/594
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4.9 Machine Guides

Machine Guides Ruida Thunder Laser

4.9.1 Connecting via Ethernet to Ruida

Controllers

To avoid using long USB cables, you may want to send jobs
to the Ruida controller in your laser via Ethernet networking.
This is a guide on how to do so.

This section is new, and is a work in progress. Be sure to let
us know on the forums or via support if we need to change
something. Thank you!

Networking

Ruida controllers operate over IPv4, or Internet Protocol
Version 4, which consists of unique external and unique
"local" addresses within a network. Ruida controllers need a
"static" IP, or one that's unchanging. More modern
networking involves DHCP, where addresses are "loaned"
temporarily to devices, like laptops and phones. 

In Windows, if you open the command prompt ("cmd" in the
start menu or in the Win+R "Run" box) and type "ipconfig",
it'll look something like this.

CHOOSING AN IP

Look for the line in ipconfig  giving your IP address 
IPv4 . . . 192.168.1.225

Remove the last section 192.168.1.225

Replace it with a number between 230 and 250 192.168.1.
235

This will probably be safe to use on a home network, but it
isn't guaranteed. See links to the left for help.

Unfortunately, choosing a static IP address can be a little
tricky. Home networks are usually small and pretty simple,
so the steps in the blue box to the right will usually be
enough to help you choose an unused IP address. If you run
into problems with the first number you try, it may be worth
trying one or two others to see if there's a conflict.

In more complex network situations, such as a school or
shop network, we recommend working with your IT/

networking team to select an IP address and ensure that you
don't cause problems for your network infrastructure.

More in-depth networking information can be found at
sources like Google Support, Simple Wikipedia's explanation,
or other technical resources like Cisco or Meraki's websites.
This is a complex topic with a wide range of possibile setups,
so we are unable to cover every situation.

ON CONTROLLER

Some Ruida controllers have different menuing and button
configurations. This is a guideline, not a hard and fast rule.

On the Ruida controller, use the Z/U or Menu buttons to
enter the menu, navigate to "IP config+" , and press enter to
access that menu setting. On the right side of the screen,
the IP address field and gateway will be visible. Use the left/
right arrows to move through the octets (sections), and the
up/down arrows to change the value. Press and hold the up/
down arrows to quickly change the value.

When done, press the "Enter" button.

In LightBurn

Ruida controllers accessed over a network are their own
type of connection for a device, so in the "Devices" menu,
click "Create Manually". 

Attention

IP Address Example For Home Networks

1. 

2. 

3. 

Note
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Select the Ruida controller from the list of compatible
controllers.

Select "Ethernet/UDP" as the communication method.

In the event this communication method proves unreliable,
you may want to consider using a LightBurn Bridge,
especially if you're using macOS. Bridge provides a much
more stable network connection than the Ruida controller's
UDP connection.

Enter the IP that was assigned or arrived at for use given the
information above.

Steps below this point are likely to mirror the setup of any
prior USB connections set up for the same hardware. 

Enter the size of your laser's bed and name the device as it'll
show up in your menus.

Enter the origin (0,0) position of your machine.

Warning

Note
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And you're ready to go, assuming all is good!

Verifying

In LightBurn, the status bar on the bottom of the main
window will show connection status to the device. In the
event LightBurn cannot find your laser, it's likely to show like
below.

In the event your networking is spotty, you can right-click
the "Devices" button to re-connect to any laser; not just your
Ruida controller.

Source

This guide was originally made for our Forums on October
20th, 2019. You can find the original guide here.
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Machine Guides Trocen

4.9.2 Connecting via Ethernet to Trocen

Controllers

To avoid using long USB cables, you may want to send jobs
to the Trocen controller in your laser via Ethernet
networking. This is a guide on how to do so.

This section is new, and is a work in progress. Be sure to let
us know on the forums or via support if we need to change
something. Thank you!

Networking

Trocen controllers operate over IPv4, or Internet Protocol
Version 4, which consists of unique external and unique
"local" addresses within a network. Trocen controllers need a
"static" IP, or one that's unchanging. More modern
networking involves DHCP, where addresses are "loaned"
temporarily to devices, like laptops and phones. 

In Windows, if you open the command prompt ("cmd" in the
start menu or in the Win+R "Run" box) and type "ipconfig",
it'll look something like this.

CHOOSING AN IP

Look for the line in ipconfig  giving your IP address 
IPv4 . . . 192.168.1.225

Remove the last section 192.168.1.225

Replace it with a number between 230 and 250 192.168.1.
235

This will probably be safe to use on a home network, but it
isn't guaranteed. See links to the left for help.

Unfortunately, choosing a static IP address can be a little
tricky. Home networks are usually small and pretty simple,
so the steps in the blue box to the right will usually be
enough to help you choose an unused IP address. If you run
into problems with the first number you try, it may be worth
trying one or two others to see if there's a conflict.

In more complex network situations, such as a school or
shop network, we recommend working with your IT/
networking team to select an IP address and ensure that you
don't cause problems for your network infrastructure.

More in-depth networking information can be found at
sources like Google Support, Simple Wikipedia's explanation,
or other technical resources like Cisco or Meraki's websites.
This is a complex topic with a wide range of possibile setups,
so we are unable to cover every situation.

ON CONTROLLER

Some Trocen controllers have different menuing and button
configurations. This is a guideline, not a hard and fast rule.

On the Trocen controller, use the Menu button to enter the
menu, navigate to "Network Settings , and press enter / the
mouse pointer button to access that menu setting. 

Each octet of the IP will be editable, enter the menu, exit
that subsection, and continue to enter your IP for the laser.

When done, exit the menu.

Attention

IP Address Example For Home Networks

1. 

2. 

3. 

Note
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In LightBurn

Trocen controllers accessed over a network are their own
type of connection for a device, so in the "Devices" menu,
click "Create Manually". 

Select the Trocen controller from the list of compatible
controllers.

Select "Ethernet/UDP" as the communication method.

Enter the IP that was assigned or arrived at for use given the
information above.

Steps below this point are likely to mirror the setup of any
prior USB connections set up for the same hardware. 

Enter the size of your laser's bed and name the device as it'll
show up in your menus.

Enter the origin (0,0) position of your machine.

Note
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And you're ready to go, assuming all is good!

Verifying

In LightBurn, the status bar on the bottom of the main
window will show connection status to the device. In the
event LightBurn cannot find your laser, it's likely to show like
below.

In the event your networking is spotty, you can right-click
the "Devices" button to re-connect to any laser; not just your
Trocen controller.

Source

This guide was originally made for our Forums on October
20th, 2019. You can find the original guide here.
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4.9.3 Adding Limit Switches to Sculpfun S9 Diode

Lasers

This guide shows the steps to install limit switches on a
Sculpfun S9 diode laser using off the shelf components, and
some laser cut parts. This enables reliable, consistent
alignment within the engraving or cutting area with less
work for the operator. This guide will be applicable to other
diode lasers (such as an AtomStack), especially those using
a MKS DLC 2.0 control board and similar.

This enables the use of LightBurn features on these
machines, including:

Print and Cut

Center Finder Tool

Using A Camera

This guide assumes electrical and mechanical know-how to
safely install and enable these features. Please take care to
avoid damaging the machine and those around it, including
you! 

Proceed with caution!

What You'll Need

Some of the materials you'd need (but not neccesarily all)
include:

A compatible diode laser

3 Pin Limit Switches

servo extension cables

If your cables don't comfortably reach, you may need to
purchase or assemble an extension cable yourself. 

Brackets to hold limit switches to your frame (one per limit
switch on your frame)

LBRN File for Laser Cutting (cut from 3mm wood or
acrylic)

STL File for 3D Printing

M3 2020 T-nuts

M3 Screws

M3 Hex Driver

2020 Extrusion Cover

Scissors (to cut said extrusion cover)

Zip Ties (to fasten the limit switch cables)

If you'd like to create custom cables rather than use a servo
extension cable, here are the ones we used.

Engineer PA-09 Crimper

Wire

JST Connectors

LIMIT SWITCHES

Limit switches are small, electro-mechanical devices that
when depressed, create a pathway for a signal to pass
through. We can use them to tell the laser's controller that
we've reached the end of their motion.

In this guide, we'll be using a 3 wire style limit switch,
mounted to a printed circuit board to make installing it on
your machine easier. 

LIMIT SWITCH CABLING

These cables are responsible for passing the signal back to
your laser, and through checks are required to connect them
correctly. If the cable is too short, it can damage the
connector, damage your diode laser, or other components.

Before Disassembly

If you intend to use the laser cut brackets for the limit
switches, you'll want to cut those before disassembling your
laser for installation. 

CUTTING OUT BRACKETS

Same as with standard use of your laser, you'll want to focus
the head relative to the cutting material, in our case, some
thin 3mm wood.

• 

• 

• 

Danger

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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DOCUMENT SETUP

Use the LightBurn preview window to ensure that your
document as set up looks good. The default settings for the
S9 should be adequate. We used:

You may want to use the "Square Frame" command within
LightBurn to ensure the material you're engraving has the
sufficient area to cut out the brackets. 

Mechanical Installation

To install the limit switches, you'll need to insert an M3 2020
t-nut into the frame sideways, and then rotate it 90° in the
frame slot to align correctly for retention. You may need
other tools to insert & rotate them appropriately; we found
that a small flat-bladed screwdriver may be helpful.

When mounting the limit switch, place the cut or printed
spacer underneath the limit switch board, and oriented it
such that the "arm" of the limit switch faces the head of the
laser. 

Here we use a M3 x 8mm screw to fasten the board to the
frame.

This process should be repeated such that a limit switch is
positioned for both the X and Y axes of the machine.

Wiring

Our limit switches are labeled as having three pins for use:

G - Ground

V - Voltage

S - Signal

This labeling also applies to the printed circuit board that
has the control electronics of the laser. Be sure to match
each axis' limit switch to the correct connector and direction,
for X or Y axis as is correct. 

Notes on Extensions

The cables we're using, while they technically fit, aren't
what's intended on these connectors. We suggest you use a
crimper and make a custom cable, but we understand this
isn't possible for everyone and opted to include this as a
more accessible option.

250mm/m

100% Power Max (%)

Pass Count: 2

• 

• 

• 
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The preferred way would have the user crimp JST
connections on a single length of cable per axis and make it
exactly to length, but we recognize this isn't always an
option. 

Please be aware that use of "PWM" style connectors in a JST
housing permits the inversion of the connection, potentially
damaging your laser. Ensure the pins are connected with the
correct labels (i.e. ground to ground, signal to signal, etc.)
before turning on your laser on.

When continuing to hook up the wiring, you'll likely want to
route the extensions or connections through the pre-existing
hole in the housing, or through the vent holes on the side.
This ensures you can re-close the housing and protect your
electronics.

Next you'll need to test the machine while opened up. This
allows you to resolve those issues you might encounter
more easily. Carefully reconnect power and USB to the
device, and turn it back on.

The diode laser won't immediately understand how to use
the limit switches, and as such, we'll need to do software
configuration within LightBurn.

Software

The first major check is to ensure that upon re-powering the
device, LightBurn can still see your laser; confirm this
through the Console dock. If so, you'll need to use the
following codes to enable limit switch homing.

Danger
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Be ready to power off the machine in the event it does
something unintended and dangerous.

This GRBL command enables limit-switch based homing. To
test your homing behavior, click the "Home" button in
LightBurn in the "Laser" window.

If your device attempts to home in the wrong direction, you
may need to change the "homing location" via more GRBL
commands.

For ours, we needed to do $23=3  to chose the near, left side
as our 'home' location. If your device has the limit switches
in another location, you'll want to reference this guide as to
what the different values mean with respect to limit switch
"bitmasks".

HOMING SPEED

By default, our device was rather slow during the homing
process, and we changed the following to allow it to home
more quickly.

The final configuration information needed are for the
workspace offset, which we can find by looking in the
"Move" window when clicking "Get Position".

Taking these values, go back to the "Console" tab and enter
the following GCode command:

These values directly use the data observed just prior, with
the L2 P1 portion indicating to the device the specific offset
mode (corrent workspace offsets to the specified values) and
P1 to the "tool number" (value of 1, the first and only
present on this machine).

We'll also need to tell the machine's status reporting to be
relative to the workspace origin, and we can do that with:

STOCK FIRMWARE WARNING

Many devices don't actually have GRBL firmware that by
default stores these values in the memory of the laser's
controller. As such, rebooting would wipe these values out,
reverting the work you've done.

The correct fix would be to re-flash the firmware, of which
we'll have a guide for soon. However, in the interim you can
use the "Macros" button under the "Console" window.

By right-clicking the button, we can re-name it, and combine
all of our commands together for use, which might look
something like this:

$22=1

Danger

$25=8000 (homing speed)

$24=100 (re-seek speed)

G10 L2 P1 X-409 Y-399

$10=0
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If you'd like to copy this behavior and simply use it as-is, still
verify your G10  command has the correct offsets.

Reassembly

Once we've confirmed that this configuration works
correctly, we can begin to reassemble our housing and more
permanently install the wires for the limit switches. Turn the
machine off to do so, to avoid any errant connections of the
case to the electronics resulting in a short.

You can use 2020 extrusion covers cut to size to protect and
hide the wires inside the grooves of the extrusion frame, and
zip-tie the limit switch cable for the gantry to the pre-
existing cable to the diode head itself.

$22=1

$23=3

$25=8000

$24=100

G10 L2 P1 X-409 Y-399

$10=0
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Machine Guides Sculpfun S9

4.9.4 Flashing Guide

If your Sculpfun S9 (or similar laser) doesn't have the ability
to permanently save changes made to the firmware, you
may need to re-flash the microcontroller inside of it. This lets
the brain running the diode use newer features of GRBL (the
software controlling your laser inside it's electronics)
effectively, and helps you avoid the possibility of forgetting
to click the homing button.

Prerequisites

While this guide requires no additional physical components,
several downloads are needed.

Arduino IDE

GRBL (with tweaks to disable Z axis)

This guide was written for older versions of the Arduino IDE
released before 2.0. Major changes were made when that
version was released, and as such, this guide may not work
with them. Please revert to use these steps, or find a newer
guide to update your laser. Thank you!

To successfully flash your laser, high attention to detail is
needed. Flashing your firmware incorrectly can damage your
machine. Read the whole guide, start to finish, before trying
to flash your machine.

Prep

Plug in your laser's power and USB, connect it to your
computer, and open LightBurn.

In LightBurn, use the macro created in the Limit Switch
Guide to apply the needed limit switch firmware changes,
and afterwards use the Edit -> Machine Settings dialog. In
this window, you'll want to click "Save to file". This allows
you to save a backup of the laser's configuration that's know
to work before we flash firmware and reset all of those
settings.

BACKUP VIA CONSOLE

Using the Console, you can enter "$$" to get the GRBL
values of the machine to supplement those from the
Machine Settings window. This gives you a further
verification step to make sure the laser's behavior is as
intended after flashing. Copy those to a text editor like
Notepad or TextEdit and save for safekeeping.

At this point, please close LightBurn. Not doing so will cause
flashing errors later in this process.

Arduino IDE

To flash a newer version of GRBL to your laser, you'll need to
download Arduino IDE. As a toolkit to enable microcontroller
development in a friendly bundle, it allows you to make any
changes we might need to make, connect to the laser, and
send the new version of GRBL to your device.

You'l need to install Arduino IDE through the appropriate
installer for your system, but the specifics will vary
computer to computer.

GRBL

To actually have something to flash to the laser, you'll need
GRBL. An off-the-shelf version of GRBL however, assumes

• 

• 

Info

Warning

Attention
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we have three axes, not two. As a result, when it goes to
home the "Z" axis, it never proceeds to the next step as it
physically cannot trigger a limit switch that doesn't exist.

To make this step easier, we already made the necessary
modifications to the last current (1.1h) GRBL version for you,
disabling the third axis. Download the file linked and extract
it.

Setting Up Arduino IDE

In Arduino IDE, we'll need to open the Sketch Menu, click
"Include Library", and then "Add .ZIP Library". This allows us
to tell The Arduino IDE that the code you've downloaded is
something you need it to use.

Make sure that "Makefile", "COPYING" and "README.md" are
visible in the folder you select; the folder inside of that one
labeled grbl is not the correct folder for Arduino IDE to
recognize it. 

In other words, select the grbl folder in the root of the ZIP
you extracted.

You'll then need to go back to the menu by going to Sketch,
Include Library and ensure that "grbl" is listed under
"Contributed Libraries".

To get ready to flash your board, open the "File" menu,
Examples, "grbl" and "grblUpload". It will open a new
window containing the sketch mostly ready to go. You'll need
to select your board and port still, and tell Arduino how and
where to upload the new firmware.

PORT & BOARD CONFIGURATION

We're working with a board resembling the MKS DLC 2.0,
running an Atmel 328p. To the Arduino IDE, this is an
Arduino Uno, as that's the chip the Uno is based on. Under
Tools, Board, select "Arduino Uno" near the top of the list.

You'll also need to select the correct port to send the
firmware on, so open Tools, Port, and take note of the ports
listed. 

Connect your laser via USB and check the Ports menu again
to look for any new devices. Unplug and replug your laser
once more to confirm the port the laser is on, and select it.

Flashing

Use the checkmark  at the top left to verify that you've
set the project up correctly, and note on the bottom of the
screen above the black terminal area says "Done compiling."
when you do so. If it does, we're ready to upload!

Click the arrow button  to the right of the checkmark,
and it'll begin to flash to your laser! When "Done uploading."
is shown, you can continue!

Warning
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If there's an error shown that it can't access the port in
some way, make sure that you closed LightBurn. Only one
device can "have control" of certain peripherals, and
Arduino IDE needs full control of that device for a moment to
send the new firmware.

Restoring Settings

In LightBurn, open the Machine Settings menu again, and
click "Load from file", selecting the "lbset" or "LightBurn
Settings" file we'd made at the start of the guide. At this
point, click "Write" to apply these settings to our machine's
firmware. This transfers the configuration back to the
machine, and writes them to EEPROM, or programmable
memory. This means our homing behavior will be consistent
through machine reboots.

When this has finished, the window will show "controller
settings written successfully".

Verifying

In the console, enter 

Once more and verify that the settings match that of the
macro made originally, and/or the backup file we made
when backing up via Console. 

Finished!

If these settings hold, you'll be able to click the "Home"
button in LightBurn and have it home automatically, without
any additional use of macros.

Note

$$
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5. Galvo Docs

Galvo LightBurn 1.2

5.1 LightBurn & Galvos

If this is your first time using LightBurn, you'll definitely want to take a look at the user interface guide first and maybe some 
hotkeys first before diving in.

5.1.1 Getting Started

Glossary

Galvo Installation - This is Windows-only and covers the
driver changes needed to control your galvo laser. If
you're not using Windows, you can skip ahead to Galvo
Setup

Galvo Setup (importing configs, getting them from your
manufacturer)

Lens Correction (Bulge, Skew, Trapezoid, Stretch)

Framing Mode

Focusing

Cylinder Correction

Galvo Settings

Sub-Layers

Rotaries

5.1.2 Intermediate Mechanics

Changing A Lens

3D Sliced Engravings

Anatomy of a Galvo

5.1.3 Involved Topics & Diagnostics

Laser Timings (for dealing with the physical limitations of
galvo heads)

IO Port Control (external event triggering)

5.1.4 Galvo Crash Course from Laser Everything

Our friends at Laser Everything have put together some
fantastic videos on using LightBurn for Galvo. We encourage
you to check out their YouTube Channel for additional
resources.

5.1.5 Frequently Asked Questions

Can I import an EZCAD project/parameter/file?

LightBurn as of 1.2.00, does not have the ability to import or
open EZCAD project files or parameters. Due to the file
format not being documented, and the sheer volume of
effort to produce a useful, cohesive importer, it simply isn't
possible at the moment. The exception to this is lens
correction files, as outlined here.

LightBurn on Linux doesn't recognize fiber laser

plugged in with USB

This is an issue we haven't generally encountered in our own
testing in Ubuntu and Fedora, the two distros we support.
The laser is treated as a libusb device and should just work.
However, this is occasionally an issue with USB permissions.
Please try the following, as discussed on our forum.

Unplug your laser from the computer.

Run sudo gedit /etc/udev/rules.d/usb.rules  (you can use
any text editor you prefer) and enter the following
contents:

SUBSYSTEM=="usb", MODE="0666"

Save the file and close.

Run: sudo udevadm control --reload-rules

Now plug your galvo USB connection back into the
machine.

Run LightBurn without sudo and you should be able to
automatically find and connect to the device.

Where are the hatch settings?

Hatch in EZCAD is the equivalent of "Fill" in LightBurn;
looking at the different modes for Cut Settings Editor is
highly suggested to make the best use of LightBurn with
your galvo. We also have a page comparing EZCAD hatch
settings with LightBurn fill settings to help you match the
settings you're used to.

It won't connect to LightBurn after moving USB ports!

Some lasers require you to fully reboot the device after
moving USB ports. The suggested workflow is:

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Turn the laser fully off.

Move the USB cable to the correct port.

Turn the laser back on.

Can I convert from EZCAD2 to LightBurn files?

As of 1.2.01, you cannot import an Ezcad2 project file to
LightBurn directly. If the grid in Ezcad is turned off

temporarily, LightBurn can trace screenshots of Ezcad easily
to import placement in many situations. 

My galvo is trying to engrave my rotary, what's wrong?

LightBurn allows you to offset your rotary's "center" when
engraving with a rotary, to compensate for the rotary being
aligned physically to the frame on a different pattern than
your lens. Please see the section on output centers for more
information.

1. 

2. 

3. 
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5.2 Glossary (Galvo)

This section is new, and is a work in progress. Be sure to let us know on the forums or via support if we need to change something.
Thank you!

5.2.1 Galvo

A type of laser apparatus that uses a series of actuated
mirrors to reflect the beam of a laser source around at high
speeds. This contrasts to "gantry" style lasers, that move a
series of mirrors along the gantry itself with a "lens" at the
end to focus it, or diode lasers that move the laser souce
itself, (usually using a gantry).

5.2.2 Source

This is the portion of a galvo laser responsible for producing
the beam itself used for operation. While not a laser tube
inherently, laser sources are similar in purpose to the tubes
found in CO2 gantry lasers.

5.2.3 MOPA

Master Oscillator Power Amplifier lasers are a specific class
of fiber laser sources that enable pulse duration to be varied
(not just pulse energy and frequency as in other sources).
This variability enables use cases such as durable colored
marking of stainless steels and titanium by pulsing the beam
in such a way it anneals the metal.

5.2.4 Tower

This is the portion of galvo lasers responsible for moving the
galvo head up and down, vertically. The tower connects the
head to the fiber cable (that carries the beam from the
source), and any other apparatus that need to move with
the lens to focus and effectively work on the job.

5.2.5 Framing

Framing allows you to accurately position work. It's an
operation that outlines the job in real life on the object/
material, but using a lower power, so it doesn't cut/engrave
it. It usually requires you to be accurately focused. 

5.2.6 Frame/Base

This is the portion of a galvo laser that holds up the tower
and ensures it's rigid and won't tip over. It usually has a
work table larger than the tower above it for stability.

5.2.7 Cleanup Pass

A final pass, usually at a tighter line width, higher frequency,
and a lower power. Done to to clean up soot and debris from
more ablative processing. 

5.2.8 Focal Point (Waist)

The thinnest part of the (focused) beam, the point at which
it is the most in focus. See the Focusing page for more info.

5.2.9 Focal Length

The distance from the optical centre of the lens to the focal
point. See the Focusing page for more info. 

5.2.10 Depth of Field (Focal Range)

The useable range of the (focused) beam. It appears either
side of the focal point, and varies based on various factors
including; the focal length of the lense, the material being

Attention
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cut, the power of the laser source, etc. See the Focusing
page for more info. 

5.2.11 Field Size (Build Volume, Window Size)

These fields describe the maximum area that the lens
installed in the galvo can physically cover when focused.
See the Focusing page for more info. 

5.2.12 Wobble

Wobble refers to the ability of the beam to rotate about a
particular area, imparting more heat to the workpiece and
allowing for more material removal. 

This feature can be enabled in the Cut Settings Editor on
galvo devices.

5.2.11 Field Size (Build Volume, Window Size)
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Galvo LightBurn 1.2

5.3 Installing Drivers (Windows only)

If you haven't already installed LightBurn, please start by installing it on your computer.

5.3.1 Installing The Driver

When installing LightBurn, the last screen of the installer has
a set of tickboxes to install additional drivers needed for
certain types of machines. We'll need to add the "EzCad2
driver" used by galvos before LightBurn can see the galvo
you're trying to set up. 

If during initial installation you didn't tick this box, you can
simply run the installer again, and select this box to ensure
the driver is installed for use. Windows will prompt you for
permissions escalation to install it, and quickly replace the
driver provided by default with one LightBurn can use to
communicate with your galvo-based laser.

Alternately, the installer for the driver is in the LightBurn
files at "C:\Program Files\LightBurn\EzCad2Driver\" and can
be run again via the "dpinst-x64.exe" file directly.

This installed driver may not work correctly with Windows 7.
Please see the Zadig method below.

5.3.2 Restoring the Driver

In the event you want to use EZCAD it's a simple task to
revert to the original driver. 

Open your Windows Device Manager - You can do this by
clicking 'Start' and typing 'Device' and letting it auto-
complete.

Next, find the USBLMC device in the list - it should be near
the bottom, under 'Universal Serial Bus devices', shown
below:

Right-Click the device and choose 'Uninstall Device' from the
pop-up menu.

Info

5.3 Installing Drivers (Windows only)
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In the next window, check the box to delete the driver. (this
doesn't actually delete anything from your system, it just
completely dis-associates the driver from this device)

Click the 'Uninstall' button. The process should finish quickly.

If you power off the laser and power it back on, Windows will
reconnect, realize that it already has a driver for this device
(the old LMC driver) and it'll appear in the Devices list again,
near the top, as a BJJCZ device. That's it - You can use
EZCAD again.

5.3.3 Zadig-based Driver Swap

In the event the driver swap (performed by running the
installer) isn't working, it may be suggested to try and use
Zadig (a driver tool) to replace the manufacturer's with a
generic driver so LightBurn can communicate with it. Below
are those steps.

Download Zadig, the driver replacement tool from https://
zadig.akeo.ie/ and run it. (it doesn't require installation)

You'll see a window that looks like this:

Open the 'Options' menu and enable 'List All Devices'

If your EZCAD laser is powered up and connected with the
USB cable, you should see USBLMCV2 (or very similar) in the
device list, like this:

Select that device, and choose 'WinUSB' as the target driver,
like this:

Double check that it says LMCV2U in the 'Driver' box, and
that the USB ID under it matches what you see above. If you
haven't used the laser with this computer before, the
'Driver' box may be empty instead.

Click 'Replace Driver' and wait for the process to complete.
Make sure that you are not running EZCAD when you do this
- if anything is actually using the hardware, the driver swap
will likely not complete, and time-out after five minutes. If

Legacy Zadig-based Driver Swap

5.3.3 Zadig-based Driver Swap
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everything goes as expected, it takes about a minute, often
less.

You'll see some different messages cycle through while it
does the install. When it's done, it might ask you to reboot,
but that's rarely required.

On the rare occasion that Zadig fails, just try it again - it
almost always works, and sometimes reports a failed
installation erroneously, when it actually succeeded. You 
should see this:

5.3.3 Zadig-based Driver Swap
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Galvo LightBurn 1.2

5.4 Adding & Setting Up Your Galvo

To set up and configure your galvo laser, you'll need to create a new device, and import or manually enter settings provided by
your laser manufacturer. 

It's also a good idea to set up a new device profile for each lens you have for your galvo, because changing lenses will affect many
parameters. You can duplicate a device after setting it up by right clicking on it in the 'Devices' window and choosing 'Duplicate'.
This is the easiest way to add a new profile while keeping the settings, so you only have to update parameters that change with
the lens.

To add a new device LightBurn, click the 'Devices' button. From here you have two options: the importer or manual entry.

5.4.1 Importer

Click 'Find my Laser' and LightBurn should detect the JCZ
controller and add it for you. You will need to specify your
field size (the size of your workspace), but this can be
changed later too. 

Select JCZFiber, click Next, and choose 'USB'. It's the only
supported connection type for now.

5.4 Adding & Setting Up Your Galvo
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As with any other laser device, you'll need to enter your
window size. (110mm x 110mm is common).

5.4.1 Importer
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Select your configuration file from your EZCAD setup (or if
you received a card, email, etc. with that information in it,
please click "Next" anyways) It's likely to be on the USB
drive you recieved from the manufacturer. Ours was in the
"PLUG" folder of the "Ezcad2" install folder.

If your markcfg7 file includes information about Lens
Correction, LightBurn will attempt to automatically import
this for you. If your configuration doesn't, you'll need to
manually enter it in Device Settings after finishing the New
Setup Wizard.

You'll need to enter the specific work area dimensions as
selected by your manufacturer. While 110mm by 110mm is
very common, the different models offered & their
respective dimensions are usually listed on the
manufacturer's website.

Before Import After Import

Info

5.4.1 Importer
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Just like that, you're all finished, and ready to start
calibrating!

5.4.2 Manual Entry

If your laser did not come with the settings on a USB drive or
if you don't have the USB drive available, you may need to
contact the manufacturer for settings. Galvo settings can't
be found through trial and error, due to the complexity and
variety of machine configuration. Settings that work on one
laser may destroy another.

If your settings were provided on a card, in an email, or in
any other way that doesn't work with the automatic
importer, clicking "Next" when asked to Import EZCAD
Config will allow you to skip this step. 

When in the main window, please open the "Edit" menu
item, and select "Device Settings". 

The settings can now be manually entered to match what
was provided by the manufacturer. 

Please note that when entering these settings manually, the 
Additional Settings tab needs to be updated with the correct
information for the simulation in Preview to function
correctly. 

5.4.2 Manual Entry
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Galvo LightBurn 1.2 Advanced

5.5 Configuring Galvo Settings

If you did the EZCAD parameter import as part of setting up the device, you can likely skip this part, though we do recommend
verifying that everything came across correctly. If you didn't import your EZCAD settings, continue reading.

LightBurn needs to know more about your galvo laser before you can use it effectively. Below is an explanation of every currently

listed item in the Device Settings  for Galvo devices. 

To expedite manual entry, you can either run EZCAD and just flip through the Param (F3) pages for this, or take screenshots and
use them for reference when setting up LightBurn. All of these settings are taken directly from EZCAD.

Run LightBurn, choose the JCZFiber laser, then click Edit > Device Settings (or click Device Settings  on the toolbar.) 

Note

5.5 Configuring Galvo Settings
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5.5.1 Basic Settings

Field

These fields describe the area that the lens installed in the
galvo can physically cover when focused. Changing the
lenses always requires going through the setup and
calibration to adequately tune and dial in galvos.

SIZE

The maximum area the lens installed in the laser can cover.
This value is also used to set up the work area in LightBurn.

ANGLE

Rotational correction for the field - if you're correcting for a
rotated galvo head relative to the physical fixturing pattern,
you can rotate it to behave as if it were square with this
value. 

OFFSET (V1.4+)

You can fine tune the position of the field using x and y
offset

Red Dot

The red dot laser is a separate mechanism that is in line with
the optics of your galvo laser souce. It may require fine
adjustment to get it aligned with those optics, and this is
where those settings come from. While generally provided in
the EZCAD Config during Setup, they may also be found in
your installation media as a screenshot or other text file.

5.5.1 Basic Settings
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5.5.2 Galvo configuration

Load COR File - A COR file is an EZCAD lens correction file.
LightBurn has the ability to import them and fill in the scale,
bulge, skew, and trapezoid setting automatically, and if you
used the markcfg7 import during Setup, you'll already have
these values/file set. Otherwise this field can be left blank,
and entered manually in Per Galvo Settings

Per Galvo Settings

Each galvo head is responsible for an axis, and has fine-
tuning that can be performed to get it operating optimally.

Galvo (N) is X Axis

This toggle is linked for both galvo mirrors, allowing you to
specify which mirror is used for the X-motion of LightBurn.

Reverse Direction (Negate)

This flips the output behavior of an axis in the event the
control signal is linked backwards to the motion of the
mirror.

Scale, Bulge, Skew, and Trapezoid

A more in-depth explanation of the below settings can be
found in the Lens Correction section.

SCALE

Perentage to scale the output axis by.

BULGE

Distortion near / at the center of the engraving field.

SKEW

Distortion at the edges (corners) of the fields, pulling the
towards a cardinal direction.

TRAPEZOID

Corner tapering adjustment, to fix keystoning.

Play sound on job finished

This feature mirrors that of EZCAD, causing the computer to
play a sound when your current run is done, in leiu of all
galvos having a window.

Require framing before start

This option forces the user to use framing mode and align
their workpiece before engraving directly. It makes the Start
Button in the Laser Window open the Framing Dialog
instead.

5.5.3 Laser Source Configuration

All of these settings should be imported from EZCAD,
manually changing them to "guess and check" settings is
not the correct course of action. Doing so may damage your
laser, proceed with caution!

Danger

5.5.2 Galvo configuration
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Frame Speed

This is the maximum speed of the red dot framing tool in
your galvo.

Laser Type

This refers to the specific type of galvo laser in use. Fiber or
CO2 are the current options.

Fiber Type

The specific manufacturer, or granular type of laser. This
may reveal other settings depending on what type and
category of laser is in use.

Enable Q-Pulse Width Setting (MOPA)

This is a MOPA specific laser setting to adjust the fine length
timing of the pulses from the laser. The larger the timing,
the less dense the pulse impact is.

Open MO Delay (ms)

MOPA permits a wider frequency range comparatively to Q
switch laser types, and this delay allows you to adjust this
fine control.

Enable PWM

This permits adjustment of the valid range of PWM timings
on CO2 galvo lasers.

Tickle

CO2 lasers require constant low power to be able to fire at

lower power densities consistently and reliably. Use of a
tickle permits adjusting the controlled location of that
threshold to produce better lower power engravings.

These will be provided by your manufacturer.

First Pulse Killer (FPK)

This setting is also CO2 specific. To enable the initial power-

on of a CO2 tube, there's a higher power draw needed to

energize it. FPK lets you choose and tune that first pulse to
get to the normal operation energy. 

This setting can be found via trial and error if needed.

5.5.4 IO Ports

These are external switches or features attached to the
controller on the board.

The High / Low toggle indicates whether the device is
normally high, or normally low electrically, and determines
what signal to interpret as being toggled. 

Not all of these may exist, or be enabled on all galvos. If not,
the port number will be shown as "None".

Red 0 thru 15

These red/green rectangles represent the pin state of the
Ezcad board inside your galvo laser at any given time, and
the numbers the port number on the controller. This is useful
for diagnosing floating electrical connections, loose wires,
and a potential default setting dependent on a foot pedal. 

Within LightBurn, a red indicator means the port is "LOW", or
off, and green means the port is "HIGH", or on. Some
manufactured boards are active LOW as opposed to active
"HIGH". If all ports are green by default, you'll likely need to
change your trigger type to "LOW" from HIGH.

Ready Light

This is the selector to toggle LEDs on the galvo head, aimed
at the workpiece.

Red Dot

This is the selector for the external Red Dot enable.

Start Marking

This is the selector for starting an engraving job as set up,
typically triggered with a foot switch of some kind on the
laser. Like mentioned in IO Ports, a user can change the pin
number to match that of the board's foot pedal or start
signal, the signal trigger type, or disable it entirely. The
former is useful to use a foot pedal; the latter for safety.

Info

5.5.4 IO Ports
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If you find your laser activating sporadically and you do not
use a foot pedal, it is a heavy suggestion that the "Start
Marking" pin is set explicitly to disabled. Some galvo
controllers do not adequately electrically protect the circuit
and stray voltage and static can mark the pins as HIGH, or
"on" to LightBurn.

LightBurn has debouncing in software to mitigate this as
much as possible in 1.2.02. Please update to 1.2.02 or later
to ensure you have this functionality automatically in place.

RED DOT ALWAYS ON

This setting forces the external red dot alignment to "always
be on", permitting constant use or disabling it if desired.

ENABLE BLANKING

This options allows you to attempt to turn off the red dot
internal to your galvo between drawing shapes. This is not
supported on all devices.

5.5.5 Jump Setting Defaults

These settings control the speeds by which to toggle, offset,
delay, or fudge the source enable and galvo head motion. 

Laser on TC (μs)

When attempting to mark, the physical mirrors of the galvo
head must reach the desired speed before they begin
marking. This fine tuning allows the user to reduce the burn-
in potential during that initial acceleration by adjusting the
source timing.

Laser Off TC (μs)

Similarly to the above, when the mirrors of the galvo head
must slow down as they attempt to end a marking move,
there may be a burn-in effect while slowing down. This
setting allows the end timing to be adjusted finely. 

End TC (μs)

This setting adjusts how long the laser waits at the end of a
series of vectors. Due to the fact the laser will physically lag

behind the commanded state as decided by any software,
this delay permits adjustment similarly to the Laser Off TC.

This setting applies to any marking move where the laser is
turned off after execution.

Polygon TC (μs)

This setting adjusts how long the laser "waits" at the end of
each segment of a polygon, permitting the laser to settle
appropriately, compensating for the same lag as outlined in 
End TC. This adjustment will only apply to polygonal
execution.

5.5.6 Additional Settings

This settings tab consists of specific timing adjustments for
simulation and preview, entirely for the Preview Window.
The galvo can function even if these are set incorrectly, so
long as the other timing and adjustment are correct. 

If the estimate is significantly off from the timings in
practice, we recommend editing these settings to match the

main device settings .

Danger

5.5.5 Jump Setting Defaults
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Galvo LightBurn 1.2 Advanced

5.6 Lens Correction

Much in the same way that cameras used in LightBurn need to have a calibration routine run for best performance, so do galvo
lasers. Many manufacturers ship lasers with these types of settings already present, and when using the importer these should be
automatically imported for you. 

If the LightBurn Importer does not detect the lens correction setup when following the wizard, these specific settings may be
copied from EZCAD's Configuration Parameters tool, or found by the user manually. Device Settings otherwise must come from the
manufacturer for safety, as outlined in Setup.

5.6.1 Field Size

While not strictly part of the lens correction, the intended
field area affects all of the correction and calibration settings
described below. The field size describes the maximum area
the lens can reach at it's focal length. When correcting a
new lens, be sure to follow the steps suggested here.

5.6.2 Scale Adjustment

This setting scales the overall size of your intended laser
output on X & Y axes. If adjustment of this is needed, please
also verify that your [Machine Setup] was finished and your
field size was imported. Otherwise, you may be
compensating for the field size in the wrong area,
complicating further adjustments.

5.6.3  Bulge Adjustment

The bulge factor allows you to change by how much (if at all)
the center of shapes are distorted and stretched. 

5.6.4  Skew Adjustment

The skew factor allows you to adjust the tension on the
corners of your design, pulling the bottom portion of the
design left or right relative to the top. 

5.6.5  Trapezoid Adjustment

The trapezoid tool works similarly to the Skew adjustment
tool, where it permits the distortion of your design by
stretching or pinching the "corners" of your design.
Trapezoid adjustment allows you to pinch one portion
relative to another This is where the name of the tool comes
from, as it allows you to make trapezoids into squares, and
vice versa.

5.6 Lens Correction
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Galvo UI

5.7 Framing

Framing mode is a function of Galvo lasers that permit you to preview the outline of your design on your physical object before
engraving it. Clicking the 'Frame' button in the Laser window, or pressing 'F1' brings up the Framing Mode window. 

5.7.1 Framing Styles

The different options allow you to choose how accurately the
red-light frame represents your shapes, and which shapes
are shown.

Bounds

This mode is a simple rectangle, drawn just big to enclose
your shapes. It is extremely fast, but doesn't represent
complex shapes well.

5.7 Framing
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Hull

The 'hull' is what you'd get if you stretched a rubber-band
around your shapes. It is nearly as fast to draw as the
rectangle bounds, but gives a much closer fit for rounded or
smooth shapes.

Contour

Contour follows the exact contours of your shapes - it takes
the longest to draw, but it's the most accurate.

5.7.2 Nudging

While framing, the arrow keys can be used to nudge the
position of your graphics by 1mm. Holding Shift will increase
the movement distance to 5mm, and holding Ctrl will
decrease it to 0.2mm.

Starting from version 1.4, you can also nudge the scale of
your design. Page Up  will scale up, and Page Down  will scale
down. If your keyboard doesn't have those keys, try the
Function key along with up and down arrows.

5.7.3 Additional Options

Frame Individually

This toggle switch indicates whether you would like to draw
a single bounding box or hull around everything together, or
around each shape in turn (this only affects Bounds and 
Hull modes).

Image Bounds

Enabling this toggle switch attempts to quickly trace the
outlines of any images you have in your design, rather than
simply showing the rectangular boundary of the entire
image.

Outside Shapes Only

This toggle switch tells the software not to trace inner
shapes, like the insides of letters - Typically this doesn't
affect placement, but allows a faster update of the frame
(this only affects Contour mode).

Tool Layers Only

Enabling this toggle will tell LightBurn to only frame shapes
that are on one of the tool layers.

5.7.4 Job Counter and Multiple Runs

Count

This value is incremented at the end of each successful run
of your file. You can use this to keep track of how many parts
you have marked, or how many passes of a single job you've
run. Press the Reset button to reset the count back to zero.

Run Continuously

Turning on this switch will make LightBurn re-start the job
automatically after it finishes, and will update the run
counter after each run. This is useful when you are doing
very deep engraving, and are unsure how many passes a job
will need. If you turn off the switch while a job is running, it
will stop when the current run completes.

Please ensure your laser is properly supervised, even during
long jobs with multiple passes.

Repeat

Turn on this switch and set the repeat count value to run the
entire job a specific number of times. This is similar to 'Run
Continuously', except it will stop when it reaches the repeat
count. If you turn off this switch while a job is running, it will
stop when the current run completes.

Warning

5.7.2 Nudging
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5.8 Lens Focusing & Calibration Tools

Any use of a laser, as outlined in this section, requires effective and useful laser safety glasses calibrated to your galvo's output
wavelength range. 

Laser safety glasses should come with the wavelengths they protect against permanently marked on the glasses themselves. 

To be able to use your galvo laser effectively, you'll need to have it in-focus, well tuned, and well calibrated. This enables best use
of features like Cylinder Correction, 3D Sliced Engravings, and more.

5.8.1 Finding Your Focal Point

Each lens should be labeled with a focal length, such as
F330 for 330mm lenses or F160 for 160mm lenses. This is a
good starting point for focusing, but manufacturing
differences result in differences between lenses so you
should still fine-tune the focus. You can fine-tune the focus
by looking for crisp outlines in framing or listening for audio
cues.

To use "crisp outlines" to find the focal length, you'll need to
frame a design and raise/lower the galvo until the edges are
as crisp as possible. This requires your galvo to have an in-
line red dot. With audio cues, you'll instead listen for louder
burning or sizzling noises while the job is running. The
correct focal length will generally make the loudest sounds.

While the depth of field is a range that produces engraved
results, finding the optimal focal point within that field is
important, to ensure the best results, and is best found
through trial and error.

A Step-By-Step for Focusing Flat Objects

Raise your galvo head as high as it reasonably can go.

Start a repeat engraving.

Lower the head until it starts making noise.

Continue further down slowly until the engraving noise is as
loud as it gets.

if the noise tapers off, raise it back up and fine tune based on
that.

Your flat surface is now focused!

If your laser has two-diode red-points that are manually
moved, re-adjust those at this point. See your laser's user
manual for help.

Danger

1. 

2. 

3. 

4. 

5. 

6. 

7. 

5.8 Lens Focusing & Calibration Tools
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5.8.2 Measuring Focal Length

Make sure you keep track of what part of the laser your focal
length is measured to! You might find it convenient to
measure to a point other than the bottom of the lens, and
that's fine as long as you keep measuring to the same
height.

Accurately measuring the focal length above is a useful
process to speed up swaps of different and diverse jobs,
given the lens. Use an acrylic ruler (preferably one with the
edge of the ruler starting from 0"/0mm), to measure up to
the point the ruler meets outside lip of your lens.

If your acrylic ruler has a lip, you can measure the offset
with calipers to produce the formula needed to measure the
focal length accurately.

To make it quicker and easier to focus the laser when
working with objects of different sizes, it's a good idea to
make a tool that you can place between the lip of your lens
and your object, so you can easily raise/lower your galvo
head to it. This can be as simple as a dowel of the right
length marked to indicate which lens it goes with (if you
have multiple lenses). Another popular option is to laser cut
an acrylic focusing tool for the size you need.

Video Guide For Focus Sticks

5.8.3 Focusing For Cylinder Correction

Cylinder correction within LightBurn maximizes the depth of
field usable for engraving by intentionally defocusing your
laser. See here for more information.

Tip

5.8.2 Measuring Focal Length
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5.9 Cylinder Correction Marking

Cylinder Correction (called ProjectMark in EZCAD) warps the output of your design to correct for the expansion that happens when
you mark on a cylindrical object, like a cup or tumbler, without using a rotary.

This feature is currently only avalible on galvo machines. While it is on the roadmap to enable this functionality for DSP and GRBL, this
will not present itself on DSP or GCode machines until that change is made.

Theory

In the image below, the blue shapes represent a rectangle. If you were to project a rectangle directly onto a cylinder, the sides of
the rectangle would hit the cylinder at a lower point than the middle. Since the laser is projected from a single point above your
object, the extra distance means the sides of the rectangle will widen and curve, like the rectangle below labeled "Uncorrected".

With Cylinder Correction mode enabled, LightBurn will alter the data sent to the laser to compensate for this. LightBurn sends
something similar to the "Corrected" image, and when engraving your object, the effects negate each other. This produces crisp,
significantly less distorted results, like the "Result" shape shown below.

Lens Selection

Using this feature is dependent on being able to make a mark on your target object across a potentially wide focal range. For
example, if you have a 75mm diameter tumbler and are engraving a 50mm wide graphic, there will be a roughly 10mm difference
in focal distance from the center to the edge of that graphic. 

Due to this, you will want to select a lens that has a wider "field" (working area) for your galvo laser. For example, a 110mm field
lens (f=160mm) may only have a workable focal range of around 1.5-2mm. However, a 300mm field lens (f=430mm) should be
able to handle a 10mm range relatively easily.

You will also want to focus your lense partway into the surface of your cylinder, to take advantage of the full depth of field of your
lens, as described in the image below. 

Note

5.9 Cylinder Correction Marking
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Design Placement

LightBurn will always assume that the center of the provided shapes are at the center of the object you are engraving on. This
includes if you are using Cut Selected Shapes  - where it will base the center calculation on only those shapes. It is done this way so
that you do not have to always place your object exactly at the center of your machine working area. If, for example, your
placement jig has to be 20mm off center due to the threaded grid holes being off center, you can simply adjust your design to be
20mm off center to match. You can, of course, verify the correct placement using the framing option in the Laser  panel.

This assumption is made because if the object is off center from the actual galvo center, the laser can physically reach more of one
side of that curved surface than the other. LightBurn will actually warp each side of your design more or less according to this
offset.

It also affects the valid boundary in which your design can be placed for a given mirror distance and object diameter.

Setup

To enable it, go to Tools > Cylinder Correction Setup, and you'll be shown this screen:

5.9 Cylinder Correction Marking
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Start by toggling the "Enable Cylinder Correction" option at the top. Note: this is not preserved across LightBurn sessions like it is
for some rotaries. You will have to re-enable it any time you restart LightBurn and would like to use this feature.

Next, set your mirror distance from the surface of your object. Note: this is not the focus distance from the lens, but actually to the
mirrors. It is relatively easy to find this distance however. There is typically a tube connecting the galvo head to the laser source
and the mirrors are generally centered along that tube.

In the image below, you can see the center plane of that tube marked along with the distance from the bottom of the lens to that
center plane marked. Assuming you measure your focus distance from the bottom of the lens to the surface of the object, simply
measure the distance from the bottom of the lens to the center plane of the tube and add that to your focus distance. Use that
value for the mirror distance.

5.9 Cylinder Correction Marking
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Finally enter your object diameter and choose the axis along which your target object curves.

Valid Boundary

Given that the laser is being projected from a fixed point onto a curved surface, there are limits to where on your engraved object
your laser can actually reach.

In the Cylinder Correction Setup dialog, shown above, there is a Show Valid Boundary  button at the bottom. Click on this and it will
insert a rectangle, on the T0 tool layer, into your design, showing you the area in which your design can be placed.

This valid boundary area is also affected by how far from center your object is.

If you attempt to run an cylinder corrected engrave or even show the preview while your design is outside of this boundary, you
will be presented with the following dialog:

If you choose to continue anyways, the areas outside of the valid boundary will be automatically cut off from the output. In the
image below you can see it has actually removed the portions outside of the valid boundary area, shown in orange at the left.

5.9 Cylinder Correction Marking
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You can also, from that dialog choose to have it show you the boundary just as you would in the setup dialog.

5.9 Cylinder Correction Marking
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5.10 LightBurn Fill & EZCAD Hatch Quick Translation

If you're coming from EZCAD and having trouble finding hatch settings you're used to, please see below for a guide to matching
your usual hatch settings to LightBurn's fill settings.

If you're not sure how to adjust cut & engraving settings, please see the Cut Settings Editor page.

5.10.1 Mark Contour

EZCAD2's "Mark Contour" option can be replicated with
LightBurn's sub-layers. By creating a line sub-layer and a fill
sub-layer, you can achieve the same effect. To cut the
contour first, have the line sub-layer as the first sub-layer. To
fill first, have the fill sub-layer as the first sub-layer.

5.10.2 Hatch 1, Hatch 2, Hatch 3

EZCAD2 allows for three different hatches on the same
geometry. This is equivalent to LightBurn's sub-layers.
Please see the relevant page for help.

5.10 LightBurn Fill & EZCAD Hatch Quick Translation
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5.10.3 Cross-Hatch

This functionality is the same between the two programs,
and is a checkbox in both.

5.10.4 Hatch Patterns

Unidirectional hatch & Bidirectional hatch

 EZCAD2's bidirectional hatch and
unidirectional hatch are the same as the default hatch in
LightBurn, with the bi-directional fill toggle either on or
off.

Ring-like hatch / Pyramid Hatch

 EZCAD2's ring-like hatch is equivalent to
LightBurn's Offset Fill.

Snake Hatch

Snake hatch is equivalent to a regular fill in LightBurn with 
Flood Fill enabled.

Auto Rotate Hatch Angle

In LightBurn, the EZCAD2 feature of "auto rotate hatch
angle" is labeled as "Angle Increment" in your layer / sub-
layer settings. While not a fill mode, it's still relevant to
replicating EZCAD2 fill styles.

5.10.3 Cross-Hatch
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5.10.4 Hatch Patterns
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5.11 Rotary Setup (Galvo)

The Rotary Setup can be found on the toolbar with the rotary icon, in the "Laser Tools" menu near the bottom, or brought up by
using Ctrl + Shift + R  / Cmd + Shift + R .⌃ ⇧ ⌘ ⇧

5.11 Rotary Setup (Galvo)
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Chuck Rollers

5.11 Rotary Setup (Galvo)
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To use the rotary with your marking laser, you first need to set up the rotary parameters.

When rotating about the X axis, you'll want to engrave along the X axis (with a resultant scan angle of 0 or 180). When rotating about
the Y axis, you'll want to engrave along the Y axis (with a resultant scan angle of 90 or 270). 

First choose whether you have a chuck or roller style rotary.

Set the 'Steps per Rotation' value to the number of motor steps required to spin the rotary itself one complete rotation when the
'Test' button is pressed. (it should rotate a full 360 degrees, pause, then rotate back to the starting point).

Set the Min and Max speeds to move the rotary, in pulses per second.

Set the Acceleration time (the time to ramp the speed from Min to Max speed).

Set the Return speed value (this value is how fast to move when returning to the starting point)

Choose whether you are rotating around the X or Y axis. (If the roller is along the horizontal axis, choose X, if it's along the vertical
axis, choose Y)

You may need to enable the 'Reverse Rotary Direction' switch if the output is backwards or sliced in the wrong order. 

In most cases, the steps/rotation and other values will be provided by the manufacturer of your machine, either as a screenshot of the
rotary params page in EZCAD or a text document.

If you don't know the correct numbers, the 'Test' button in LightBurn will run a single 360 degree movement of the chuck or roller,
pause, and return to zero, using the current settings, so it is possible to find usable values by trial and error.

The values listed above, minus object diameter/radius, should only need to be set up once. If the rotary unit or orientation are changed
though, performing Rotary Setup again is a good practice.

Split Setup

Galvo markers will run a portion of the job (a slice), rotate the object, run another slice, and so on.

SPLIT SIZE

The size of each slice is called the 'Split Size'. If your object is tapered, irregularly shaped, or not perfectly aligned with the rotary
axis, using a small split size can help reduce gaps or misalignment of the splits.

A larger split size will reduce the time spent running the job, but can be harder to dial in the settings such that no overlaps or gaps
are visible.

OVERLAP

To help eliminate visible gaps between slices, you can tell LightBurn to overlap them - specifying an overlap of zero means that
each slice is run on its own. A non-zero overlap value will produce that much overlap on the ends of each slice, like this:

Note

1. 

2. 

3. 

4. 

5. 

6. 

7. 

Note

5.11 Rotary Setup (Galvo)
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If you are removing paint, anodizing, or other surface coating, using a small overlap is recommended. If you are annealing or
marking the material directly, adding overlaps could produce visible artifacts.

RUN WHOLE SHAPES

When 'Run whole shapes, if possible' is turned on, LightBurn will attempt to create splits that keep shapes intact. This can produce
a higher quality finish without gaps or misalignment within shapes.

Running the job

When rotary mode is enabled, pressing the Start button on the main window will bring up the Rotary Marking window, shown here:

From here you can tune the split size, overlap, and object diameter, as well as jog the rotary, and run the job. When running a
rotary job, the center of your page is treated as the current rotary position when you clicked 'Start'.

OUTPUT CENTER

This setting allows you to shift the center position of your rotary output to compensate for the center of the rotary not lining up
precisely with the center of the field. This value cannot be negative.

This setting is only adjustable (as of 1.2.01) in the Rotary Marking "Run" window, and not the "Framing" window. If you wish to retain
use of the Framing dialog, you can set it here, and then use "Frame" all the same. 

Focusing

See Focusing for more information. 

Note

5.11 Rotary Setup (Galvo)
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5.12 Changing A Lens

To ensure best performance following a lens swap in LightBurn when using a galvo, there are several changes and settings you'll
need to confirm first. Some manufacturers give you the calibration information for your new lens, and it's highly suggested you
check their website before proceeding to find this manually.

5.12.1 Physical Lens Swap

This video guide from Laser Everything covers the physical
installation of the lens, as well as many of the items outlined
below with EZCAD analogues. It's suggested this video by 
Laser Everything is reviewed to help ensure the lens swap
doesn't damage your machine or hurt you in the process.

5.12.2 Duplicate Original Laser

In many cases, changing the galvo lens means that you'll
need to adjust many settings and recalibrate it, making it a
"new" machine when doing so. To duplicate a laser device in
LightBurn, click "Devices" in the "Laser" window, and right
click on the given laser to duplicate it.

Be sure to give the duplicate a descriptive and accurate
name to contrast it to the original, and ensure that's the one
you'll be editing.

5.12.3 Field Size

When changing lenses, the effective Field Size of your laser
will also change. The Field Size for your lens is usually listed
on the manufacturer's website.

5.12.4 Focus

After changing lenses physically, you'll need to adjust the
focus of the laser even without other calibration being done
yet to ensure the results are as good as possible.

Spend time and reference the steps outlined in Focusing to
ensure your galvo's output is crisp and in focus; keep in
mind your red dot framing may no longer be in focus due to
the focal length changes.

5.12.5 Scale, Bulge, Skew, Calibration

Once your galvo is focused, you'll need to adjust the bulge,
skew, trapezoidal calibration as best you can to match this
new lens. Please see Lens Correction and the specific Device
Settings for Galvo to get more in-depth explanations of the
calibration settings.

While your initial testing may have been done in the center
of your engraving field, it's suggested that you perform one
or more tests at the edge of your field to fine-tune the Scale/
Trapezoid/Bulge/Stretch to ensure accuracy and consistency.

In the event you find the design severely distorted at the
edges but not at the center, it's likely your Field Size was set
incorrectly. You'll need to follow the steps from the beginning
to try and mitigate this.

Warning

5.12 Changing A Lens
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Scale

In order to test scale, it's suggested you attempt to frame a
square of known size in LightBurn (say, 60mm), and
measure the corner-to-corner with calipers to adjust your X
and Y scale as needed. 

Bulge

Following that, you'll want to measure your design bulge;
frame a square nearly as large as your field allows (errors
are amplified at the edges of a galvo). Put the edge of a flat
surface directly between the two corners of a side and check
to see if the line bulges into or past the straight edge, and
adjust your bulge settings accordignly. Repeat this step for
both axes.

Trapezoidal

Frame a square nearly as large as your field allows (errors
are amplified at the edges of a galvo). Measure the length of

the top edge and compare it to the length of the bottom
edge, and adjust the trapezoidal value until they match

Skew

The fine-tuning of your skew can be done either by lining a
set square along two edges to see if they are 90 degrees, or
by framing a rectangle nearly as large as your field allows
(errors are amplified at the edges of the field). Measure the
distance between opposing corners, and compare it to the
measurement of the other opposing corners (so that if you
were to trace the lines you measured you'd end up with an X
shape across your framed square). Your goal woudld then be
to adjust the trapeziodal value until both measurements are
the same. 

Repeat

You may wish to repeat these checks to ensure they are still
correct, following the changes made. 

5.12.5 Scale, Bulge, Skew, Calibration
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Galvo LightBurn 1.2

5.13 3D Sliced Engravings

Galvo users without a live Z-axis have the ability to make "2.5D" engravings with LightBurn and their galvo, producing objects with
tactile and visual depth. LightBurn calls this mode "3D Sliced" due to the similarity to 3D printing slicers; where horizontal slices
are deposited by 3D printers, LightBurn allows subtractive layer-by-layer operations.

3D Sliced mode uses greyscale images called powermaps to create depth in the engraving. Darker shades of grey will be cut with
more passes and become deeper, while lighter shades of grey will be cut with fewer passes, making them shallower. These can be
created by hand, although tools like STL2PNG that generate raster images from STL files are often used to make more complex
depth maps. The greyscale powermap can be imported to LightBurn like any other image. 3D Sliced mode uses the depth map to
generate up to 256 steps of engravings, with impressive results.

5.13.1 How-To

First, produce a greyscale heightmap image in any tool you
choose and import it to LightBurn. 

Open the Cut Settings Editor for the layer the image you've
imported is on, and change it's type to "3D Sliced".

Next, change the number of passes entry to the quantity
you intend to use for this operation. The more passes, the
higher the effective resolution can be, though reducing the
power such that it doesn't go deeper may be needed. Think
of this as "layer height" for 3D printers.

5.13 3D Sliced Engravings
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More complex, larger designs may take more time to
process, because of the complexity of generating each pass.
If you see this dialog, please be patient as your computer
may need some time to prepare your design.

Check the preview to confirm your design is behaving as
you're expecting. If you use the play button, you should see
your design render from the bottom to the top, with black
indicating the engraved portion for each layer.

5.13.2 Further ExamplesNote

5.13.2 Further Examples
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Galvo LightBurn 1.2 Advanced

5.14 About Galvos

5.14.1 Supported Types

The current types & manufacturers of galvo laser sources
supported (as of LightBurn 1.2.00) are as follows:

Raycus (RAYCUS)

JPT (JPT)

IPG (IPG_YLP / IPG_YLPM)

MAX (MAX / JPT)

CO2

(as of 1.2.02) UV

5.14.2 Unsupported

These are devices that may work at some point in the
future, have been communicated to our staff that users

would like to use them, but we can't 100% confirm
behavior just yet. 

QUANTEL_M20HF

QUANTEL_M20

MANLIGHT_PL

VGEN_YPFL

EO

QUANTEL_M20EG

QUANTEL_M30EG

IPG_YLP_E

HFB

Orion Laser

Note

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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5.14.3 Sources

Fiber

Fiber lasers are incredibly common devices, due to their use
for long-distance & high bandwidth networking; fiber lasers
power the internet. 

They make use of an optical pathway, made of silica glass to
guide the light, resulting in a narrow, straight beam that's
able to carry an incredible amount of energy and data. For
galvo actuated fiber lasers, this means that the beam can
move extremely quickly, making small adjustments via
actuated mirrors, rather than complex gantry systems.

Due to the beam being formed inside of a solid mechanical
apparatus, fiber lasers are considered "solid state" devices,
whereas CO2 laser tubes are generally considered "gas

state".

STEP BY STEP

Light is created in a laser diode, a dedicated source that's
"pumped" into the fiber optic cable, resulting in them
occasionally being referred to as a "pump source".

Pump light is guided into the fiber optic cable. While the fiber
optic is able to carry the beam, the cladding (or casing) on the
fiber is the reason the beam stays inside of the fiber instead of
dispersing out of it.

Light is amplified inside the laser cavity. As the light passes
through this region, the particles rise to a higher energy level,
getting caught and excited / relaxed into a singular
wavelength of operation. A doped portion of fiber, mixed with
certain rare earth elements, makes this possible, reflecting
back and forth while doing so inside "Bragg gratings". This is

where it becomes a stimulated emission of radiation.

Laser light of a particular wavelength is created. The specific
element(s) used to dope the fiber effect what wavelength the
beam becomes.

The beam is released and shaped. The light at this point is
collimated (straight), and to produce a usable shape for
engraving, marking, or more, lenses and/or beam expanders
are used to adjust the collimation.

5.14.4 Q-Switched vs MOPA

These two terms are often used in conjunction, but what
does that even mean? What's being switched? Why is it a
MOPA?

Master Oscillator Power Amplifier (MOPA) lasers allow more
timing adjustment than Q-Switched lasers. MOPA lasers
allow for separate control of pulse duration and pulse
frequency to produce highly accurate and controlled
engravings or etchings. The general range of MOPAs can be
as low as 2ns or as high as 500ns, allowing highly accurate
adjustment of the energy dispersed into the material.

Q-Switched lasers are typically not adjustable in this
manner, and operate at a fixed duration, typically between
80ns to 140ns.

5.14.5 Laser Timing Adjustment

Galvo lasers sometimes have granular, but adjustable tuning
of when the beam is commanded on, or off, as well as how
the mirrors are adjusted. Some of this calibration and
adjustment is in Lens Correction, or provided by your laser
manufacturer, but the fine tuning for corner approach and
speed may need adjustment.

Laser on TC (μs)

When attempting to mark, the physical mirrors of the galvo
head must reach the desired speed before they begin
marking. This fine tuning allows the user to reduce the burn-
in potential during that initial acceleration by adjusting the
source timing.

Laser Off TC (μs)

Similarly to the above, when the mirrors of the galvo head
must slow down as they attempt to end a marking move,
there may be a burn-in effect while slowing down. This
setting allows the end timing to be adjusted finely. 

End TC (μs)

This setting adjusts how long the laser waits at the end of a
series of vectors. Due to the fact the laser will physically lag
behind the commanded state as decided by any software,
this delay permits adjustment similarly to the Laser Off TC,
except only for the end of polygons.

This setting applies to any marking move where the laser is
turned off after execution.

Polygon TC (μs)

This setting adjusts how long the laser "waits" at the end of
each segment of a polygon, permitting the laser to settle

1. 

2. 

3. 

4. 

5. 
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appropriately, compensating for the same lag as outlined in 
End TC.

5.14.5 Laser Timing Adjustment
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Galvo UI

5.15 Repeat Marking Tool

Starting in version 1.4, galvo laser users have access to the Repeat Marking Tool. This tool enables the use of a rotary table or
linear axis to move parts past the laser while running jobs. This is typically used so you can engrave multiple pieces quickly and
consistently.

You can find the Repeat Marking Tool by going to Laser Tools >> Repeat Marking

Count

The desired number of repetitions.

Increment

The angle to rotate the axis between repetitions.

The Calculate button is only available if the axis type in Setup is set to rotate, and can automatically calculate the rotation
increment based on the number of positions in your rotary table. To use it, set Count to the number of positions in your rotary
table, click Calculate, and then set count to the actual number of repetitions you want.

Pause After Move

If your rotary table wobbles when it stops, adding a pause here gives it time to settle before marking starts again.

5.15.1 Position

This section shows the current position of the rotary table or
linear axis and allows you to manually control it. The top line
shows the current position.

The number box allows you to set how far the motor
controlling the axis will turn when manually jogged. Go to

Zero will return you to your starting point.

5.15.2 Controls

Start, pause, stop, and frame all work as they do elsewhere
in LightBurn.

5.15.3 Setup

Click the Setup button to enter the setup window and
configure your rotary table.

5.15 Repeat Marking Tool
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5.15.3 Setup
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